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1 What’s New in This Release
What’s New in Siebel Marketing User Guide, Version 8.0
Table 1 lists changes described in this version of the documentation to support release 8.0 of the 
software.

Table 1. What’s New in Siebel Marketing User Guide, Version 8.0

Topic Description

Marketing Initiatives

See Creating Initiatives and Linking Initiatives to 
Plans on page 20

Describes how to create marketing 
initiatives and associate them with plans, 
funds, and tactics.

Marketing Funds Management

See Developing and Managing Marketing Funds on 
page 26

Describes how to create and manage 
marketing funds.

Budget Requests

See Creating and Submitting Budget Requests on 
page 27

Describes how to spread funds from an 
approved budget request across multiple 
tactics.

Purchase Order Management

See Associating Purchase Orders with Marketing Tactics 
and Budget Requests on page 33

Describes how to use the purchase order 
management feature to associate 
procurement information with budget 
requests, program, and campaign 
expenses.

Collateral and Asset Management

See Managing Marketing Assets and Collateral on 
page 34

Describes how to use the Collateral and 
Asset Management feature to manage, 
track, and replenish marketing assets.

Offer Management and Treatments

See About Creating and Using Offers and Treatments on 
page 79 and Adding Treatments to Offers on page 82

Describes how to create cross-channel 
offers and associate treatments from 
multiple channels.

Adding Graphics to Email Treatments

See Adding Graphics to HTML Email Treatments on 
page 95

Describes how to add a new graphic to an 
email treatment using the HTML editor.

Allocation of Segments to Offer Treatments

See Allocating Segments to Offer Treatments on 
page 133

Describes how to use the campaign 
allocation matrix view to allocate 
segments, segment trees and internal 
lists to offer treatments within a 
campaign.
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What’s New in This Release ■ 
Other changes

Response Type Definitions on page 156. Removed Email Bounceback and Email 
Reply from list of response types. 

Global Changes

Siebel Analytics References to Siebel Analytics have been 
changed to Oracle Business Intelligence.

Siebel Analytics Server References to Siebel Analytics Server 
have been changed to Oracle Business 
Intelligence Server.

Siebel Analytics Web Catalog References to Siebel Analytics Web 
Catalog have been changed to Oracle 
Business Intelligence Presentation 
Catalog.

Siebel Answers, Siebel Analytics Answers References to Siebel Answers have been 
changed to Oracle Business Intelligence 
Answers.

Table 1. What’s New in Siebel Marketing User Guide, Version 8.0

Topic Description
Siebel Marketing User Guide Version 8.012 



2 Marketing Process Flow
This chapter describes the process flows for Oracle’s Siebel Marketing. These process flows allow you 
automate, design, and target marketing campaigns and programs. This chapter includes the 
following topics:

■ About Campaigns

■ Executing Campaigns from Start to Finish on page 15

About Campaigns
A campaign is a marketing tool that is used to target and motivate specific segments of your 
customer base to achieve a specific result. Campaigns can be stand-alone or part of a multistage 
program. Stand-alone campaigns include the elements listed in Table 2.

Table 2. Elements in Stand-Alone Campaigns and Multistage Campaigns

Element Description

Offer An offer is a single proposition or message that you want to present to your 
current and potential customers as part of a campaign. To present an offer 
through a specific channel or medium using a specific piece of collateral, you 
create a treatment for that offer. An offer can have multiple treatments, such as 
an email treatment and a phone treatment, and an offer can have multiple 
versions of treatments for the same channel. You can create different treatments 
to communicate an offer in different campaigns, but the campaign is a one-time 
instance of the treatment presented to a customer at a certain point in time. For 
more information, see Creating and Using Offers and Treatments on page 79.

Treatment A treatment is a channel-specific instance of an offer. A treatment can include 
details such as the HTML content, literature, delivery parameters, a call guide, 
and other details. A campaign can use one or more treatments. For a simple 
campaign, you may have only a single list or segment and a single treatment. In 
other campaigns, you might use multiple treatments by associating multiple lists 
or segments and then allocating which treatments each list and segment 
receives. For more information, see Creating and Using Offers and Treatments on 
page 79.

Segment A segment defines a target set of customers or prospects. A campaign can target 
one or more segments. For more information, see Marketing Segments and 
Segment Trees on page 41.
Siebel Marketing User Guide Version 8.0 13



Marketing Process Flow ■ About Campaigns
A stand-alone campaign is a campaign that is set up independently of other campaigns. The 
outbound treatments for the campaign would all be launched at the same time. If you want to 
combine multiple campaigns into a larger process, you can create a program. Programs have one or 
more stages so that you can schedule some campaigns in parallel to or as follow-ups to another 
campaign. For more information, see About Multistage Programs on page 66. 

Table 3 lists some terminology used in Marketing Programs.

Source code A source code is composed of multiple codes that represent information about the 
customer, and the offer sent to the customer. You use source codes to track the 
customers’ responses and gauge the reaction to a campaign and its offers. An 
administrator creates the source code definitions for you. For more information, 
see Siebel Marketing Installation and Administration Guide.

Vendor A vendor is a company that you retain to help you with a campaign, such as a 
printing house, a fulfillment house, and a telemarketer. An administrator enters 
the vendor information for you. For more information, see Siebel Marketing 
Installation and Administration Guide.

Table 3. Terminology used in Marketing Programs

Element Description

Programs A program is a container for organizing, designing, and executing multistage, 
triggered, and recurring marketing programs using new or existing campaigns, lists, 
and segments. You can establish multiple stages for a marketing program. Each 
stage can have multiple campaigns, lists, segments, and segment trees. 
Subsequent stages can be based on a customer response or any other event. For 
example, a visit by a sales person to a premium customer may trigger a follow-up 
email to that customer for the selected product. For more information, see 
Designing Marketing Programs on page 65.

Stage A stage is a group of campaigns that happen during a certain phase of a program. 
For example, you might have a two-stage program where stage 1 has campaigns to 
generate demand and stage 2 has another campaign to convert responders from 
the previous stage into leads.

Table 2. Elements in Stand-Alone Campaigns and Multistage Campaigns

Element Description
Siebel Marketing User Guide Version 8.014 



Marketing Process Flow ■ Executing Campaigns from Start to Finish
Executing Campaigns from Start to 
Finish
The approach for executing campaigns depends on if you are executing a stand-alone campaign or 
a marketing program (multistage campaigns):

■ Executing Stand-Alone Campaigns from Start to Finish on page 15

■ Executing Marketing Programs from Start to Finish on page 15

Executing Stand-Alone Campaigns from Start to Finish
To execute a stand-alone campaign, complete the following tasks:

1 Create one or more target lists or target segments. See Managing Lists on page 187 or Marketing 
Segments and Segment Trees on page 41.

2 Create offers and offer treatments. See Creating and Using Offers and Treatments on page 79.

3 Create a campaign. See Planning and Designing Marketing Campaigns on page 121.

4 Load the campaign. See Loading Campaigns on page 165.

5 (Optional) Set up distribution waves. See Setting Up Waves for Campaign Loads on page 73.

6 Launch the campaign. See Process of Launching Campaigns on page 172.

Executing Marketing Programs from Start to Finish
To execute a marketing program, you need to complete the following tasks:

1 Create a marketing program. See Designing Marketing Programs on page 65.

Responses Response handling is essential in triggering follow-up stages. Whenever prospects 
or contacts respond to an offer treatment through any channel (by inbound email, 
the Web, a call center, or sales representative, and so on), their responses may be 
captured in detail. You can use this data to determine which contacts to pursue as 
opportunities. For more information, see About Using Response Management on 
page 151.

Waves Waves are a method of phasing the delivery of a campaign or stage over time. For 
example, you want to extend an offer to millions of customers, but do not want to 
add more inbound call center staff to handle the load. Using waves, you can phase 
the delivery of treatments over any time delay (in hours or days) you need. For 
more information, see Setting Up Waves for Campaign Loads on page 73.

Table 3. Terminology used in Marketing Programs

Element Description
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Marketing Process Flow ■ Executing Campaigns from Start to Finish
2 Create your target segments for each campaign. See Marketing Segments and Segment Trees on 
page 41.

3 Create offers and treatments. See Creating and Using Offers and Treatments on page 79.

4 Plan response handling. See About Using Response Management on page 151.

5 (Optional) Set up waves. See Setting Up Waves for Campaign Loads on page 73.

6 Launch the program. See Launching Programs and Campaigns on page 171.

7 Load the campaigns manually or schedule the stage for automatic execution. To load campaigns, 
see Launching Campaigns Manually on page 172. To schedule a stage, see Scheduling a Stage 
Execution on page 176.
Siebel Marketing User Guide Version 8.016 



3 Planning and Budgeting for 
Marketing
Siebel Marketing includes support for a variety of Marketing Resource Management processes such 
as defining initiatives, planning and budgeting, expense tracking, managing calendars, and collateral 
planning. This chapter describes how to develop marketing plans, initiatives, and budgets. It includes 
the following topics:

■ About Planning and Budgeting for Marketing on page 17

■ About Marketing Initiatives on page 19

■ Creating Initiatives and Linking Initiatives to Plans on page 20

■ Process of Creating Marketing Plans and Budget Requests on page 21

■ Creating and Submitting Budget Requests on page 27

■ Associating Purchase Orders with Marketing Tactics and Budget Requests on page 33

■ About Loyalty Programs on page 38

About Planning and Budgeting for 
Marketing
Siebel Marketing provides support for planning and budgeting across the marketing organization. 
Using marketing plans, marketing executives and managers can create high-level business plans that 
cover a broad set of tactics, including outbound and inbound programs, campaigns, and events. For 
each plan, the marketing executive or team can set goals and objectives, identify available funds, 
assign budgets, associate multichannel marketing tactics, share documents, and generate forecasts.

Table 4 explains some of the marketing terms used in this chapter.

Table 4. Glossary of selected marketing terms

Term Description

Marketing Plan Plans are used to associate a broad set of tactics, including outbound and 
inbound programs, campaigns, and events for a specific business unit (such as 
European Field Marketing), purpose and/or time period. 

For each plan, users can include goals and objectives, associate budget 
requests, associate multichannel marketing tactics, and share documents.

Tactic A tactic is a term that is used to describe any kind of internal marketing 
activity. Types of tactics include programs, event plans, and stand-alone 
campaigns.
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Planning and Budgeting for Marketing ■ About Planning and Budgeting for Marketing
The Marketing Planning module can be applied to fit any organizational planning approach, including 
plans based on time periods (such as quarterly or annual planning cycles), business units, product 
lines, or any other management structure. Plans can be organized in hierarchies with any number of 
levels to support small marketing organizations as well as more complex planning processes.

Executives can also set high-level corporate objectives and then assign goals to each business unit 
that is participating in the plan. Each business unit can then create its marketing plan to meet its 
own assigned goals, forecast the organization’s ability to achieve the assigned goals, and submit the 
plan for approval. Based on common goals and performance metrics, marketing organizations can 
develop their own set of key performance metrics and institute the use of those metrics across their 
marketing plans.

There are several phases to the planning and budget cycle. The following are some typical processes 
using Siebel Marketing Resource Management, although the process for your company may differ. 

■ Planning and Alignment Process – This process is usually performed one time a year or one time 
a quarter. In this process, your company executives establish the overall marketing budget 
amount for the planning cycle. Based on the company priorities, a rough budget amount is set 
for each department or cost center. Meanwhile, the marketing teams develop their proposed 
programs, and submit them for review as budget requests. Budget requests that have good 
potential are approved to continue planning. The total cost of the approved budget requests is 
used to finalize the exact budget amounts (marketing funds) for each cost center. After the 
budget is finalized, the finance organization enters the official fund amounts for that planning 
cycle.

Initiative An initiative can be used to associate global plans and tactics to overall 
strategic initiatives or priorities. For example, initiatives might include 
entering a consumer market or increasing brand equity.

Marketing Fund A marketing fund is an internal marketing budget managed by a department 
or cost center, such as Corporate Advertising, Event Marketing, Market 
Research, and Partner Programs.

Budget Request A budget request is an internal request to release some of the money in a 
Marketing Fund for use on a marketing program.

Purchase Order An account number issued by the purchasing system giving a marketing team 
authority to incur expenses.

Expense A record associated with a tactic with an estimated amount (forecast amount) 
and an actual amount. For example, Catering or Shipping. The actual amount 
may be based on an Invoice list item or entered by the user directly.

Invoice A bill from a vendor for services rendered to the marketing organization.

Table 4. Glossary of selected marketing terms

Term Description
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Planning and Budgeting for Marketing ■ About Marketing Initiatives
■ Budget Approval process (for internal programs) – In this process, the owner of a marketing 
program submits a budget request to request that funds be allocated from a Marketing Fund to 
pay for the program (this step may have been done during the Planning and Alignment Process). 
If the program is being jointly funded by more than one cost center, each cost center submits a 
budget request for their portion of the cost. The fund owner reviews and approves the budget 
request. After the budget is approved, the request details can be entered into a procurement 
system for additional approvals if required, so that a purchase order can be issued.

■ Expense Tracking Process (execution phase) – In this process, the marketing team executes a 
marketing program or event. During the course of the program, expenses are incurred. Before 
the final invoice is received, the estimated value of each expense is tracked using the expense 
line items, so that a forecast of the expense amount can be monitored. After an invoice is 
received from a vendor that was hired for the program, the invoice is sent to the Finance 
department, and the invoice and purchase order number can be associated with specific 
expenses under the program or event.

■ Budget Adjustment Process – This process can occur at any point during the year. Usually this 
process happens at the end of a quarter when executives want to adjust the annual plan mid-
cycle. This process may also occur if there is a change of strategy or the overall budget increases 
or decreases. In this process, the finance team or fund owner can transfer money from one fund 
to another, or use an adjustment to directly increase or decrease the money in a fund.

About Marketing Initiatives
Many organizations establish a set of strategic initiatives for each year or quarter. Often these 
initiatives are defined by the CEO, CFO, or executive committee; the intent is that all the company’s 
marketing activities are aligned to achieve these initiatives. While some initiatives can represent 
quantitative objectives, such as Grow the Premium Segment 10%, they can also represent more 
abstract concepts such as Enter a new market.

The Siebel Marketing Initiatives feature allows you to define these initiatives for each planning cycle, 
and associate your marketing plans, budgets (funds), and tactics with these initiatives to measure 
alignment throughout the organization. It helps improve the alignment of the activities of individual 
teams with the corporate priorities by providing a visible association of high-level themes with day-
to-day details, and helps you improve ROI (Return on Investment) for your marketing budget.

For example, you can:

■ Define the top priorities for your company or organization for a given period (year, quarter).

■ Associate these priorities with marketing funds and budgets. (How much funding have we 
actually budgeted for each of the initiatives?).

■ Associate the initiatives with each of your marketing tactics such as campaigns, programs, and 
events. (What specific marketing activities are we implementing to achieve this objective?).

■ Analyze the success of marketing tactics. (We failed to meet this objective last year. Why? What 
specific tactics did we execute?).
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Planning and Budgeting for Marketing ■ About Marketing Initiatives
Creating Initiatives and Linking Initiatives to Plans
You can create a marketing plan initiative and associate it with your plan to help you track and 
analyze the success of your marketing plan against overall corporate initiatives. In addition, you can 
associate existing marketing tactics and funds to the initiative, link to marketing collateral 
documents, and add notes to each initiative.

To define a Marketing Initiative

1 Navigate to Marketing Plans > Marketing Initiatives.

2 In the Initiatives list, create a new initiative and complete the required fields.

The following table describes some of the fields.

To associate a Marketing Plan with an Initiative

1 Navigate to Marketing Plans > Marketing Plans list.

2 In the Marketing Plan list, query for the Marketing Plan.

3 Select the Plan Details tab, and then click the Initiatives field.

4 Associate one or more initiatives to the plan, and then save the record.

To associate a Marketing Fund with an Initiative

1 Navigate to Marketing Plans > Marketing Funds list.

2 In the Marketing Fund list, query for the Marketing Fund.

3 Select the Fund Details tab, and click the Initiatives field.

4 Associate one or more initiatives to the fund, and then save the record.

Field Description

Name The name of the marketing initiative.

Status The status indicates whether the initiative is still in planning (not yet 
official), active, completed (for a past planning cycle), or is cancelled.

Planning Period The period for the planned initiative. This period must align with the period 
for your marketing plans, marketing funds, and tactics.

Priority The priority assigned to the initiative.

Executive 
Sponsor

If the initiative is owned by an executive sponsor, this field allows you to 
select the name of the sponsor (employee).

Team If the initiative is owned by a particular team, this field allows you to 
add team members to the initiative.

Region If the initiative applies to a specific region, this field allows you to 
select it. Regions are organized using a region hierarchy.
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Planning and Budgeting for Marketing ■ Process of Creating Marketing Plans and Budget
Requests
To associate a Marketing Tactic with an Initiative

1 Navigate to Marketing Plans > Programs or Campaign Management or Events.

2 In the Program (or Campaign or Event Plan) list, query for the Tactic.

3 Select the Details tab, and click the Initiatives field.

4 Associate one or more initiatives to the tactic, and then save the record.

To associate documents and notes to an initiative

1 Navigate to the Marketing Plans list, and click Initiatives in the link bar.

2 In the Initiatives list, click the Initiative name.

3 From the Initiative form, click the appropriate view tab.

Process of Creating Marketing Plans and 
Budget Requests
To create marketing plans and budget requests, perform the following tasks:

■ Creating Marketing Plans on page 21

■ Creating Initiatives and Linking Initiatives to Plans on page 20

■ Setting Goals for Marketing Plans on page 22

■ Creating and Associating Tactics with Marketing Plans on page 25

■ Developing and Managing Marketing Funds on page 26

■ Creating and Submitting Budget Requests on page 27

■ Developing and Tracking Budgets for Marketing Plans on page 32

■ Attaching Documents to Marketing Plans on page 36

■ Adding Expenses for Events, Campaigns, and Programs on page 36

■ Associating Invoices and Invoice Items with Expenses on page 38

Related Topic
■ About Developing and Tracking Budgets for Marketing Plans on page 31

Creating Marketing Plans
You create a marketing plan in the Marketing Plans screen. The Marketing Plans list provides a list 
of the marketing plans to which you have access.

The visibility filter provides several levels of visibility, including the following views:
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■ My Marketing Plans displays marketing plans with which you are associated as a team member.

■ All Marketing Plans displays marketing plans in your assigned organizations.

■ All Marketing Plans across My Organizations displays marketing plans that exist in your 
organizations and in any suborganizations in your organizations.

■ All Marketing Plans across Organizations displays the marketing plans that exist in every 
organization in your application.

To create a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, create a new record, and complete the fields.

The following table describes some of the fields.

Setting Goals for Marketing Plans
Each marketing plan can be associated with a set of goals. Each goal is a metric against which the 
performance of the plan is measured.

Field Description

Marketing Plan 
Name

(Required) The name of the marketing plan.

Plan Code (Required) An identification code provided by you. Must be a unique value.

Type (Optional) A list of the category types of marketing plans. Examples of 
possible values include Corporate, Regional, Business Unit, and 
Department.

Objective (Optional) A text description of the objective of the marketing plan.

Planning Period (Optional) You associate the planning period with the plan so that you can 
use it during categorization and reporting. For example, you may need to 
track a quarterly or annual planning period.

Execution Period (Optional) The period in which the plan is to be executed.

Approval Status A status field that indicates that the plan has been Approved, Declined, 
Submitted, or Needs Revision.

Approval History Displays the history of approvals for the marketing plan.

Region (Optional) A listing of regions that you can associate with this plan. 
Regions are organized using a region hierarchy.

Organization (Optional) A multivalue field displaying organizations associated with the 
plan. Organizations that appear in this list have visibility to the plan.

Team (Optional) A multivalue field containing members of the team for the plan.
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To create a goal for a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a plan name.

3 In the Marketing Plans form, use the Type drop-down list to choose a type of plan.

4 Click the Goals view tab.

5 In the Goals list, click Apply Goal Template.

The goals from the template populate the Goals list.

NOTE: The goal template is controlled by the Type field. If you apply the template with an 
incorrect type selected, you can change the type and click Apply Goal Template again. If a 
template is not available, a message appears indicating that there is no active goals template for 
the specified type that you chose in Step 3.

6 If a goal template is not available, in the Goals list, create a new record.
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7 In the new record, complete the fields using the following table as a guide.

NOTE: Make sure that you select the appropriate number format for the goal type.

Field Description

Metric Type of goal. Some of the values for this field are:

■ Average Cost per Lead. (Number Format=Currency) The expected cost 
of the marketing activities in the plan divided by the number of sales 
leads generated.

■ Average Cost per Opportunity. (Number Format=Currency) The expected 
cost of the marketing activities in the plan divided by the number of sales 
opportunities generated.

■ Average Cost per Order. (Number Format=Currency) The expected cost 
of the marketing activities in the plan divided by the number of sales 
orders generated.

■ # Leads. (Number Format=Integer) The number of sales leads this plan 
is expected to yield. The definition of lead may vary based on your 
company’s business process.

■ ROI %. (Number Format=Percentage) The Return on Investment 
percentage that this plan is expected to earn.

■ Unit Volume. (Number Format=Integer) The number of product units 
that are expected to be sold as a result of this plan.

Number Format The types of formats are Number (nonfinancial), Percentage (nonfinancial), 
and Currency (financial).

■ If you select the Currency number format (a financial goal), complete the 
Target Amount field.

■ If you select a different number format (a nonfinancial goal), in the 
Target Qty field, enter the target number for the goal.

NOTE: If the goal has a Number Format of Percentage be sure to enter 
whole number values, not decimal values. For example, an ROI goal of 
15% must be entered as “15”, not “.15”.

Target Amount If the number format is Currency, use this field to specify the amount.

Target Qty If the number format is anything other than Currency, use this field to 
specify the number.

Forecast 
Amount or 
Forecast 
Quantity

If you know the expected forecast value, enter it in the Forecast Amount or 
Forecast Quantity field. If you do not know the expected forecast value, 
leave the Forecast Amount or Forecast Quantity field empty, and add the 
value after you develop a forecast.
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Creating and Associating Tactics with Marketing Plans
A plan tactic is a marketing program, event plan, or stand-alone campaign that you have associated 
with a marketing plan. A marketing plan can be associated with any number of marketing programs, 
event plans, or stand-alone campaigns:

■ A marketing program is any program created in the Programs screen.

■ An event plan can be any event plan created in the Events screen.

■ A stand-alone campaign can be any campaign created in the Campaigns screen that is not 
associated with a marketing program.

You can create new tactics while developing your marketing plan or associate existing tactics with 
the marketing plan.

To create a new plan tactic and associate it with a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a marketing plan name.

3 Click the Plan Tactics view tab.

4 In the Plan Tactics list, create a new tactic.

5 In the new tactic record, complete the Tactic Name and Type fields.

CAUTION: Be sure to select the correct Tactic Type (Event Plan, Program, or Standalone 
Campaign) before saving the record, because the type cannot be changed after the record is 
saved.

To associate an existing plan tactic with a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a marketing plan name.

3 Click the Plan Tactics view tab.

4 In the Plan Tactics list, click Add.

You can modify every field in this record except Type.

5 In the Pick Tactic dialog box, query for an event, program, or stand-alone campaign, and click 
OK.

NOTE: Each tactic can be associated with only one marketing plan.
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Developing and Managing Marketing Funds
Many marketing organizations, especially those that operate across multiple business lines and 
geographies, typically use disparate methods to track the sources, uses, and status of marketing 
funds. These methods may include the use of multiple, disconnected systems and media including 
spreadsheets, email messages, and departmental databases. Gaining control of these funds and 
maintaining a consistent view of the available fund balance is a challenge that is complicated by the 
lack of consistent processes across the organization.

By creating Marketing Funds, you can delegate spending authority to a particular department or cost 
center, and use Siebel Marketing as a system of record for managing each budget. Because there is 
often a delay between the execution phase of a program and the date when all the invoices are 
received and processed in your back-office financial system, your Marketing Funds and related tactics 
can provide a more up-to-date forecast with your organization's financial position.

Using Marketing Funds, an organization can:

■ Establish a budget for each marketing department or cost center

■ Draw money from these funds to pay for marketing tactics

■ Transfer funds from one budget to another 

■ Adjust a fund with an increase or decrease (but not a transfer)

■ Monitor current amounts for initial, allocated, committed, and spent funds

Creating Marketing Funds
Complete the steps in the following procedure to create a Marketing Fund.

To create a Marketing Fund

1 Navigate to the Marketing Plans screen and click Marketing Funds in the link bar.

2 In the Marketing Finds list, create a new marketing fund, and complete the required fields.

The following table describes some of the fields.

Field Description

Initial Amount Indicates the amount delegated to the fund at the beginning of the 
planning cycle (typically an annual or quarterly cycle).

Allocated Indicates the total Approved Budget amount from budget requests 
associated with the Fund.

Spent Indicates the total of actual expenses from the tactics associated with 
the fund (via budget requests). If you have linked invoice line items 
to your tactic expenses, this would represent the actual invoice 
amount. Otherwise, the actuals would be whatever was manually 
entered by users in the tactic-level expense records.

NOTE: You must associate the Budget Request with the expense. 
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Creating and Submitting Budget 
Requests
Use budget requests to request funds to pay for a marketing activity such as a campaign, event, or 
program. You can specify the amount of funding you need, associate the tactics related to the 
request, and submit the request for approval from the budget owner in your organization. Budget 
requests can be associated with a marketing plan or created and approved without establishing a 
relationship to a marketing plan. You can request funds for a single tactic from multiple budget 
owners. You can spread the money from an approved budget request across multiple tactics.

To create a budget request

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans link bar, click Budget Requests.

3 In the Budget Requests list, create a new record, and complete the fields.

The following table describes some of the fields.

Fund Id Automatically assigned when the record is created.

Approval Status Indicates the status of the marketing funds approval. Options are 
Submitted, Approved, Declined, Needs Revision. If you change the 
status to anything other than Approved or Declined, you must specify 
the name of the employee who will become the new owner.

Committed Indicates the total of all purchase orders associated with budget 
requests from this fund. Note that the budget request and purchase 
order must both be associated with the same tactic.

Available Indicates the Initial Amount minus Committed minus 
Net Adjustments minus Net Transfers.

Locked When this check box is selected, the marketing fund can only be 
updated by a Marketing administrator.

Net Adjustments Net amount (calculated) of all financial adjustments made to the 
Marketing Fund.

Net Transfers Total transfers into the fund minus total transfers out of the fund.

Field Action

Total Requested Total amount of the budget request. This field must be 
completed, or the budget request cannot be submitted.

Approval Status A status field that indicates that the plan has been Approved, 
Declined, Submitted, or Needs Revision.

Field Description
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To associate programs, campaigns or event plans with a budget request

1 Navigate to the Marketing Plans screen.

2 Click the Budget Request link.

3 Click the Tactics view tab.

4 To associate an existing program, campaign or event, click Add, then select a tactic in the dialog 
box, and click OK.

5 To create a new tactic:

a Click New, and then enter a name.

b Select the type (Program, Event Plan or Standalone campaign).

NOTE: After you select a tactic type and save the record, you cannot change the type.

Marketing Plan Associates the request with the marketing plan.

Budget Request Id Automatically populated.

Net Requested By default, this field shows the same value as Total Requested, 
but it can be configured to calculate the net amount as total 
minus any partner contributions.

Approval History Displays the history of approvals for the budget request (when 
Approval Status is Submitted).

Planning Period Indicates the time period during which the request is active. For 
example, an annual or quarterly budgeting period.

Budget Category (G/L 
Account)

Choose a budget category for the request. The categories 
typically correspond to the values in the back-office accounting 
general ledger.

Line Number You can use this field in any way that meets your business needs. 
For example, some general ledger applications generate a line 
number for each budget item.

Approved Budget Specify the amount of money approved for the request. This field 
must only be used by employees with budget authority.

Region Select the region authorized to spend the funds.

Type The value corresponds to the categories that your organization 
uses to organize and review requests. For example, Direct Mail, 
Hospitality, Marketing Operations, and so on.

Fund Identifies the Marketing Fund that provides funds for this budget 
request.

Organization Associates the request with organizations that must have 
visibility to the request. 

Field Action
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After you create the budget request (making sure that the Total Requested field is complete), submit 
the budget request.

NOTE: Be sure that the marketing plan for the budget request is associated with a tactic before 
submitting the request. For instructions, see Creating and Associating Tactics with Marketing Plans on 
page 25.

To submit a budget request

1 From the Approval Status drop-down list, choose Submitted.

The Pick Employee dialog box opens.

2 In the Pick Employee dialog box, select the employee to whom you want to submit the budget 
request.

3 (Optional) Add a comment to the request.

To approve or decline a budget request

1 Navigate to the My Approvals Inbox view.

2 Click the budget request name.

The Marketing Plans > Budget Request view appears.

3 In the Approval Status drop-down list, choose Approved, Declined, or Needs Revision.

The Pick Employee dialog box opens.

4 In the Pick Employee dialog box, select the employee who submitted the budget request.

5 (Optional) Add a comment to the request.

To associate a budget request with a marketing plan

1 Navigate to the Marketing Plans screen

2 In the link bar, click Marketing Plans.

3 In the Marketing Plans list, expand a Marketing Plan name.

4 Click the Budget Requests folder.

5 In the Budget Requests list, click Add.

6 In the Pick Budget Request dialog box, select the budget request, and click OK.

NOTE: If there are any tactics associated with the budget request that are not already associated 
with a marketing plan, the tactics are then associated with the marketing plan.

Associating Budget Requests and Tactics with the Marketing Fund
When you submit a budget request, you must indicate the Fund from which you want the money 
drawn. To indicate this, you must associate the Fund with the Budget Request record.
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To submit a budget request from a Marketing Fund

1 Navigate to the Marketing Plans screen.

2 Select the Budget Requests link.

3 In the Budget Request list, click the name of the Budget Request.

4 Click the Fund field.

5 Select the Fund, then click OK and save the record.

Managing the Marketing Fund
You can shift funds from one marketing fund to another and make other required financial changes 
to your Marketing Fund using the Transfers In, Transfers Out and Adjustments view tabs.

You can also view charts that provide Fund Analysis, Fund Allocation Analysis, and a Fund Allocation 
Trend Analysis by Region Brand, and Budget Category by Marketing Fund, and add notes to the fund.

To transfer funds into or out of a marketing fund

1 Navigate to the Marketing Funds list, and click the marketing fund name.

2 From the Market Fund form, click either the Transfers In or Transfers Out view tab.

3 In the Transfers In, or Transfers Out list, create a record and complete the fields.

Amounts transferred in or out of the Marketing Fund are calculated and appear in the Net 
Transfers field of the Marketing Fund form. For a Transfer In, the To field is always the Fund that 
you selected. For a Transfer Out, the From field is always the Fund that you selected.

To make adjustments to the marketing fund

1 Navigate to the Marketing Funds list, and click the marketing fund name.

2 From the Market Fund form, click the Adjustments view tab

3 In the Adjustments list, create a new record and complete the fields.

4 Enter a comment to explain why the Fund amount was increased or decreased. 

For example, if there is a budget cut, provide details so that other users can understand why the 
budget was changed.

The Net Adjustment amount appears in the Net Adjustments field of the Marketing Fund form.

To view marketing fund analyses

1 Navigate to the Marketing Funds list, and click the marketing fund name.

2 From the Market Fund form, click the Charts view tab.

3 In the Charts view, specify the By value, and the Chart Type, and click Go.

4 Click the appropriate link on the link bar to view Fund Allocation Analysis, Fund Analysis, or Fund 
Allocation Trend Analysis results for your Marketing Funds.
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About Developing and Tracking Budgets for Marketing 
Plans
The Marketing Plans screen also shows summary financial information based on items associated 
with the plan. This topic explains the source for each of the financial fields on the Marketing Plan.

Use the Marketing Plan form to review the forecast and actual expenses for the campaigns, events 
and programs in your organization. The marketing plan provides the following categories of values 
for viewing financial information:

■ Requested and Assigned Budget. The Plan Tactics view tab contains two fields that show how 
much money the plan owner has requested (Requested Budget) and how much money has been 
approved by the budget owner (Assigned Budget). These fields can be edited.

■ Forecast and Actual Expenses. The total forecast and actual expenses across tactics in the 
marketing plan.

■ Forecast Expenses. Total forecast expense value for expense records associated with the 
tactics (programs, campaigns, and events) in the marketing plan.

■ Actual Expenses. Total actual expense value for expense records associated with the tactics 
in the marketing plan.

The following table identifies the location of expense data for each type of tactic.

■ Forecast and Actual Revenue. The total actual expenses and revenues across tactics in the 
marketing plan. The Plan Details view tab includes a Financial Summary section summarizing 
total revenues for the tactics in the plan.

The following table identifies the location of revenue data for each type of tactic.

■ Forecast Revenue. A total of forecast values for revenue goals such as forecast amount for 
tactics in the marketing plan.

Tactic Type Where to Find the Input Data

Event Plans Events screen > Event Plans > Plan > Expenses 

Events Events screen > Plan > Expenses

Programs Programs screen > Plan > Expenses Campaigns screen > Plan > 
Expenses (for campaigns associated to programs)

Standalone Campaigns Campaigns screen > Plan > Expenses

Tactic Type Where to Find the Input Data

Campaigns Campaigns screen > Plan view tab > Goals link

Event Plans Events screen > Event Plans link > Plans view tab > Revenue link

Programs Programs screen > Plan view tab > Goals link
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■ Actual Revenue. The Total Order Revenue for orders associated with a tactic using values 
obtained from the Oracle Business Intelligence Server after the Siebel Data Warehouse is 
populated from the Siebel transactional database. If the value from the Oracle BI Server is 
not integrated into your environment, the value is blank.

Developing and Tracking Budgets for Marketing Plans
You can use marketing plans to develop budgets. As you implement tactics, you can track the 
financial status of the marketing plan.

You can use the Marketing Plan to track all the budget requests you have submitted to pay for the 
tactics in your plan. While this is not required in order to submit budget requests for your tactics, 
you may find it convenient to associate the budget requests here for easier tracking.

To allocate funds from a budget request to tactics

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a marketing plan.

3 Click the Budget Requests view tab, and verify that you have associated your budget requests 
and their related programs, events, and stand-alone campaigns.

For more information on associating plan tactics, see Creating and Associating Tactics with 
Marketing Plans on page 25.

4 In the bottom list of tactics for each budget request, if the Allocated Amount is not visible, use 
the Columns Displayed option to add it.

a From the Tactics Menu, choose Columns Displayed.

b In the Columns Displayed dialog box, move Allocated Amount to the Selected Columns list and 
click Save.

5 In the Allocated Amount field for the Tactic, enter the portion of the budget request Approved 
Budget that you want to allocate to that tactic. If there is only one tactic for that budget request, 
this amount must be 100%.

If you developed forecast expenses for the tactic, you can verify the plan is within budget by 
comparing your assigned budget to the forecast expenses.

NOTE: You can also perform Step 4 and Step 5 directly on the Budget Requests screen.
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Associating Purchase Orders with Marketing Tactics and 
Budget Requests
Purchase orders (POs) are approved purchase requests for marketing expenses. You can track 
committed spending by associating purchase orders with tactics and budget requests.

NOTE: Your company may approve and generate POs in a separate procurement system.

There are two types of purchase orders:

■ Blanket PO. This type of purchase order is used for a recurring expense.

■ One-time PO. This type of purchase order is used for a single instance of an expense.

To associate purchase orders with marketing tactics

1 Navigate to the Marketing Plans screen.

2 In the link bar, click Purchase Orders.

3 In the Purchase Orders list, create a new purchase order, complete the fields, and save the 
record.

In the type field, you must specify either Marketing Purchase Order or Blanket Purchase Order. 
You can also select an existing purchase order.

4 Click the Tactics tab, then click the name of the program, event plan, or campaign.

5 Click the Plan view tab, then select the Purchase Orders link.

6 Click New. In the dialog box, select the purchase order that you created in Step 1 to Step 3.

To associate purchase orders with budget requests

1 Navigate to the Marketing Plans screen.

2 In the link bar, click Purchase Orders.

3 In the Purchase Orders list, select an existing purchase order, or create a new purchase order.

If you are creating a new purchase order record, you specify either Marketing Purchase Order or 
Blanket Purchase Order in the Type field.

4 In the Purchase Orders list, click the Purchase Order # link.

5 From the Purchase Order form, click the Budget Requests view tab, and then click Add to select 
an existing Budget Request.

NOTE: The same tactic must be associated with the Budget Request and Purchase Order before 
you can see it in this dialog. This ensures that the budget request and purchase order are indeed 
related, since they are intended to pay for the same tactic.
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Creating Line Items for a Purchase Order
Optionally, you can enter the line items that are associated with a purchase order. Usually you 
submit and approve purchase requests through your company procurement system, however, you 
can choose to use the purchase order screen as a system of record. You can use the line items view 
to enter the detailed line items that are part of your purchase request.

To enter a purchase order line item

1 Navigate to the marketing Plans screen.

2 In the link bar, click Purchase Orders.

3 In the purchase orders list, select an existing purchase order.

4 In the purchase orders list, click the Purchase Order # link.

5 From the purchase order form, click the Line Items view tab.

6 Click New to create a line item.

7 Enter a description, quantity and price for each item covered by the Purchase Order.

Managing Marketing Assets and Collateral
Using the Marketing Asset feature, you can track the physical inventory of your marketing collateral, 
monitory inventory status, and manage requests for vendors to replenish your marketing materials.

The Marketing Assets screen provides a running inventory of each collateral item, with visual 
indicators that show when collateral is likely to require replenishment. For more rigorous purchase 
processes, the fulfillment process supports tracking of vendors and multiple bids for fulfillment 
requests to make sure that the low price supplier is always used.

Marketing Assets is integrated with Siebel Content Center. Using Content Center, users can use 
version management for revision of content, and implement workflow-driven approval processes.

To create a Marketing Asset

1 Navigate to the Administration > Content Center screen.

2 Select the Content Assets link.

3 Click New to create a new asset.

4 In the dialog box, enter a Name and Title for the asset, and then click File Options to browse for 
the file or URL options if you want to reference a URL to an online location.

5 Click OK to save the document.

6 Enter Activation and Expiration dates for the asset.

7 Select the Marketing Asset check box.
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To track inventory of marketing assets

1 Navigate to the Marketing Asset screen.

2 Select the Marketing Inventory link.

3 Click New to add an asset to the inventory list.

4 In the location field, enter the Location where the inventory currently resides. 

NOTE: To create a location, go to Administration > Location on the site map.

5 In the Quantity Available field, enter the current inventory amount for that location.

To create fulfillment requests

1 Navigate to the Marketing Asset screen.

2 Select the Fulfillment Requests link.

3 Click New to enter a request.

4 Enter the priority, date requested, and shipping location.

5 Save the record, and then click on the Request # link.

6 Select the Pieces view tab, and then click New.

7 Select the Asset name field and specify the asset you want shipped and the quantity requested. 
Repeat this step for other assets you want fulfilled.

To track bids for a fulfillment request

1 Navigate to the Marketing Asset screen.

2 Select the Fulfillment Requests link.

3 Click on the Request # link.

4 Select the Bids view tab.

5 Click New to create a record for each supplier that is considered for fulfillment, and then select 
the Supplier name and set the Bid Status to Request Submitted.

6 In the Bid Items list at the bottom of the screen, enter the Asset, # of Units, and expected Unit 
Cost.

7 Repeat Step 5 and Step 6 for other suppliers.

8 When bids are received for a supplier, set the bid status to Bid Received and update the bid items 
list to reflect their submitted estimate.

9 When you select a supplier, set the bid status to Awarded Bid and update the Actual Cost field 
on the bid header.
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Attaching Documents to Marketing Plans
You can attach planning documents to a marketing plan using the Documents view. These documents 
are visible to anyone who has access to the plan.

To attach a document to a marketing plan

1 Navigate to the Marketing Plans screen.

2 In the Marketing Plans list, click a Marketing Plan name.

3 Click the Documents view tab, and attach the document to the marketing plan in either of the 
following ways:

■ If the document is a file on your computer or network, click New File, then navigate to the 
file, and click Open.

■ If the document is a Web page, click New URL, paste the URL into the URL field, and click Add.

Adding Expenses for Events, Campaigns, and Programs
Using the Expense views for event plans, events, campaigns, and programs you can add the type 
and amount for each budget expense along with information, such as the purchase order number 
and invoice details. After you add expenses, the total forecast and actual values are calculated and 
displayed in the parent marketing plan for the tactic.

To add expenses for a campaign, event, event plan, or program

1 Navigate to the appropriate screen for your product:

■ For campaigns, navigate to the Campaign Management screen.

■ For events, navigate to the Events screen > Events view.

■ For event plans, navigate to the Events screen > Event Plan view.

■ For programs, navigate to the Programs screen.

2 In the list, click a campaign, event, event plan, or program name.

3 Click the Plan view tab.

4 In the Plan link bar, click Expenses.

5 Create a new record, and complete the fields.
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6 (Optional) For programs only, associate the expense to a specific campaign by choosing the 
campaign in the Campaign Name field, if appropriate.

The following table describes some of the fields.

Field Description

Expense (Campaigns 
and Programs only)

A reference name for the expense.

Campaign Name 
(Programs only)

A reference name for the campaign.

Purpose (Campaigns 
and Programs)
Cost Type (Events and 
Event Plans)

The category for the expense.

Unit (Campaigns and 
Programs only)

Indicates if the expense is a fixed or unit (variable) cost.

Invoice # The Id that corresponds to the invoice received. This information is 
available only if your company stores invoice information in the 
application. For more information, see Associating Invoices and Invoice 
Items with Expenses on page 38.

Purchase Order # Associates the Purchase Order that must pay the expense.

NOTE: The Purchase Order only appears if the purchase order type is 
Payable and the purchase order is associated with the tactic in the 
Plan > Purchase Orders view.

Assigned Budget 
(Campaigns only)

The amount budgeted for the expense.

Forecast # Units,
Forecast Unit Cost, 
and
Forecast Expense

Typically, the Forecast amount indicates the expected cost of the 
expense before the actual quote or invoice is received for the 
expense.

The Forecast Expense column is calculated by multiplying Forecast # 
Units by Forecast Unit Cost.

Actual # Units,
Actual Unit Cost,
and
Actual Expense

Typically, the Actual amount indicates the true cost of the expense 
after the quote or invoice is received.

The Actual Expense column is calculated by multiplying Actual # Units 
by Actual Unit Cost.

Variance Calculated as Actual Expense less Forecast Expense.

Event (Event Plans 
only)

Associates the expense with a specific event.
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Associating Invoices and Invoice Items with Expenses
Invoice values are available only if your company stores invoice information in the application.

To associate invoices and invoice items with expenses

1 Navigate to the Campaigns, Events, or Programs screen.

2 Click the campaign, event, event plan, or program name.

3 Click the Plan view tab.

4 In the Plan link bar, click Expenses.

5 In the Expenses list, locate the expense record to associate the invoice and Invoice item.

6 Click the Invoice Id # select button, query for the invoice number, and click OK.

NOTE: Only Invoices with a type of Payable appear.

7 Scroll down to the Invoice Line Items list, and click Add.

8 In the Pick Line Items dialog box, select one or more line items to associate with the expense.

9 Click Update Actual Cost to update the Actual Expense field on the expense record.

NOTE: You can associate different line items from the same invoice to different expense records.

About Loyalty Programs
Loyalty programs are available in Siebel Loyalty Management only.

You can associate a campaign to your loyalty promotions by first associating the loyalty program with 
a marketing plan. Any expenses for the loyalty promotion are then rolled up to the marketing plan 
and appear in the audit trail.

To associate a loyalty program with a marketing plan

1 Navigate to the Marketing Plans screen.

2 Click a marketing plan.

The Plan Tactics view tab appears.

3 Click the Plan Details tab.

4 In the Marketing Plan Details form, choose a Loyalty Program.

Session (Events and 
Event Plans only)

Associates the expense with a specific session.

Expense Date Determines the correct exchange rate, if your application spans 
multiple currencies.

Field Description
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To associate a loyalty promotion with a campaign

1 Navigate to the Marketing Plans screen.

2 Click a marketing plan.

The Plan Tactics view tab appears.

3 Add a new plan tactic.

4 Click the plan tactic.

5 Click the Design view tab.

6 Click the Related Loyalty Promotions link.

A list of Loyalty programs that are associated with the selected Marketing plan appears.

7 Add a promotion.
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4 Marketing Segments and 
Segment Trees
This chapter describes how to develop target segments for marketing campaigns. It includes the 
following topics:

■ About the Segment Designer on page 41

■ About Segment Tree Designer on page 54

■ Creating and Editing Segment Trees on page 55

About the Segment Designer
From the segmentation home pages, you can perform the following tasks:

■ Create a segment. A segment defines a target set of customers or prospects. In most cases, 
the members of a segment change over time because the criteria is reevaluated against the most 
current data in your database.

■ Create a segment tree. Use a segment tree to select one or more segments and split the 
segment members into smaller groups (or target cells).

■ Create a List format. List Formats define the layout of files that you can use for purposes such 
as mailing to postal addresses or email addresses.

■ Manage marketing jobs. The Manage Marketing Jobs link on the segmentation home pages 
displays your jobs and cache entries. The administrator can display job and cache entries for each 
user. For more information about managing marketing jobs, see Siebel Marketing Installation 
and Administration Guide

Using the Segment Designer, you can determine how many prospects or customers qualify for certain 
criteria. Each Segment is created by adding a sequence of successive criteria blocks to refine the 
segment membership. With each additional criteria block that you add, the membership can either 
increase or decrease depending on whether the criteria excluded or added members. You can create 
a new segment, you can click the new icon or open a saved segment, modify it, and save it with a 
new name.

Each segment is based on a target level that indicates the type of customer you plan to count and 
target for your campaigns. For example, target levels may include companies, individuals, or 
households.

For each target level there are a set of relevant subject areas that contain the information about that 
target level. These subject areas organize available facts and attributes into common topics such as 
Campaign History, Orders, Products Owned, or Service History.

From the start page for the Segment designer, you can do the following:

■ Open a Saved Segment. To open an existing segment, drill down on the segment folders in the 
left column.
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■ Create a New Segment. To create a new segment, select a target level from the list of target 
levels.

■ Manage Marketing Jobs. To view the status of jobs that are processed by the server, click the link.

For additional information, see the following topics:

■ Frequently Used Terms for Marketing Segmentation on page 42

■ Managing the Catalog on page 45

■ Refreshing the Display on page 45

■ Reloading Server Metadata on page 45

■ Creating Segments in Segment Designer on page 45

■ Adding Criteria Blocks to Segments on page 46

■ Saving Result Sets for Marketing Segments on page 51

■ Segment Advanced Options on page 53

Frequently Used Terms for Marketing Segmentation
Table 5 defines frequently used segment and segment tree terms.

Table 5. Frequently Used Terms for Marketing Segmentation

Term Description

Criteria Block Building block of a segment. With each additional criteria block that you 
add, the segment membership can either increase or decrease. 

Cumulative Count A type of count calculated by the Segment Designer. The cumulative 
count represents the total number of segment members that qualify for 
the indicated criteria block as well as the criteria blocks above it. As you 
add an additional criteria block at the bottom of the stack, the 
cumulative count either increases or decreases depending on whether 
you add, keep, or exclude segment members from the previous result.

Deduplication Calculation that removes overlapping members of a segment tree 
branch. Overlapping members are members of one branch that also 
qualify for any higher priority branch.

Eligible Audience A set of criteria that constrain the members of a segment tree. The 
eligible audience appears in the top section of the segment tree. The 
Eligible Audience criteria are defined by selecting a segment with the 
criteria and then adding the segment to the Eligible Audience section of 
the Segment Tree. For example, you may have an eligible audience 
which excludes inactive customers or only selects customers in your 
geographic region.

Global Audience A default eligible audience set by an administrator to apply to every 
segment and segment tree.
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Gross Count In a segment, gross count represents the total number of members that 
qualify for a specific criteria block, independent of any other criteria 
block in the segment design. This value tells you how many segment 
members would be selected if the specific criteria block was the only 
criterion in your segment.

In a segment tree, the gross count represents the total number of 
members that qualify for a tree branch, taking into account the full set 
of criteria in the parent branches.

Groups A group is a combined set of criteria blocks that evaluate together. A 
group is like a pair of parentheses in an equation, so that the qualifying 
members for the group are determined before adding or removing the 
group members from the cumulative segment membership.

List format Define the layout of files that you can export for a variety of purposes 
such as importing targeted customers into a campaign, building a 
customer email list, or generating a list for execution by a third-party 
vendor.

Nested Segment A segment that is embedded within another segment definition. When a 
nested segment is used, its corresponding counts apply the criteria for 
the nested segment and then add, keep, or exclude the qualifying 
customers to the cumulative count for the main segment.

Net Count A type of count computed by the Segment Tree Designer. The net count 
represents the number of members that qualify for a target cell in the 
segment tree. The net count displays how many members qualify based 
on the splitting and sampling criteria. Net count displays the members 
after deduplication.

Not Included Count A type of count computed by the Segment Tree Designer. The Not 
Included Count represents the number of members that were removed 
from a tree branch because they also qualified for any higher priority 
cell.

Priority Each target cell has an assigned priority number, which is used to apply 
deduplication when some members qualify for more than one target cell. 
Priority must be an integer value of 1 or higher and no two cells can 
share the same priority. The smallest value in the tree (usually 1) is the 
top priority.

Saved Result Set A fixed set of segment members that are recorded at a particular point 
in time. They are saved in the database so that they can be reused in 
the future without reevaluating the criteria again.

Table 5. Frequently Used Terms for Marketing Segmentation

Term Description
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Segment A target set of customers or prospects that qualify for a set of criteria. 
In most cases, the exact members of a segment changes over time 
because the criteria are reevaluated against the most current data in 
your database. However, using saved result sets, you can also save a 
segment as a static set of customers that were recorded at a particular 
point in time.

Segment Tree Use to select one or more segments and split the segment members into 
smaller groups (or target cells). As you split a segment into smaller 
groups, the groups are displayed in a tree diagram. As in segments, 
segment trees can save a static set of customers derived from any 
target cell.

Splitting and Sampling The action you take to break a segment or segment tree branch into 
smaller groups. 

Subject Area A set of facts and dimensions that are organized by a common topic, 
such as Orders, Products Owned, Service History, or Campaign History. 
Within each subject area, you can choose any fact or dimensional 
attribute to create a criteria for your segment.

Target Cells An end point branch of a segment tree, meaning that the branch does 
not have any child branches. Target Cells are the only branches that can 
be associated with a marketing campaign. Target Cells have an assigned 
priority number, and you can use deduplication to deduplicate members 
that qualify for more than one target cell.

Target Level Indicates what type of customer are counted in the segment 
membership and included in associated campaigns. For example, target 
levels may include target levels, companies, individuals, or households. 
The gross and cumulative counts for a segment are counted based at the 
selected target level. In most situations, target levels represent some 
type of customer, such as an individual or company. However, target 
levels can also be created by your administrator to create more 
advanced segment definitions. For example, advanced target levels can 
include Assets or Products that a customer owns.

Web Catalog The Oracle Business Intelligence Presentation Catalog stores content 
created with the Segment Designer, Segment Tree Designer, and List 
Format designer. Content can be organized into folders, which are either 
shared or private. Types of content that can be stored in the Web 
Catalog include segments, segment trees, list formats, as well as 
reports, filters, and dashboards created with Oracle Business 
Intelligence Answers.

Table 5. Frequently Used Terms for Marketing Segmentation

Term Description
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Managing the Catalog
Use the Manage Catalog feature to edit, rename, set permissions for, and delete folders and items 
in the Oracle Business Intelligence Presentation Catalog. To manage the catalog, click the Manage 
Catalog link in the Segments or Segment Trees column.

For more information on managing the catalog, see Oracle Business Intelligence Web Administration 
Guide or access the online help from the Manage Catalog window.

Refreshing the Display
The Segments column and Segment Trees column is populated when you first access the Segments 
or Segment Tree Designers. New folders, segments, and segment trees added by other users during 
your session do not automatically appear in your session. To keep your display current so you can 
access any new items, click Refresh Display at the bottom of the column.

Reloading Server Metadata
When creating a segment you use columns that are created in Oracle Business Intelligence. The list 
of columns available to you is populated when you start the Segment Designer, and is not 
automatically updated during your session. To update the list of columns, click Reload Server 
Metadata at the bottom of the Segments column.

Creating Segments in Segment Designer
The Segment Designer applies criteria blocks in a top-down sequence so that each criteria block that 
you add refines the segment membership of the criteria immediately above it. As you add criteria 
vertically down the screen, the Cumulative Count keeps track of how many customers have qualified 
for that criteria and those above it. At the bottom of the view, the total count of qualifying segment 
members appears with the criteria applied. 

NOTE: The Segment Designer computes two types of counts, gross count and cumulative count. For 
descriptions, see Frequently Used Terms for Marketing Segmentation on page 42.

For special situations where you need to create a group of criteria blocks (similar to parentheses in 
an equation), you can drag one criteria block on top of another to create a group. This method applies 
a combined set of criteria as a single constraint on the main segment membership.

The Segment Designer can include a reference to another existing segment (referred to as a nested 
segment) within the segment you are building.

After you create a segment, you can save it in one of the folders in the Web Catalog.

To create a new nested segment based on a different target level, click the Select Another Target 
Level button. This action saves the current segment. You can then build a nested segment and return 
to the main segment when you are finished.

NOTE: The subject areas that you can display are dependent on the security settings specified for 
you by your site's administrator.
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About Using the Marketing Segment Panel to Add Criteria to Segments
Use the segment pane to add criteria blocks when creating new or changing existing segments. To 
create a new segment, you can click the new icon or open a saved segment, modify it, and save it 
with a new name. Using either method, you select the subject area and field to use for a segment 
criteria. The panel displays the subject areas that are relevant for the target level for your segment.

You can also add a nested segment to your segment by selecting a folder displayed in the bottom of 
panel and clicking the segment name.

Adding Criteria Blocks to Segments
Each criteria block denotes a set of criteria that are evaluated together. This means that any segment 
member that qualifies for the criteria block must meet the criteria displayed within the block.

For example, if a segment has the following criteria block:

Product purchased is a blue hat
AND
Purchase date is December 31, 2004

This segment finds the customers who purchased a blue hat on December 31, 2004. Because the 
criteria are in the same block, the criteria are applied to the lowest level dimension related to the 
criteria, which, in this case, is Purchases (record-level evaluation).

If your segment places criteria into separate criteria blocks, each criteria block finds segment 
members that satisfy each criteria block. After segment members have been identified, the segment 
designer determines how many segment members qualified for both criteria blocks.

NOTE: If your administrator sets up a dashboard so you can display the contacts that qualify, you 
can display this dashboard by clicking the final segment count (at the bottom of the screen).

For example, you may have a segment with the two criteria blocks shown in the following list:

 

In this example, the relationship between the criteria are evaluated at the customer level, rather 
than the purchase level (record level). This segment would find the customers who purchased a blue 
hat at any time and customers who purchased any product on December 31, 2004. For example, the 
segment includes customers who purchased a blue hat in February and purchased a black coat on 
December 31, 2004.

To select a field to add as a criteria block

1 Click a subject area near the top of the selection pane and then expand the subfolders to display 
the available facts and dimensions.

2 Click the fact or dimension to use.

3 In the Create/Edit Filter dialog box, add the filter criteria, and click OK.

For more information about using column filters, see Oracle Business Intelligence User Guide.

Start With Criteria block 1: Product purchased is a blue hat.

Keep Criteria block 2: Purchase date is December 31, 2004.
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To set properties for a criteria block

1 In a criteria block, click Properties.

2 In the Properties dialog box, make changes to any of the following options:

■ In the Label field, enter a custom caption for your criteria.

■ Cache the block for future update counts requests.

Select this option to temporarily cache the results for that criteria block. This option saves 
time when refreshing counts while designing a segment. When a block is cached, updating 
counts refreshes the cache when the cache is expired or does not exist. By default, the 
segment designer does not cache any blocks unless you explicitly check this box.

3 Click OK.

To add filters to a criteria block

1 In a criteria block, click the filter button.

2 In the Create/Edit Filter dialog box, add the filter criteria.

For more information on using column filters, see Oracle Business Intelligence User Guide.

3 When you are finished adding filters for the criteria block, click OK.

To add a filter using an aggregate field

1 Create a new criteria block or click the filter button on an existing block.

2 Select the aggregate field such as Order Revenue from the selection pane.

3 To group by another field, in the Create/Edit filter dialog box, click Add Aggregate By.

4 While the Add Aggregate By dialog box is open, in the selection pane, click a field to group the 
results by.

To embed a nested segment in your segment design

1 Click the My Segments or Shared Segments folder at the bottom of the selection pane.

2 Click a segment to add as a nested segment.

To save a new segment

1 Click the save icon in the upper-right corner of the screen.

2 Select a folder location where the segment is to be saved.

3 Enter a segment name, and click OK.

To save changes to a segment

1 Click the save icon in the upper-right corner of the screen and click OK.
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2 In the Save dialog box, click Yes to confirm replacing the previous version.

To generate lists

1 Save the segment.

2 Click Generate List

To view the cumulative counts within a criteria block

1 Click the filter button on the criteria block.

2 In the Edit Criteria Block dialog box, click Get Counts.

3 The cumulative counts for each criterion in the criteria block appears.

NOTE: The starting count for the selected block is based on the cumulative count for the criteria 
block above your selected block.

4 When you are finished viewing the counts, click Back to Editing, and click OK.

To update counts in a segment

1 In the upper-right of the Edit Segment tab, click Update Counts.

2 In the Update Counts dialog box, select a refresh option.

3 If you are using the Cache option, you can also select Refresh Cache.

Selecting Refresh Cache guarantees that you query against the most current data.

4 Click OK.

Adding Selection Rules
Selection Rules control the items related to the segment that are included in the campaign load and 
list export processes. For example, for a segment of accounts (companies), you can control which 
employee or employees at the company you want to target.

A selection rule consists of several parts:

■ Inclusion and Exclusion criteria - Apply one or more criteria to indicate what items are to be 
included in and excluded from the segment.

■ Ranking rule - If there are multiple items related to each segment member, use the ranking rule 
to indicate how the items must be ranked. For example, if there are multiple employees for an 
account, indicate what field you want to use to rank the employees before selecting a subset. 

■ Record count selector - Indicate whether you want to select one or more items for each segment 
member (the Target Level). For example, you can indicate how many employees from a single 
company are targeted.
Siebel Marketing User Guide Version 8.048 



Marketing Segments and Segment Trees ■ About the Segment Designer
You can apply selection rules for more than one qualified item if desired. For example, you may have 
a segment targeted at households that own a variety of financial assets (bank account, insurance 
policy, or mortgage). You could use a selection rule for individuals to control which member of the 
household to which to communicate and a second selection rule on assets that controls which assets 
to mention in the text of a personalized letter.

NOTE: Selection rules for any nested segments within another segment definition are ignored. Only 
selection rules for the top-level segment are applied.

To create a selection rule

1 Click on Add Selection Rule.

2 Select the type of Qualified Item to constrain or select.

3 In the Create/Edit Filter dialog box, add the filter criteria.

For more information on using column filters, see Oracle Business Intelligence User Guide. 
Alternatively, you can filter the item with a previously saved segment by clicking the segment 
from the left panel.

4 Click OK.

5 In the criteria block, select Include/Exclude to include or exclude these types of items from the 
results.

6 For additional constraints, repeat Step 5.

7 In the bottom section of the rule, use the option buttons to select whether all items qualify or 
only specific items.

For more information on selecting specific items, see To add a ranking rule to a selection rule.

To add constraints to a selection rule

1 Click on Add Another Constraint.

2 In the Create/Edit Filter dialog box, add the filter criteria.

3 For more information on using column filters, see Oracle Business Intelligence User Guide.

4 Click OK.

5 In the criteria block, select the Include/Exclude link to include or exclude these types of items 
from the results.

To add a ranking rule to a selection rule

1 In the area beneath the constraint criteria boxes, select the option button for a limited number 
of items (for example, 1 Contact only).

The Add Ranking Field link appears.

2 Select the link.
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3 In the dialog box, select a field from the left selection pane to use for the ranking, and then click 
OK.

4 In the drop-down list choose either Maximum or Minimum for selecting items in the ranking field.

NOTE: Date fields treat older dates as Minimum and newer dates as Maximum.

5 To modify the formula for the ranking field or add a Case statement, click the Edit Formula icon. 

For more information, see To modify the formula for the Ranking Field.

NOTE: Ranking fields are available from any subject area that relates to both the Qualified Item 
and the main segment's primary Qualified Item (the Target Level).

To modify the formula for the Ranking Field

1 In the Ranking line for the Selection Rule, click the Edit Formula icon.

2 In the dialog box, click the Column Formula tab.

3 To display a glossary of available expressions, click the help link.

4 To convert the values for a field using a Case statement, click the Bins tab.

5 To create a bin for a condition, click Add Bin.

NOTE: By default, bin values are treated alphabetically. In the Bins tab, you may need to treat 
the resulting values as numeric values (to use numeric sorting). For example, if you used Bins 
to convert the Net Worth field to Values 1,2,3...10, you would want to rank numerically to make 
sure that '10' was after '9'. To enable numeric ranking, click the check box for 'Treat result as a 
numeric value or expression'.

6 When done editing, click OK.

As a shortcut, you can add a criteria block from the Edit Segment view directly as a Selection Rule 
constraint. You can only reuse criteria blocks from the top level of the segment criteria and blocks 
that use Keep and Exclude operators.

To reuse criteria from the Edit Segment view as a selection rule constraint

1 Click the Edit Segment tab.

2 Locate the criteria block to which to add selection rules and click its view icon.

The Properties dialog box appears.

3 Check the box for the Qualified Item to constrain.

4 Click OK.

5 Click the Selection Rules tab.

The constraint has been added to the selection rule for the item you checked.
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Saving Result Sets for Marketing Segments
A Saved Result Set is a fixed set of segment members that are recorded at a particular point in time. 
They are saved in the database so that they can be reused in the future without evaluating the 
criteria again.

Saved Result Sets can be useful in the following situations:

■ When you want to freeze the members of a segment at a specific point in time, so that the 
membership does not change.

■ When you have a very complex segment and you want to store the members of a recently 
counted segment to save query time.

■ When you want to save a branch of a segment tree as a separate segment.

Requirements
Before you can save a result set, you must create a result set list format and specify that list format 
in the Advanced Options. For more information on creating a result set list format, see the chapter 
on designing marketing list formats in Siebel Marketing Installation and Administration Guide. For 
more information on specifying which list format to use for your segment, see Segment Advanced 
Options on page 53.

To save a result set for a Marketing segment

1 In the Segment Designer, open the segment.

2 Click the Saved Result Sets tab.

3 Click the Save Result Set button.

4 In the Please save your current segment dialog box, verify the segment name and location.

5 Click OK to submit the job.

6 To cancel the job, click the Cancel/Exit links.

After the request is complete, the newly created saved result set appears.

To use a segment saved result set as a nested segment

1 In the Segment Designer, open a segment to edit.

2 Find a different saved segment in the Segment Folders in the selection pane and click it to add 
it to the segment design.

3 Click the properties button on the nested segment block.

4 Select Use Saved Result Set.

5 In the Saved Result Sets dialog box, select one of the following:

■ Always use most recent Saved Result Set

■ Choose a specific result set from the list.
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6 Click OK to close the Saved Results Set dialog box.

7 Click OK to close the Properties dialog box.

8 Save your changes.

To set a segment to always use a Saved Result Set

1 In the Segment Designer, open the segment.

2 Click the Advanced Options tab.

3 Select the following check box, and then click OK:

Always use most recent saved result set

NOTE: When you use this segment, the most recent result set determines the segment 
membership.

To save the results set for an entire segment tree

1 Click the Saved Result Sets tab.

2 Click Save Results Set.

3 In the Please save your current segment dialog box, verify segment name and location.

4 Click OK.

5 When prompted, enter a custom label for the segment tree.

Marketing creates a static segment for each tree node. The naming format is:
<Custom Label>-<Node Label>-<Priority>

While Saving a result set for a particular tree node, you have the option of either append to an 
already created static segment (useful for doing analysis over time) or creating a new static 
segment.

To purge a saved result set

1 Click the Saved Result Sets tab.

2 Select a results set and check its box.

3 Click Purge.

Results sets for branches are listed twice: one time as part of the tree and one time as a static 
segment. Purging one instance purges both.
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Segment Advanced Options
Table 6 shows the options available in the Advanced Options tab for a segment.

Table 6. Segment Advanced Options

Control Name Description

Cache final segment result set 
for list output

When generating multiple lists based on the same segment, you 
can cache the final set of customers during the first list usage so 
that subsequent list uses can access those results for faster 
processing.

Always use most recent Saved 
Result Set

When you use the segment, the most recent result set 
determines the segment membership.

Default to cache criteria blocks 
for future jobs

Controls the default value of the check box named Cache this 
block for future Update Counts.

Campaign Load File format The campaign load file format used for loading the members of 
the segment tree into each campaign.

The campaign load file format controls what information about 
the segment members is loaded into the campaign history in the 
Siebel Marketing transactional database. This information may 
include name, address, and email address.

When you first create a segment, the Campaign Load file format 
is set based on the default setting for the target level. You can 
select a different file format, if required. If you are not certain 
about the effect of changing the file format, contact your 
administrator.

For more information on list formats, see the chapter on 
designing marketing list formats in Siebel Marketing Installation 
and Administration Guide.

List Preview File Format The file that specified the format used for previewing lists.

For more information on list formats, see the chapter on 
designing marketing list formats in Siebel Marketing Installation 
and Administration Guide.

Saved Result Set File Format The file that specified the format used for saved results sets.

For more information on list formats, see the chapter on 
designing marketing list formats in Siebel Marketing Installation 
and Administration Guide.
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Segment Extension Attributes
Segment Extension Attributes are additional columns you add to a segment or a segment tree node. 
These attributes do not affect the segment counts. Instead, they are used to provide a means of 
storing additional data for each customer in a segment. This additional data can be used in list 
generation and in third party tools for further analysis. Your administrator creates the list of columns 
available for use as extension attributes.

Example: You add two extension attributes to a segment. One extension attribute is a column that 
contains the source of a new lead (trade show, internet web page visit, cold call) and the other 
column contains the product the lead is interested in. Based on the source and product information, 
you can track the resulting sales to see if lead source affects product sales.

To add an extension attribute

1 In the Advanced Options tab, click Add Attribute.

The Segment Extension Attributes window appears.

2 Select an attribute.

The new attribute appears in the Advanced Option tab’s Segment Extension Attributes list.

3 In the Value column, enter an alphanumeric value.

About Segment Tree Designer
Using the Segment Tree Designer, you can create a new segment tree or open a saved segment tree 
by selecting it in the selection pane, making changes, and saving the tree under the same or a new 
name. After you create a segment tree, you can save it in one of the folders in the Web Catalog in 
the selection pane. To obtain descriptions for frequently used terms, see Frequently Used Terms for 
Marketing Segmentation on page 42.

The Segment Tree Designer has links to additional Help information on each screen. When you need 
more information, click the Help link in the dialog box or the small help icon next to the item.

Segment Extension Attributes For more information, see the topic Segment Extension 
Attributes on page 54.

Purge List Cache (button) Clicking this button submits a job to purge the cache entries 
associated with pulling a list requalified by any of the target cells 
in this tree. You would click this button prior to pulling a list to 
make sure that the list contains the most recent customers in the 
target cell.

Table 6. Segment Advanced Options

Control Name Description
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Creating and Editing Segment Trees
The Segment Tree Designer creates and edits segment trees. You can select one or more segments 
and split the members into smaller groups (or target cells). As you split a segment into smaller 
groups, the groups are displayed in a tree diagram, and the resulting branch is always the same size 
or smaller than the parent branch.

Use the Split/Sample option to split any segment or tree branch into smaller groups. You can select 
from a set of splitting and sampling methods, including Random selection, Nth selection, Ranked, 
N-tiles, and Values.

NOTE: For more information about adding a filter using an aggregate field, see Adding Criteria Blocks 
to Segments on page 46.

Each segment tree is based on a target level, which indicates what type of customer you plan to 
count in the tree. For example, target levels can include target levels, companies, individuals, or 
households. When deduplication is enforced between target cells in the tree, the deduplication is 
applied at the target level. For example, if the target level for the tree is Companies, then 
deduplication makes sure that each company is a member of only one cell.

As you split and sample from the tree branches, some of the branches are end point branches, which 
means that they do not have any child splits. These end points are referred to as Target Cells, 
because they are the distinct groups targeted in a marketing program. Each Target Cell displays a 
priority number. The priority is used to apply deduplication between cells that may contain some of 
the same members.

The Segment Tree Designer displays several types of counts such as net counts and gross counts. 
For descriptions, see Frequently Used Terms for Marketing Segmentation on page 42.

Members of the Segment Tree are constrained by the eligible audience. The eligible audience is a set 
of criteria that appear in the top section of the screen. The criteria are applied to the Eligible Audience 
by creating a segment with the criteria and then adding the segment to the Eligible Audience section 
of the Segment Tree. For example, you may have an eligible audience which excludes inactive 
customers or only selects customers in your geographic region. Optionally, your administrator can 
also designate a Global Audience, which is a set of criteria that applies to the segment trees and 
cannot be removed by other users.

After you create a segment tree, you can save it in one of the folders in the Web Catalog.

The Segment Tree Designer has links to additional Help information on each screen. When you need 
more information, click the Help link in the dialog box or the small help icon next to the item.

This topic contains the following information:

■ Creating a Segment Tree in Segment Tree Designer on page 56

■ About Segment Tree Branch Properties on page 57

■ Adding Selection Rules to a Segment Tree on page 58

■ Splitting Segments or Branches on page 59

■ Constraining List Data for a Segment Tree on page 62

■ Adding or Removing Constraints to the Eligible Audience on page 62
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Creating a Segment Tree in Segment Tree Designer
Use the segment tree selection pane to create a new segment tree, select the segments to sample 
in the tree, and select the fields to use for the splitting criteria. After you create a segment tree, you 
can save it in one of the folders in the Web Catalog.

When you begin editing a tree, the selection pane displays the available segments that you can use 
in the tree. To add a segment to the segment tree, open its folder in the selection pane, and click 
the segment name.

As you add splitting and sampling criteria, the selection pane changes to display the available subject 
areas and fields for the target level on which the tree is based.

NOTE: The subject areas that you can display depend on the security settings specified for you by 
your site's Administrator.

To create a new segment tree

1 In the Segment Tree Designer, select a Target Level.

2 In the selection pane, click the names of the segments to add.

3 To save the segment tree, click the save icon in the upper-right corner of the screen.

4 Select the folder location where the segment tree is to be saved.

5 Enter a segment tree name and click OK.

To add a segment to a segment tree

1 In the Segment Tree Designer, select the Edit Segment tab.

2 Click the folder in the selection pane to display the segments.

3 Click the segment name in the selection pane.

This adds the segment to the bottom of the segment tree.

4 Click the save icon in the upper-right corner of the screen and click OK.

5 Click Yes in the dialog box to confirm saving over the previous version.

To generate lists for a node

1 Save the segment tree.

2 Select a node.

3 Click the node’s menu button and choose Generate Lists.

To update counts in a segment tree

1 In the upper-right of the Edit Segment Tree tab, click Update Counts.

The Update Counts window opens.
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2 In the Update Counts dialog box, click the Count Options tab.

3 Indicate which criteria blocks to update:

■ New and changed criteria blocks

■ Selected criteria blocks

■ All criteria blocks

4 If you are using the Cache option, you can also select Refresh Cache.

Selecting Refresh Cache guarantees that you query against the most current data.

5 Click the Count Type tab.

6 Select the counts to be updated—making sure to select at least one type of count—and then click 
OK.

About Segment Tree Branch Properties
Table 7 shows the options available in the properties dialog box for a segment tree branch.

Table 7. Segment Tree Branch Properties

Control Name Description

Label Used to add a custom label for the branch.

NOTE: Custom labels cannot be entered for embedded segment 
nodes.

Include Remainder with 
child cells (check box)

When selected, adds a remainder group when you split or sample the 
branch.

Include overlapping 
members from higher 
priority cells

When selected, disables deduplication for this cell.

Cache this block for future 
Update Counts

Select this option for the following reasons:

■ When selected, this option temporarily caches the members who 
qualified for that branch, which saves when time refreshing 
counts while designing a segment tree.

■ When a split-by-value node is marked for caching and constrains 
a secondary list attribute, this attribute is also cached.

■ The segment tree designer caches the tree nodes by default.

Anticipated response rate 
for statistical significance 
test

Use this to add the assumed response rate for that cell.
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Adding Selection Rules to a Segment Tree
Selection Rules control the items related to the segment tree cells that are included in the campaign 
load and list export processes. For example, for a segment tree of accounts (companies), you can 
control which employee or employees at the company you want to target.

For a Segment Tree, you have several options to apply the Selection Rules:

■ Selection Rules tab. Use this tab to enter explicit Selection Rules that apply to all cells on the 
Segment Tree.

■ Inherit Selection Rules from the segments. This option inherits any existing selection rules 
from the segment or segments included in the segment tree.

■ Apply constraints from the Segment Tree splitting and sampling criteria. Use this option 
to selectively apply the criteria for specific tree branches as part of the selection rule.

For information on creating selection rules, see Adding Selection Rules.

Rather than create Selection Rules for the entire segment tree, you can inherit the Selection Rules 
from each segment.

To inherit selection rules from a segment

1 Click the view icon for the segment in the tree.

2 Click Properties.

The Properties dialog box appears.

Save Result Set (button) Saves the list of members that qualify for the branch based on the 
most recent updated counts. When you click this button, you are 
prompted for a new segment name. The customers in the target cell 
are extracted and saved to the new segment.

NOTE: The saved segment does not include any of the original 
criteria, it includes only the stored list of members.

Path This displays the Web catalog path of the segment to which an 
embedded segment node refers.

Use Saved Result Set When selected for an embedded segment node, you can select the 
following options:

■ Always use most recent Saved Result Set.

■ Choose a specific result set from the list.

Table 7. Segment Tree Branch Properties

Control Name Description
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3 Check the box for Inherit Selection Rules from the segment and then click OK.

NOTE: The inherited rules do not appear in the Selection Rules view. This occurs because the criteria 
may vary between different segments in the tree, while the Selection Rules view shows only criteria 
that apply to all cells in the tree. You can only inherit selection rules from segments with the same 
target level as the tree.

As a shortcut, you can add the splitting and sampling criteria from the Edit Segment Tree view 
directly as a Selection Rule constraint.

To reuse criteria from the Edit Segment Tree view as a selection rule constraint

1 Click the Edit Segment Tree tab.

2 Locate the split block to be added to the selection rules and click its icon.

The Properties dialog box appears.

3 Check the box for the Qualified Item to constrain, and then click OK.

NOTE: These constraints do not appear in the Selection Rules view. This occurs because the criteria 
may vary between different tree branches, while the Selection Rules view only shows criteria that 
apply to all cells in the tree.

Splitting Segments or Branches
Use the Split/Sample option to split any segment or tree branch into smaller groups. As you split or 
sample, the resulting branch is always the same size or smaller than the parent branch. Table 8 
shows the available sampling methods.

Table 8. Sampling Methods for Splitting Segments

Sampling Method Description

Random selection The Random method selects a purely random subset of members based on 
the percentage or count you add for this method. For random selection, you 
are not required to select a field.

Nth selection The Nth method splits the branch into N number of equally sized groups. 
The selection is based on the sequence with which the records are returned 
from the database. For example, if you select N = 4, the branch would be 
split into 4 equally sized groups representing 25% of the original group. For 
this method, you are not required to select a field.

Ranked The Ranked method sorts the members of the branch by a field you select 
and lets you choose the top or bottom portion of the ranked list. For 
example, if you Rank by Total Customer Revenue, you can select the top 
10% of the customers with the highest revenue.
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Mixing Random Splits with Other Splits
You can create segments that mix random splits with other splits. However, this affects how targets 
are assigned to each split. Random splits exclude targets only when those targets are in immediately 
adjacent random spits. This point is best illustrated by some examples.

Example A: Three Random Splits
1 - Random Split 10%
2 - Random Split 20% (This split excludes targets that are in split 1.)
3 - Random Split 30% (This split excludes targets that are in splits 1 and 2.)
Effect: All three splits contain different targets, no target exists in more than one split.

Example B: Mixed Random and Nth Splits with Possible Recurrence of Targets
1 - Random Split 10%
2 - Nth Split [N=10]
3 - Random Split 20% (This split does not exclude any targets.)
4 - Random Split 30% (This split excludes targets that are in split 3, but does not exclude targets 
that are in other splits.)
Effect: Because Split 4, a random split, follows another random split, it does not contain any targets 
that are in split 3. Because there is a nonrandom split after split 1, targets from split 1 could appear 
in splits 3 and 4.

Example C: Mixed Random and Nth Splits with No Recurrence of Targets in Random Split
1- Nth Split [N=10]
2- Random Split 10%
3- Random Split 20% (This split excludes targets that are in split 2.)
4- Random Split 30% (This split excludes targets that are in splits 2 and 3.)
Effect: Because the random splits are adjacent to each other, splits 3 and 4 exclude any targets that 
are in previously adjacent random splits. However, targets in split 1, an Nth split, may recur in any 
of the random splits.

When random split cells are separated, they are evaluated independently and do not stay mutually 
exclusive.

N-tiles The N-tile method sorts the members by a field you select and then splits 
the list into equal sized groups. For example, you may create quartets or 
deciles based on Total Customer Revenue.

Values Similar to instructions for creating filters in segment criteria blocks. For 
more information about adding a filter using an aggregate field, see Adding 
Criteria Blocks to Segments on page 46.

Table 8. Sampling Methods for Splitting Segments

Sampling Method Description
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To select a field for splitting or sampling criteria

1 Click the action button for a tree branch to split or sample.

2 In the menu, choose Split/Sample.

3 In the Apply Split/Sample dialog box, select a sampling method to use.

NOTE: The contents of the dialog box changes when you select different sampling methods.

The available subject areas and fields appear in the selection pane. The list of subject areas is 
based on the target level for the segment tree.

4 In the revised Apply Split/Sample dialog box, complete the fields.

5 Click the subject area that contains the desired field.

6 Click the folders to expand the subject area.

7 Click the field name.

To create random samples

1 Enter the number of groups to create (1 to N).

2 Select whether to define the group sizes by Percentage or Count.

3 Enter a percentage or count for each group, and click OK.

The sum of the percentages cannot exceed 100%.

To create Nth samples

1 Enter the number of groups to create (N).

2 Click OK.

To create ranked samples

1 Select the field to rank by from a subject area in the selection pane.

2 Enter the number of groups to create (1 to N).

3 Select whether to define the group sizes by Percentage or Count.

4 Enter a percentage or count for each group, and click OK.

The sum of the percentages cannot exceed 100%.

To create N-tile samples

1 Select the field to use for the N-tile from a subject area in the selection pane.

2 Enter the number of groups to create (1 to N).

3 Select whether the top group has the lowest or highest values for the selected field, and click OK.
Siebel Marketing User Guide Version 8.0 61



Marketing Segments and Segment Trees ■ Creating and Editing Segment Trees
Using the Values Sampling Method
Instructions for creating Values samples uses instructions that are similar to creating filters in 
segment criteria block. For more information about adding a filter using an aggregate field, see 
Adding Criteria Blocks to Segments on page 46.

Constraining List Data for a Segment Tree
This option can limit the information in list files to members of the branch. For example, if you have 
a segment tree based on accounts, you may qualify specific contacts for the accounts based on 
criteria for that branch.

Additionally, this option can limit the information in list files to any additional items that you 
constrained on the segment tree branch. The following are scenarios for other types of constraints:

■ Nested Segment Node. You may have a business-to-business company targeting business 
accounts. You split by predefined contact segments containing the decision-making contact at 
each account. You can make sure that you select the correct contact for each account by 
constraining the contact attribute for the nested segment node.

■ Split-by-Value Node. You may have a banking company targeting customers split by checking 
and savings account types. You can make sure that you select the correct account type for each 
customer by constraining the bank account attribute for the split-by-value node.

You can constrain list data for a tree branch only when the following criteria are met:

■ The branch is an embedded segment node in which the target level is different from the target 
level of the segment tree.

■ The branch is a split node created using the values sampling method, and the split-by field is not 
an aggregated measure.

To constrain list data for a segment tree

1 In the Segment Tree Designer, locate the branch on which you want to constrain data.

You can only constrain list data on nested segment tree nodes and split by value nodes.

2 Click the Actions button, and choose Constrain List Data from the menu.

3 In the dialog box, select a qualified item to constrain.

4 In the Constrain List Data dialog box, click OK.

Adding or Removing Constraints to the Eligible Audience
Members of the Segment Tree are constrained by the Eligible Audience. The eligible audience is a set 
of criteria that appear in the top section of the screen. The criteria are applied to the Eligible Audience 
by creating a segment with the constraining criteria and then adding the segment to the Eligible 
Audience section of the Segment Tree. For example, you may have an eligible audience that excludes 
inactive customers or only selects customers in your geographic region.
Siebel Marketing User Guide Version 8.062 



Marketing Segments and Segment Trees ■ Creating and Editing Segment Trees
Optionally, your administrator can also designate a Global Audience, which is a set of criteria that 
applies to every segment tree and cannot be removed by other users. The Global Audience appears 
as a block that is more lightly shaded than the rest of the tree. For instructions about setting the 
Global Audience, see Siebel Marketing Installation and Administration Guide.

To add or remove constraints to the Eligible Audience

1 Click the actions button on the existing eligible audience block.

2 To add constraints, choose Add Constraint and perform the following steps:

a In the Add additional constraints to the Eligible Audience dialog box, click Browse.

b Select the segment that has the criteria to use to constrain the audience.

3 To remove constraints from the eligible audience, click the delete button on the constraint to be 
removed.

NOTE: If the constraint is the Global Audience, you cannot remove it.

4 Click OK.

Segment Tree Advanced Options
Table 9 shows the options available in the Advanced Options tab for a segment tree.

Table 9. Segment Tree Advanced Options

Control Name Description

Cache final segment result set 
for list output

When generating multiple lists based on the same segment, you 
can cache the final set of customers during the first list usage so 
that subsequent list uses can access those results for faster 
processing.

Automatically create 
remainder cells

If you do not want the tree designer to create remainders 
whenever you split a branch, clear this option.

Default to include overlapping 
members from higher priority 
cells in lower priority cells

The standard behavior for new trees is to always enforce 
deduplication between target cells. When this option is checked, 
deduplication is not enforced for the segment tree. However, you 
can enable deduplication for specific branches using the branch 
properties.

Default to cache tree blocks for 
future jobs

Controls the default value of the check box named Cache this 
block for future Update Counts (in the properties of a newly 
created tree branch).
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Campaign Load File format The campaign load file format used for loading the members of 
the segment tree into each campaign.

The campaign load file format controls what information about 
the segment tree members is loaded into the campaign history in 
the Siebel Marketing transactional database. This information 
may include name, address, and email address.

When you first create a segment, the Campaign Load file format 
is set based on the default setting for the target level. You can 
select a different file format, if required. If you are not certain 
about the effect of changing the file format, contact your 
administrator.

List Preview File Format The file that specified the format used for previewing lists.

Saved Result Set File Format The file that specified the format used for saved results sets.

Statistical Significance 
Parameters

The following variables are used as inputs for the statistical 
significance calculation:

■ Confidence interval

■ Error tolerance, plus or minus

■ Default Response Rate

Purge List Cache (button) Clicking this button submits a job to purge the cache entries 
associated with pulling a list requalified by any of the target cells 
in this tree. You would click this button prior to pulling a list to 
make sure that the list contains the most recent customers in the 
target cell.

Table 9. Segment Tree Advanced Options

Control Name Description
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5 Designing Marketing Programs
This chapter describes how you can use the Program screen’s Program Flow view and the Program 
Explorer view to design and execute programs using new or existing segments, lists, and campaigns. 
It includes the following topics:

■ About Designing Marketing Programs on page 65

■ Process of Designing Marketing Programs on page 65

■ About Multistage Programs on page 66

■ About the Program Execution Workflow on page 67

■ Creating Programs on page 67

■ About Using the Program Flow on page 70

About Designing Marketing Programs
A program is a multistep dialogue in which you can set up a series of communications to your 
customers and prospects. In the Programs screen, you can use the graphical drag-and-drop Program 
Flow view or the Program Explorer view to design and execute multistage, triggered, and recurring 
marketing programs using new or existing campaigns, lists, and segments.

You can establish multiple stages for a marketing program. Each stage can have multiple campaigns, 
lists, segments, and segment trees. Subsequent stages can be based on a customer response or any 
other event. For example, a visit by a sales person to a premium customer may trigger a follow-up 
email to that customer for the selected product.

In the workspace, you can use the right-click menu to manually start Marketing Server tasks. To 
schedule server tasks to be started automatically, use the Schedule calendar.

The graphical Program Flow designer is integrated with the workflow engine and Marketing Server. 
Therefore, when defined, the entire program can be automated from the initial customer 
segmentation through communication, to response collection and analysis. This capability is 
especially useful when programs are set to recur, such as a monthly welcome package campaign to 
new customers.

In previous releases, allocation was done across campaigns, and segment trees were at the stage 
level. Now, segmentation is performed within a campaign, a campaign is a direct child of a program, 
and a stage is an optional attribute of a campaign.

Process of Designing Marketing 
Programs
To design marketing programs, perform the following tasks:
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■ Creating Programs on page 67

■ Adding Stages to Programs on page 70

■ Specifying Repeating Stages Within Programs on page 71

■ Associating Segments with Campaigns on page 72

■ Adding Campaigns to Stages on page 72

■ Setting Up Waves for Campaign Loads on page 73

■ Adding Imported or Internal Lists to Campaigns on page 75

■ Adding Trees to Campaigns and Allocating Segment Tree Cells on page 75

■ Creating and Applying Program Templates on page 76

■ Executing Programs on page 77

Related Topics
■ About Multistage Programs on page 66

■ About the Program Execution Workflow on page 67

■ About Using the Program Flow on page 70

■ Process of Loading Customers in Campaigns on page 161

■ Launching Programs and Campaigns on page 171

About Multistage Programs
Siebel Marketing supports both single-stage and multistage marketing programs. In a single-stage 
program, contacts are targeted in a stand-alone campaign, with no follow-up campaigns planned. 
During a multistage program, contacts in the first stage receive follow-up treatment in the program’s 
second and third stages, often based on the contact’s response to the original campaign. Multistage 
programs use stages to mark each phase of the program, campaigns to track separate instances of 
marketing messages, and campaign waves to track each batch of customers that are contacted. The 
following are types of multistage programs:

■ Marketing program with recurring campaign. Scheduled to recur at standard intervals or 
specific times (daily, weekly, monthly, quarterly, yearly). For example, your company sends out 
a welcome kit and free gift to new customers on a monthly basis. Each month, a program stage 
occurs, new customers are identified (based on the segment criteria of account longevity of less 
than a month), and the welcome campaign is launched.

■ Event-triggered marketing program. Provides a follow-up activity based on an action. For 
example, a customer visiting a product catalog may trigger an email offer to that customer based 
on items included in the customer’s cart. If no response to the email is received, a telesales 
campaign launches to offer the customer a special offer on the product.
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■ Response triggered marketing program. Uses response data to drive the next stage of the 
marketing program.

For example, the marketing manager of a bank designs a program implementing the company’s 
goal of increasing the number of bank-affiliated credit card customers. Within the program, he 
creates a campaign with two offers and two treatments, one offering a card with 10% interest 
and a $25 annual fee, the other offering 14% interest but no annual fee. These treatments are 
sent to 250,000 of the company’s customers who do not already have credit card accounts with 
the bank.

After 30 days, response information is used to:

■ Send a welcome packet of information to each new credit card customer who responded to 
one of the treatments.

■ Offer an 8%, $25 annual fee card to everyone who did not respond.

When using repeating stages, be sure that your segment criteria exclude customers who were 
targeted in any previous wave of the same campaign or stage. This precaution prevents the 
customers from receiving redundant messages.

About the Program Execution Workflow
Multistage programs can be launched manually or automatically scheduled using the calendar. When 
you use the calendar, it can trigger key events such as loading a campaign (list generation) and 
launching a campaign (sending lists to vendors and sending offers to targeted contacts). The 
Program Schedule drives the process, with activities triggering the execution of each program. Each 
of these key events can be executed manually, using the Program Flow menu or the Program Explorer 
menus.

The Stage Execution workflow process shows how executing a program, loading a campaign, and 
launching a campaign occur in a multistage process.

When a stage or campaign is scheduled, the application applies a predefined allocation matrix for 
each campaign that links segments to each treatment. Campaigns are loaded and launched, and if 
the stage is scheduled to repeat, the next occurrence of the stage is scheduled. Each stage of a 
program is a unique event, and Siebel Marketing tracks campaign and response history at the unique 
campaign wave and treatment level (for each run). For more information about workflow processes 
and the Siebel Business Process Designer, see Siebel Business Process Framework: Workflow Guide 
and Siebel Business Process Framework: Task UI Guide.

Creating Programs
When you create a new program, you specify an objective, a type (for example, Cross-sell or Win-
back), a status (Active, Completed, or Planned), a revenue goal, and a budget figure.

When you add organizations to a program, any campaign that you add to a program (using the 
program flow or program explorer) inherits the program's organizations. The campaign that you add 
retains any existing organizations and existing lead partner.
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The organizations in the campaign represent the union of the program’s and campaign's 
organizations. After you add the campaign to the program, changes made to the organizations at the 
program are not reflected at the associated campaign level. Segments added to the program do not 
inherit the organizations. For more information, see Creating Campaigns on page 127.

NOTE: You can turn off the teams and organizations inheritance features in Siebel Tools. In the 
appropriate business component, change the User Prop value for the Copy Teams and Copy 
Organizations property from Y to N. For more information, see Siebel Tools Online Help.

You can attach documents and other files and view program stages and status. In addition, you can 
add team members, activity plans, events, and design the actual program flow, using a graphical 
designer workspace.

To create a program

1 Navigate to the Programs screen.

2 In the Programs list, create a new record and complete the fields.

Use the following table as a guide.

Field Comment

Program Code (Required) The program component of the source code. This is a unique 
code for the program. It defaults to Row ID. You can choose to overwrite 
this manually, provided that the value you specify is unique.

Status The default program status is In Planning. Options are Active, 
Cancelled, Completed and Scheduled. The status changes from In 
Planning to Active, and then Completed during program execution. 
Manual execution of the program does not affect this field.

Type Choose a program type from the following list:
Acquisition, Awareness, Cross-Sell, Loyalty, Referral, Retention, Up-
Sell, Win-Back, Other

Planned Start/
Planned End

(Required) Defaults to the current date and time. Use the select button 
to change the defaults.

Execution Period A period of time during which the program is to be executed.

Approval Status A status field that indicates that the plan has been Approved, Declined, 
Submitted, or Needs Revision.

Approval History Displays the history of approvals for the budget request.

Priority Choose a priority from 1 to 5.

Duration (in days) Calculated as the number of days between the program’s Planned Start 
and Planned End. This value updates when you save the record.

Region Choose the region to which the program is related.

Organization Click the Organization select button, and select the predefined 
organization to be responsible for the program. An organization that you 
assign to a program is inherited by campaigns in that program.
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3 Save the program.

To add detailed information to programs

1 Click an existing program in the program list (Programs > Program list)

2 Click the Program Details view tab and complete the fields.

Use the following table as a guide.

Field Comment

Objective Enter a text description of the objective for this program.

Product Lines Click the Product Lines select button to select product lines that this 
program promotes.

Products Click the Product select button to select products that this program 
promotes.

Lead Partner Choose a partner organization to associate with the program. The Lead 
Partner is limited to the organizations associated to the program.

Summary Enter a summary that describes the program’s goals.

Program Template Indicates the name of the program template (if any) that has been 
applied to this program.

Default Source Code 
Format

Click the Default Source Code Format select button to select a default 
source code format for this program.

Marketing Plan Shows the parent Marketing Plan if the program is associated with a 
Marketing Plan.

Planning Period Click the Planning Period select button to associate the planning period 
with the plan. The period is associated with the plan for categorization 
and reporting purposes. For example, you may need to track a quarterly 
or annual planning period.

Budget Request Indicates the budget requested for this program. 

Requested Budget Enter a requested budget amount.

Assigned Budget Click the Budget select button to select the program’s currency code, 
exchange date, and budget amount. The budget value is a top-down 
figure, rather than a calculated bottom-up figure.

Forecast Expenses This read-only field displays the sum of the expense data added in the 
Forecast view for campaigns associated with the program.

Actual Expenses Indicates the actual expenses associated with this program.

MDF Requested Indicates the Marketing Development Funds (MDF) associated with this 
program. This association is made on the MDF Pre-approval in the 
Marketing Purpose field.
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3 Save the record.

About Using the Program Flow
The logical flow for both single-stage and multistage programs is designed using the Program Flow 
view. In this view, you graphically define the program’s single-stage or multistage logic by dragging 
and dropping program components such as campaigns, events, lists, segments, and stages into the 
workspace.

You can manually execute the program from the Program Flow view or execute the program by 
scheduling a stage. Before setting up the Program Flow, verify that the following tasks have been 
completed:

■ Define segments and lists and associate them with the campaigns.

■ Define campaigns and associated offers and events.

■ Define segment trees, if required.

The Program Flow view displays the selected program’s details and the interactive workspace with a 
palette of objects representing program elements such as campaigns, internal lists, segments, and 
stages. To set up a program flow, perform the following tasks:

1 Adding Stages to Programs on page 70

2 Specifying Repeating Stages Within Programs on page 71

3 Associating Segments with Campaigns on page 72

4 Adding Campaigns to Stages on page 72

5 Setting Up Waves for Campaign Loads on page 73

6 Adding Imported or Internal Lists to Campaigns on page 75

7 Adding Trees to Campaigns and Allocating Segment Tree Cells on page 75

8 Creating and Applying Program Templates on page 76

9 Executing Programs on page 77

Adding Stages to Programs
Use the following procedure to add a stage to a program, using the Program Flow workspace.

Net Expense 
(forecast)

Calculated as Actual Expense less MDF Requested.

Forecast Revenue Indicates the sum of the revenue predictions (based on data added in 
the Goals view) for campaigns associated with the program. 

Actual Revenue Indicates the actual revenue associated with this program.

Field Comment
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To add a stage to a program

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 Click the Design view tab.

4 In the Program Flow workspace, select the Stage object from the palette, and drag it onto the 
workspace.

5 To complete stage details, double-click the stage object in the workspace.

6 In the Schedule view tab, in the Details list, add or modify stage details.

Use the following table as a guide.

NOTE: To display more fields, click the Details menu button, and then choose Columns 
Displayed.

Specifying Repeating Stages Within Programs
In most multistage programs, each stage occurs only one time, separated by a specified number of 
days between stages. In some circumstances, you may want to have a follow-up stage repeat at a 
different frequency than a previous stage. For example, in Stage 1, you send a direct mailing with a 
Web site link to a large audience. In Stage 2, every day you monitor the Web site mentioned in the 
direct mail offer and call any customers who visit the Web site immediately. In this example, Stage 1 
only occurs one time, and Stage 2 repeats daily until the end of the campaign.

NOTE: When using a repeating stage, be sure that your segment criteria exclude customers that 
were targeted in a previous wave of the same campaign or the same stage.

To specify a repeating stage

1 Navigate to the Programs screen.

2 In the Programs list, click a multistage program.

3 Click the Schedules view tab.

4 In the Schedules link bar, click Details.

Field Comment

Objective Enter the program’s objectives.

Stage Code The default is the record identifier for the stage. Change the identifier 
for the stage source code if desired, but make sure the value is unique.

Stage Name Name of the stage. Change the stage name from the default value to 
something more meaningful such as Stage 1: Summer Program.

Summary Enter summary text that describes the stage’s implementation.
Siebel Marketing User Guide Version 8.0 71



Designing Marketing Programs ■ About Using the Program Flow
5 In the Stages list, select a stage to repeat.

NOTE: You cannot repeat Stage 1.

Associating Segments with Campaigns
You previously defined segments with criteria in the Segment Designer. You can associate these 
segments with a campaign in the program.

To add segments to a campaign

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 In the Program Flow workspace, select a Campaign object. If you do no yet have a Campaign 
object, click and drag one from the Objects palette to the workspace, and then select a campaign.

4 In the Objects palette, click and drag the Segment object to the workspace. If segments are 
already associated with the campaign, they automatically appear in the workspace.

5 In the Previously Used Segments dialog box, perform one of the following steps:

a To create a new segment, click Choose a New Segment and select the location of the segment 
to use, and then click OK.

b Select a segment from the list and click OK.

The segment object appears in the workspace.

Repeat Step 5 to add more segments to a stage.

NOTE: When you include stand-alone segments (not part of a segment tree) in a stage, the members 
of the stand-alone segments are not deduplicated against other segments, trees, or lists in the stage.

Adding Campaigns to Stages
If you previously created a campaign, you can add it to a program.

To add predefined campaigns with associated offers

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 In the Program Flow workspace, select the Stage object.

4 In the Objects palette, select the Campaign object, and drag it from the palette to the workspace.
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5 In the Pick Campaign dialog box, select the campaign, and click OK.

NOTE: If the campaign you want is not listed in the Pick Campaign dialog box, it may be already 
associated with another program. Although offers are reusable, campaigns are not. Use the My 
Campaigns or All Campaigns view to determine which program is using the campaign. Then, 
create a new campaign with a different name and the same offers.

To create a new campaign for a program

1 Navigate to the Programs screen.

2 In the Programs list, click a program.

3 In the Program Flow workspace, select the Stage object.

4 In the Objects palette, select and drag the Campaign object from the palette to the workspace.

5 In the Pick Campaigns dialog box, create a new record, enter a name and description for the 
campaign, and click Save.

6 In the Pick Campaign dialog box, select the campaign, and click OK.

7 In the workspace, double-click the Campaign object to open the Design > Offers view.

8 To add one or more treatments:

a Click New in the Offers list and select an offer.

b Click the Treatments list and select one or more treatments for that offer.

9 In the Add Offer dialog box, select an offer, and then click OK.

NOTE: To gauge response to the offer, in some marketing programs, a control segment of customers 
may be targeted by a test campaign with no associated treatment. For more information, see Testing 
Campaigns That Have Email and Fax Treatments on page 151. 

Setting Up Waves for Campaign Loads
If your marketing program consists of a one-time campaign and treatment—and you are confident 
that your organization can handle the volume of responses—then you probably do not need to define 
multiple waves. Siebel Marketing provides a 100 % fully allocated wave (with a wave code of A and 
a time lag of 0) when a campaign is created.

If you are planning a multistage recurring campaign and anticipate a large distribution list of contacts 
to receive an offer, you may want to take a measured approach to distribution and split fulfillment 
of the offer among a number of waves.

Waves, or set distribution periods, are commonly used to:

■ Test the campaign concept. An initial sampling to gauge campaign response is followed by a 
larger distribution.

■ Examine the campaign mechanics. A measured distribution of the campaign offer provides 
information to guarantee the campaign mechanism works efficiently from order entry, to 
fulfillment, to response tracking.
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■ Balance the load on a fulfillment center. In this case, each wave may include 10 to 15% of 
the list to make sure existing resources can reasonably handle launching a campaign, including 
managing campaign responses.

In addition to setting up waved distribution periods, you can set a lag time for additional waves that 
reference the stage launch date, and then split the generated list by a percentage of contacts for 
each wave period. You can also split by a List Measure. The measure must be included in the list to 
be available for use in splitting the list.

You can use the List Distribution list to specify the vendor export list format and distribution method 
for each wave. Before creating a second wave, decrease the number in the % field of the first wave, 
which, by default, is 100%. The total percentage of values cannot exceed 100.

To set up multiple waves for a campaign load

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click a campaign name.

3 Click the Design view tab.

4 From the link bar, click Wave Settings.

5 In the Waves list, create a new record.

Use the following table as a guide.

6 Complete the necessary fields and save the wave record.

Field Comment

Wave Code Enter a wave code, up to 10 characters. You cannot save the record without 
a wave code. The wave code appears as part of the source code for the 
campaign member if you set up the source code format to include it. The wave 
code for the default wave is A.

Description Describe the characteristics of the wave.

Lag The default is 0. Enter the amount of time the wave is delayed after loading 
a campaign. The maximum lag for the waves cannot be greater than number 
of days between the start date and end date of the campaign.

The wave is launched when the server processes the Launch Campaign 
request.

This server process can be scheduled or can be manually started using the 
right-click menu in the Program Flow workspace.

Lag Unit Choose either Hours or Days. 

% The default percentage is 100 for a single wave. If you are planning multiple 
waves, first reduce the percentage number in the first wave and enter the 
percentage of contacts that are included in the second wave. The total 
percent values cannot exceed 100%.
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Adding Imported or Internal Lists to Campaigns
Imported or internal lists of contacts may be added to the campaign. To check the status of an 
imported list, double-click the list icon in the Program Flow workspace to display the List Contacts 
and Prospects view.

To add a list to the campaign

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 In the Program Flow workspace, select the Campaign object.

4 From the Objects palette, select the List object, and drag it to the workspace.

5 In the Pick Campaign List dialog box, select an imported or internal list, and click OK.

The List object appears in the workspace, linked to the stage and referencing the campaign.

NOTE: To view and edit list details, double-click the List object in the workspace.

Adding Trees to Campaigns and Allocating Segment 
Tree Cells
Each campaign in your program can use one or more segment trees. After you associate a campaign 
to your program, you must allocate each segment tree within the campaign.

Adding a Segment Tree to a Campaign
You can associate one or more segment trees with a campaign.

To associate a segment tree with a campaign

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click the campaign name.

3 Click the Design view tab, and then click the Segment Trees link.

4 In the middle list, click New.

5 In the Pick Segment Tree dialog box, click Choose a new Segment Tree.

6 In the second Pick Segment Tree dialog box, from the folders, select the Segment Tree.

7 In the Pick Segment Tree dialog boxes, click Save, and then OK to save the tree to the campaign.
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Allocating Segment Tree Cells to a Campaign
After you associate a segment tree with a campaign, you must allocate each segment tree cell to the 
treatments for the campaign. If you include stand-alone segments in the campaign that are not part 
of the segment tree, the members of the segment are not deduplicated against members of the tree 
or against other stand-alone segments. Only segment tree cells are deduplicated against other cells.

To allocate segment tree cells to a campaign

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click the campaign name. 

3 Click the Design view tab, and then click the Segment Trees link.

4 In the segment tree list, select a tree.

5 In the allocation matrix, perform the following steps:

a If the tree does not match the latest version of the tree that is in the Segment Tree Designer, 
click Refresh Tree.

This action redraws the tree structure (refreshes the stored definition of the tree in the 
database), and clears any allocations. The row across the top right displays the name and 
treatment code for each treatment.

b Select the appropriate check boxes to indicate which cells are to be allocated to each treatment.

You can allocate a single cell to more than one treatment, if desired. If you want each cell to 
receive a single treatment, be sure to check only one box for each row. The total allocated 
count appears along the bottom of the matrix as you check the boxes.

6 Click Save.

CAUTION: The Design view does not automatically save your changes to the matrix. If you do 
not click Save, the changes are not written to the database.

Creating and Applying Program Templates
You can save any program you create as a reusable program template. The template retains many 
of the planning details from the program such as the program flow, related campaigns, activity plans, 
documents, and other details. After you create a program template, you can apply the template to 
new programs. You can also share the template with other employees in your organization.

Program templates also include child campaign templates for each of the campaigns in the design. 
For more information about campaign templates, see Creating and Applying Campaign Templates on 
page 135.

To save a program as a program template

1 Navigate to the Programs screen.

2 In the Programs list, click a program to use as a template.
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3 In the Program form, click the menu button, and choose Save As Template.

This menu option is active only if your administrator has given you permission to use this action 
(using the Marketing access groups).

4 In the Save As Template dialog box, enter a name, and click OK.

5 To make changes to the new template, navigate to the Marketing Templates screen > Program 
Templates view.

6 Query for the template you created in Step 4 on page 77.

7 In the template list or form, make the necessary changes.

To apply a program template to a program

1 Navigate to the Programs screen.

2 In the Programs list, either create a new program, or select the program name to which to apply 
the template.

3 In the Program form, click the menu button, and choose Apply Template.

4 In the Apply Template dialog box, select the template to apply, and click OK.

5 When asked if you want to continue, click OK.

The Message dialog box, appears, confirming that the template was applied.

NOTE: You cannot apply a program template if your program already has stages in the program 
flow. If your program has existing stages, delete them from the program flow before applying 
the template.

6 In the Message dialog box, click OK.

Executing Programs
You can manually execute a program from the Program Flow link in the Design view. Alternatively, 
you can execute a program by scheduling a stage in the calendar. In the Schedule view, you use the 
calendar link to invoke the workflow process and execute the server tasks.

To execute a program using the Design view

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 In the Design view, click Program Flow

4 In the Design view, right-click on the campaign.

5 Select Load Campaign.

6 In the Load Campaign Dialog Box, select the time and date, and click OK.

7 In the Design view, right-click on the campaign.
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8 Select Launch Campaign.

9 In the Launch Wave dialog box, select the wave or waves to launch, and click OK.
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6 Creating and Using Offers 
and Treatments
This chapter describes how to create offers and treatments to present content on product and 
services to current and potential customers as part of a campaign. It includes the following topics:

■ About Creating and Using Offers and Treatments on page 79

■ Creating, Modifying, and Associating Products with Offers on page 80

■ About Creating and Editing Treatment Templates on page 84

■ Creating Treatment Templates and Adding to the Template List on page 85

■ About Email Treatments on page 87

■ Previewing Treatments on page 99

■ Personalization Items on page 99

■ About Creating Conditional Content on page 103

■ About Fax Treatments on page 108

■ Web Treatments on page 110

■ Creating Other Treatment Types on page 115

■ Associating Literature with Treatments on page 119

About Creating and Using Offers 
and Treatments
An offer is a single proposition or message to a customer that provides an incentive to respond. 
Offers are associated with a campaign, and then presented to contacts and prospects when the 
campaign is launched. Offers can be reused in many campaigns, but the campaign is a one-time 
instance of the offer presented to a customer at a certain point in time.

A single offer can have multiple treatments; each treatment delivers the offer by means of a specific 
channel and campaign. A treatment is a channel-specific instance of an offer. You create a treatment 
for every channel, such as email or direct mail, through which you want to deliver the offer.

Offers associated with campaigns are created using the Offers screen. Typically each campaign has 
a single offer, but you can associate multiple treatments with that offer. For example, a single 
campaign may have an associated offer that has email and Web treatments.

Using the Offers views and Treatments views, you can create, edit, and preview reusable offers with 
multiple channel-specific treatments, which can be associated with your campaigns.
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In addition, you can design personalized HTML and text templates for email treatments. You can 
create email treatments containing conditional content that is based on contact and prospect 
attributes. Additionally, email treatments can contain embedded links to items such as Web 
treatments and Web surveys, so the marketer can assess and capture campaign responses. Web 
Treatments can contain embedded links to Web surveys, events and related URLs, downloads, and 
response forms.

Process of Creating and Modifying Offers
To create and modify offers, perform the following tasks:

■ Creating, Modifying, and Associating Products with Offers on page 80

■ Associating Products with Treatments on page 83

Creating, Modifying, and Associating 
Products with Offers
You can create reusable offers in the Offers screen, adding details such as the channel to use, 
activation and expiration dates, templates, literature, and so on. For more information about using 
offer templates to create an offer, see Creating Treatment Templates and Adding to the Template List on 
page 85.

Use the Offers link bar to navigate directly to a treatment type. The types of treatments that are 
available to you depend on the features your company is licensed to use. After you create or modify 
an offer, you can create and add treatments to the offer, and associate products with the offer.

Creating and Modifying Offers
You can use the following procedures to create and modify offers.

To create or modify an offer

1 Navigate to the Offers screen.

2 In the All Offers list, create a record, or select an offer to change.

3 Complete the fields.

The following table describes some of the fields.

Fields Comment

Offer Code Contains a unique code that identifies the offer. You can 
change this code, but make sure the new value is unique.

Type Designates the purpose of the offer. For example, Cross-
Sell, Retention, or Up-Sell.
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Activation Date Identifies the date that the offer becomes active. You can 
associate an inactive offer with a campaign, but when you 
launch the campaign, only active offers are executed.

Expiration Date Use the calendar controls to select the offer’s expiration 
date.

Expired offers must not be associated with campaigns 
because they are not sent out when the campaign is 
launched.

Organization The organizations that have visibility to associate to see 
this offer in their campaign design views.

Approval Status Indicates if the offer has been submitted, approved, or 
declined.

Approval History Shows the approval history of the offer.

Products Use to indicate which products are being promoted by this 
offer.

Price List Used to associate a previously defined price list with this 
offer.

A marketer can create promotional prices for specific 
products. When an offer recipient clicks a product item 
hyperlink in an email or Web treatment and goes to the 
product detail Web page, the recipient sees the predefined 
promotional price.

The set of products associated with the selected price list 
can be different from the set of products defined in the 
offer’s product list. When a contact responds to a 
treatment, clicks a product link, and goes to the product 
detail page, the contact sees the promotional price that is 
defined for that product only if that product is a part of the 
price list that was selected for this offer. Otherwise, the 
contact gets the default price for the product.

Promotion Use to associate a Promotion from the Order Management 
system (from the product catalog), such as a special price 
discount or product bundle.

Loyalty Promotion Shows the Loyalty promotion associated with this offer. 
The offer is used to advertise this loyalty promotion. When 
a customer transacts accordingly, the promotion can 
award them loyalty points.

Fields Comment
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Adding Treatments to Offers
You can use the following procedure to create treatments and add them to offers. After creating a 
treatment you can associate a treatment template with it.

To create a treatment

1 Navigate to the Offers screen.

2 In the link bar, select the Treatment channel you want to add.

3 Complete the fields in the Treatment Details screen, using the following table as a guide.

Table 10. Treatment Details Fields

Fields Comment

Treatment Code Contains a unique code that identifies the treatment. You can 
change this code, but make sure the new value is unique.

Channel Identifies the channel used to distribute the treatment.

For example, Email, or Fax.

Parent Offer Choose the offer with which to associate the treatment.

Type Designates the purpose of the offer. For example, Cross-Sell, 
Retention, or Up-Sell.

Activation Date Identifies the date that the treatment becomes active. You can 
associate an inactive treatment with a campaign, but when you 
launch the campaign, only active treatments are executed.

Expiration Date Use the calendar controls to select the treatment’s expiration 
date.

Expired treatments must not be associated with campaigns 
because they are not sent out when the campaign is launched.

Subject Text Email Treatment only. Enter the subject text of the email.

Description Enter a description of the treatment.

Organization Use to associate the organization that has visibility to see this 
treatment in its campaign design views.

Approval Status Indicates if the treatment has been submitted, approved, or 
declined.

Approval History Shows the approval history of the treatment.

Products Use to indicate which products are being promoted by this 
treatment.

Subscription List Use to select a marketing list of type Subscription List and 
associate this list with this treatment. The subscription list may 
already have contacts or prospects or be empty.
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Associating Products with Treatments
You can associate predefined products with a treatment. Ideally, you only select a subset of products 
from the price list associated with an offer, because there is a many-to-one relationship between the 
products and the price list. The products that you associate with the offer determine which product 
catalog page links can be embedded in Email and Web treatments.

Language For email treatments, do not change the value in this field.

Version Use this field if you create multiple versions of the same 
treatment in the same channel. You can enter any numeric 
value.

Locale Used to locate the correct, language-specific Web page.

Email Marketing Server Used for email treatments and Web treatments only. Use to 
select the Email Marketing Server when sending an Email 
Treatment. This server provides the following:

■ From and Reply-To header values.

■ Connection details for the email sending daemon.

■ SMTP envelope Sender address domain (for bounces).

■ Base URL to use in constructing Response Forms and Related 
URLs.

■ Web Server base URL (for product catalog items, Web offers, 
Web surveys, some response forms, and events).

Create Activity check box Used for email treatments. Select the Advanced tab for the email 
treatment set activity logging. When the email is sent, an 
activity is created for each recipient of the email, stating that the 
email was sent. Email sent means that the recipient list was sent 
to the ESD, and the ESD did not report any problems. The 
activity record is created through the System Activity Object for 
either the Campaign Recipient or Campaign Position business 
components.

For more information, see Creating Activities for Contacts and 
Prospects on page 98.

Delivery Profile Used when sending fax treatments. This field is only available in 
the fax treatments view, not in fax treatment records in the All 
Treatments view. Profiles are created using the Communications 
Administration screen’s Communications Drivers and Profiles 
view. For more information, see Creating Delivery Profiles and 
Associating with Fax Treatments on page 110.

Table 10. Treatment Details Fields

Fields Comment
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To associate a product with a treatment

1 Navigate to the Offers screen.

2 In the All Treatments list, select the treatment and click the Products select button.

3 In the Products dialog box, in the Available list, select one or more products, and then click Add 
to copy them to the Selected list.

4 Click OK.

About Creating and Editing Treatment 
Templates
To create an Email Treatment or Web treatment, you must start with a treatment template. A 
template can be empty or can include text and other elements. Treatment templates are available 
in Siebel Marketing, Siebel Web Marketing, and Siebel Campaigns. You can create the document that 
serves as a template using any HTML tool or text editor such as Adobe GoLive, Macromedia 
Dreamweaver, Microsoft Front Page, or Windows Notepad. After creating the source document you 
upload it to the Treatment Templates list. 

After creating a template, you add the file to the template list and associate the template with a 
treatment. When you associate a template with a treatment, Siebel Marketing creates a copy of the 
template, leaving the master unaffected. This copy has the same name as the original and adds a 
time stamp to provide a history.

Treatment templates can be associated with the following treatment types:

■ Fax treatments. For more information on Fax treatments, see Associating Templates with Fax 
Treatments on page 109.

■ Email treatments. When creating an email treatment, you can use the Edit Email view tab to 
associate a template with the treatment.

■ Web treatments. When creating a Web Treatment, you can use the Edit Web Treatment view 
tab to associate a template with the treatment.

Process of Creating and Editing 
Treatment Templates
To create and edit treatment templates, complete the following tasks:

■ Creating Treatment Templates and Adding to the Template List on page 85

■ Using Merge Fields in Email Treatments on page 101

Related Topics
■ About Using Hyperlinks (HREF) in Treatment Templates on page 86

■ Personalization Items on page 99
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■ Merge Fields Personalization Item on page 100

Creating Treatment Templates and Adding to the 
Template List
Treatment templates are usually created with a file type of text (TXT) or HTML (HTM or HTML). You 
create the template using third-party HTML tools and text editors, such as Microsoft Front Page and 
Windows Notepad.

After creating the template using a third-party tool, you must add the new template to the Treatment 
Templates list so that you can associate it with a treatment.

To create an HTML or text treatment template

1 Create an HTML template, using third-party HTML or text editor of your choice:

a Using Microsoft Word, Front Page, Notepad, or another editor, create a new file.

b For HTML templates, save the file using an HTM file extension.

CAUTION: Take care when using quotation marks in personalization elements. Some 
applications replace straight quotation marks (") with curly (also called smart) quotation 
marks (“”). Curly quotation marks cause errors when used in personalization elements.

2 If it does not already exist, create a directory of your HTML templates directory and name it 
Images.

In this directory, you store the graphics to be used in the treatment. Make sure that you refer to 
each image as follows, replacing image.gif with the name of the embedded image:

<IMG BORDER=0 SRC="http://<server name>/Web Marketing/images/image.gif">

NOTE: You cannot use HTML or embedded images in text email. However, some email readers 
display images that the sender attached to a text email at the end of the text email.

3 Add the template you created to the Treatment Templates list.

4 Copy the images you embedded in your treatment to the subdirectory you created or the image 
folder you referenced in Step 2.

To add a template to the Treatment Templates list

1 Navigate to the Offers screen.

2 In the link bar, click Treatment Templates.

3 In the Treatment Template list, create a record.

4 Complete the fields to add the treatment template to the list:

a In the Name field, enter a name for the template.

b Click the File Name select button and select the template file.
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To modify an existing treatment template

1 Make the necessary modifications to the template file saved on your local drive, using the same 
text editor used to create the file.

2 Save and close the file.

3 Navigate to the Treatments screen > Treatment Templates view.

4 In the Treatment Template list, select the template record.

5 In the File Name field, click the select button.

6 In the Add Attachment dialog box, click Browse.

7 Select the file, and click Open.

About Using Hyperlinks (HREF) in Treatment Templates
Siebel Marketing can perform a special processing task for HTML-based emails and Web treatments. 
A URL address entered directly into the body of an HTML template, such as http://
www.mycompanyname.com, is not recognized as a hyperlink by the HTML parser. The generic HTML 
syntax for a hyperlink is:

<a href="target url">highlighted text or picture</a>

The link includes both the URL and the anchor, which is the text or image that appears in the template 
and links to the URL. Thus, to create a link to the URL http://www.mycompanyname.com and display 
the web site as the text in the message, you must enter the following:

<a href="http://www.mycompanyname.com">MyCompanyName Web Site</a>

Using this method, Web treatments, response forms, and product items are replaced differently in 
HTML templates from the way they are replaced in text templates. The following list describes the 
default method for processing hyperlinks:

■ For Web treatments, Web surveys, and product links, Siebel Marketing creates the hyperlink so 
that the hyperlinked text is the Web treatment name, Web survey name, or product name such 
as in the following reference:

<a href="[Web Treatment: 10% discount offer]">10% discount offer</a>

For more information, see Personalization Items on page 99.

■ For Response forms, Siebel Marketing creates the hyperlink so that the hyperlinked text is the 
same as the Response forms description in the Response Types view. The hyperlinked text for a 
response form can be modified in the Response Types view, where, for each response form, a 
description field represents the value used for highlighted text.

These default methods for processing hyperlinks in Siebel Marketing can be modified. You can put 
an asterisk (*) before the tag to tell the application that you are manually defining the hyperlink 
format in the HTML body. The asterisk tells the application not to create the hyperlink.

For example, instead of inserting [Web Treatment: Great Discount], the marketing manager can 
enter the following:
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<a href="[*Web Treatment: Great Discount]">Whatever I want to highlight be it text 
or picture</a>

In this case, Siebel Marketing replaces the Web Treatment with the proper URL but does not create 
the HREF syntax. You can then create a Web treatment link, product item link, and response form 
link with any text or picture you want.

About Email Treatments
Using the Email Treatments view, a marketer can design and distribute a personalized email 
treatment to target recipients of a campaign. An email treatment can be associated with a price list 
for various products. If the recipient clicks on a product link in an email treatment, the product detail 
page displays the promotional price for that product rather than the list price.

The Email Treatments view includes the Treatment Details, Edit Email, Delivery Profile, Attachments, 
and Advanced tabs.

■ Treatment Details. This form contains additional fields that you can use if the email treatment 
requires approvals from your company’s marketing and legal departments. It provides a unique 
identifier for the treatment in the Treatment Code field. Use this form to specify the email 
treatment’s Subject Text, the Email Marketing Server (Reply-To and From headers, Email 
Marketing Daemon configurations, and Web Server URLs) to be used to distribute the treatment, 
and Personalization Format to use with this treatment.

■ Edit Email. Use this form to edit the template content and to select Personalization Items such 
as Related URLs, Response Forms, and merge fields. Category elements can be inserted into the 
template in the HTML Editor.

■ Delivery Profile. This read-only list provides a list of the Email Marketing Server parameters for 
the Email Marketing Server that is associated with the treatment.

■ Attachments. Includes literature items with your email treatment. These items are delivered as 
attachments to the email when the campaign is launched.

■ Advanced. Contains the Related Web Treatments, Related Web Surveys, Related Events, and 
Related URLs lists. Use these lists to specify the Web treatments, Web surveys, events, and URLs 
that you plan to include as hyperlinks in the email treatment. Adding these elements embeds 
them as a Personalization Element. Web Surveys are created using Siebel SmartScript. For more 
information, see Siebel SmartScript Administration Guide.

Whenever a treatment recipient clicks a Web treatment, Product Catalog Item, or Related URL 
link in an email treatment, the click is captured as a response. The available response types are 
Clicked On Web Treatment, Clicked On Web Survey, Clicked On Product URL, and Clicked on URL.

NOTE: Siebel Events views are not currently included in the Siebel Web Marketing application. 
Therefore, if you embed a related event in an email treatment, related events must be directed 
to the Web Server on which Siebel Events is installed. To accomplish this, the Web Server field 
must contain the location of the Web Marketing Web Server and the location of the Events server. 
For more information see the Web Server field description in Table 10 on page 82
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Process of Working with Email 
Treatments
To set up Email Treatments, perform the following:

■ Creating Email Treatments on page 88

■ Associating Templates with Email Treatments on page 92

■ Editing Treatments on page 92

■ Adding Attachments to Email Treatments on page 96

■ Adding Response Forms to Email Treatments on page 96

Related Topics
■ About Merge Fields in Email Treatments on page 102

■ Adding Response Forms to Email Treatments on page 96

■ About Creating Conditional Content on page 103

■ If-Then-Else Personalization Element on page 104

■ Named Blocks Personalization Element on page 106

■ Creating, Modifying, and Associating Products with Offers on page 80

Creating Email Treatments
Siebel Marketing has multiple forms of email treatments available for use in campaigns. The following 
topics cover these treatments.

■ Creating Email Confirmation Treatments on page 90

■ Creating Email Welcome Treatments on page 90

■ Including Forward to a Friend in Your Email Treatments on page 91

■ Creating a Text Email from an HTML Template on page 91

To create an email treatment

1 Navigate to the Offers screen.

2 Click Email Treatments.

3 In the Email Treatments list, create a new record.

4 Complete the fields, using the table in the topic Adding Treatments to Offers on page 82 as a 
guide.
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Email treatments have their own specific channel types available. Table 11 describes these email-
specific channels. You must always create a treatment using the Email channel. Use the other 
channels when implementing a double-opt in or subscription confirmation process. When you create 
treatments using these other channels, they must be associated with the same campaign as the 
original Email channel treatment.

Table 11. Channel Types for Email Treatments

Email Channel Description

Email The Email channel is for standard email treatments that do not use a 
subscription list.

Email-Confirm In The Email-Confirm In channel produces a confirmation opt-in treatment 
that is delivered to users. The confirm-in treatment is triggered by a user 
responding to the Confirm Subscribe to List Response Form. When this 
response form is clicked, this confirmation is delivered to the user with an 
additional link asking to confirm opt-in status to the email program.

For more information, see Creating Email Confirmation Treatments on 
page 90.

Email-Confirm Out The Email-Confirm Out channel produces a confirmation opt-out 
treatment that is delivered to users. The confirm-out treatment is 
triggered by a user responding to the Confirm Unsubscribe List Response 
Form. When this response form is clicked, this confirmation is delivered to 
the user with an additional link asking to confirm opt-out status to the 
email program.

For more information, see Creating Email Confirmation Treatments on 
page 90.

Email-Welcome The Email-Welcome channel produces a standard welcome message to the 
email program. This message is triggered by a user recording a 
subscription record in the database. This message is triggered by a user 
responding to the "Subscribe to List" response form.

This message does not ask for confirmation, thus it is not a replacement 
for the Email-Confirm In channel. Use the Welcome channel when you do 
not want to have a double opt-in method as is used by the Email-Confirm 
In channel.

For more information, see Creating Email Welcome Treatments on page 90.
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Creating Email Confirmation Treatments
Email confirmation treatments are used to respond to customers who have clicked on a confirm 
subscribe to list response form or a confirm unsubscribe to list response form in a previous message. 
These treatments are sometimes called double opt in or double opt out treatments because from the 
recipients’ point of view they must take two actions to opt in or out. The first act is to click on a 
response form in an initial email, the second is to respond to the confirmation email. If you do not 
require your customers to go through two steps to opt in, you can send an Email-Welcome treatment 
instead of an Email-Confirm In treatment. For more information, see Creating Email Welcome 
Treatments on page 90.

Siebel Marketing sends out an Email-Confirm In or an Email-Confirm Out message to only those 
contacts who have clicked those response forms. If your list includes contacts for whom there is no 
record of the confirm subscribe to list or confirm unsubscribe to list events, Siebel Marketing skips 
over them and does not send a confirmation treatment.

To create an email confirmation treatment

1 Navigate to the Offers > Email Treatments screen.

2 Create a new email treatment.

3 Set the Channel field to either Email-Confirm In or Email-Confirm Out.

4 Associate the Parent Offer to the treatment.

5 Associate a subscription list to the treatment.

6 In the edit email view, associate a treatment template to the treatment.

7 In the edit email view, include a response form for Subscribe to List within the body of the 
message.

8 Save the treatment.

9 Navigate to the Campaigns view.

10 Associate the treatment to the appropriate email confirmation campaign.

Creating Email Welcome Treatments
If you do not require your customers to use a double opt-in confirmation to accept the offer, then 
after the customer has clicked on the subscribe to list response form, you typically follow up with an 
Email-Welcome treatment. Siebel Marketing sends out an Email-Welcome message to only those 
contacts who have clicked the subscribe to list response form. If your list includes contacts for whom 
there is no record of the confirm subscribe to list event, Siebel Marketing skips over them and does 
not send the Email-Welcome treatment.

To create a welcome message

1 Navigate to the Offers > Email Treatments screen.

2 Create a new email treatment.

3 Set the Channel field to Email-Welcome.
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4 Associate the Parent Offer to the treatment.

5 (Optional) Associate a subscription list to the treatment.

6 In the edit email view, associate a treatment template to the treatment.

7 Save the treatment.

8 Navigate to the Campaigns view.

9 Associate the treatment to the appropriate email confirmation campaign.

Including Forward to a Friend in Your Email Treatments
Siebel Email Marketing can include a Forward to a Friend link in email treatments. This provides a 
means for your contacts and prospects to forward a version of the message to others and optionally 
to add a personalized note as well.

To include Forward to A Friend in a treatment

1 Navigate to the Offers > Email Treatments screen.

2 In the Treatments list, click an email treatment.

3 In the edit email view, select a template to edit.

4 In the HTML editor view, in the left field on the Personalization Items toolbar, select Response 
Forms.

NOTE: If you do not see the Personalization Items toolbar, right-click on a blank part of the 
toolbar area and select Personalization Items.

5 In the right field on the Personalization Items toolbar, choose [Response: Forward to Friend].

6 Click the location in the template where you want to insert the Forward to Friend link.

7 On the Personalization Items toolbar, click Insert.

Creating a Text Email from an HTML Template
You can create a text version of your HTML treatments. By creating the text version, you can 
streamline your production efforts. This creates a text template from the HTML template. You may 
need to adjust the formatting prior to delivery.

To create a text email from an HTML template

1 Navigate to the Offers > Email Treatments screen.

2 In the Treatments list, click an email treatment.

3 In the list between the Treatments list and the Editor, create an additional template for the 
treatment.

4 In the Template Name field, choose a text treatment template and click OK.

5 Return to the HTML template within the treatment.
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6 Click Save Text Template.

7 To view the results, select the text template in the list above the Editor.

The text content appears in the Editor.

Associating Templates with Email Treatments
You can associate a template with an email treatment. To edit the treatment template, see About 
Creating and Editing Treatment Templates on page 84.

To associate a treatment template with an email treatment 

1 Navigate to the Offers screen > Email Treatments view.

2 In the Email Treatments list, select the treatment.

3 In the Edit Email tab, create a new record.

4 In the Edit Email list, complete the necessary fields.

a Siebel Marketing populates the Sequence field. Change the sequence if you are adding multiple 
templates with rich and plain format. The sequence field includes email attachments. Therefore, 
when you add your first template, you may get a sequence number other than 1.

For example, if you have two templates (one HTML and one text) associated with the email 
treatment, adjust the sequence so that you associate the plain format (text) first and the rich 
format (HTML) last. This change satisfies the Multipart MIME standard. The Multipart MIME 
standard defines a way to send both the text and HTML content together within the body of 
a single email message. The email program displays only the part that it has been configured 
to display.

b In the Template Name field, click the select button.

You can associate one text template and one HTML template with the treatment.

c In the Pick Treatment Template dialog box, select the template record, and click OK.

5 Save the record to associate the template with the treatment.

Editing Treatments
After you add a template to a treatment, you can edit it in the following ways:

■ Edit a template in the Treatments screen. Make changes to your treatment using the HTML 
editor or a text editor. In the Edit Email view, select a template to modify. The template appears 
for editing at the bottom of the page.

If you created your template as an HTML file, you can use the HTML editor to render the HTML 
source (tags and text) and to modify the rendered HTML. If you created your template as a text 
file, a text editor displays the treatment contents for editing. Preview it to verify the treatment’s 
syntax, including merge fields and embeddable objects.
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■ Modify a template using a third-party HTML editor. If you need to make edits that are not 
possible in the HTML editor, you can modify the template using a third-party HTML editor. 
Examples of third-party editors are Adobe GoLive and Macromedia Dreamweaver. For more 
information, see Editing a Template Using a Third-party Default HTML Editor on page 95.

To edit an email treatment

1 Navigate to the Offers screen > Email Treatments view.

2 In the Email Treatments list, select an email treatment.

3 In the Edit Email tab, select a template to change.

One of the following editors starts:

■ Text editor. You use this tool to make simple changes to the text. The text editor starts by 
default, if the selected template is a text (.txt) file.

■ HTML Editor. You can use this tool to make more complex changes than you can make in a 
text editor. The HTML editor starts by default, if the selected template is an HTML file (HTM 
or HTML file extension). For more detail, see Using the HTML Editor on page 93.

4 If using the HTML editor, check that the Personalization Items toolbar is displayed.

a Right-click anywhere in the toolbar area.

b In the menu, check the Personalization Items option. If it is not checked, check it.

5 To imbed a personalization item (such as a response form or related URL):

a Locate the position in the treatment text where the personalization item is to appear.

b In the Personalization Items toolbar, choose a personalization item from the primary menu. such 
as Events, Merge Fields, Product Catalog Items, Related URLs, Response Forms, Web 
Treatments, or Web Surveys. For more information, see Personalization Items on page 99.

The available elements for the selected category appear in the secondary menu.

c In the secondary menu, choose a personalization item and click Insert.

6 When you finish making changes, click Save Template.

7 To preview your changes and verify that the template still performs correctly, click Verify & 
Preview.

Repeat Step 3 through Step 7 to continue editing the template.

Using the HTML Editor
You can use HTML editor to make changes to your HTML template. To make more complex changes 
than allowed in the HTML editor, see “Editing a Template Using a Third-party Default HTML Editor” on 
page 95.

The HTML editor supports the following features:

■ Alignment options: left, center, and right

■ Alt-tag support
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■ Bold, italic, and underline

■ Bulleted List

■ Clip art support

■ Copy, cut, and paste

■ Fonts (typeface, size, style)

■ Find and replace

■ Graphic support

■ HTML formatting characters such as: NBSP (non-breaking space)

■ HTML source view

■ Hyperlinks

■ If-Then-Else conditional statements

■ Image map support

■ Indents

■ MS Office document integration

■ Numbered Lists

■ Personalization support (events, merge fields, response types, web surveys)

■ Spelling checker

■ Styles

■ Tables

■ Undo and redo

■ Upload content to web servers

To make changes using the HTML editor, you enter your changes directly in the workspace. In 
addition, you can use the editing toolbar in the Template Contents workspace for formatting text. 
Most of the buttons on the toolbar are the same buttons that appear in standard text editing 
software. Table 12 summarizes some of the typically used tasks and how to accomplish them.

Table 12. HTML Editor Commands

To do this ... Right click in the workspace and choose ...

Copy selected text or graphics Copy

Cut selected text or graphics Cut

Insert a graphic Picture

Insert a hyperlink Hyperlink

Insert HTML Insert HTML

Paste plain text only, removing any embedded 
HTML tags or other formatting

Paste text
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Adding Graphics to HTML Email Treatments
You can add a new graphic to an email treatment using the HTML editor.

To add a graphic to an HTML email treatment

1 Navigate to the Offers screen, and from the link bar select the type of treatment.

2 In the Treatments list, select a treatment, and click the Edit Email tab.

3 In the Edit Email tab, place your cursor at the location where you want to insert the graphic.

4 On the toolbar, click the Picture icon.

5 In the dialog box, browse for the graphic either on your computer or on the network and then 
click OK. 

A thumbnail rendition of the graphic appears in the dialog box.  

6 In the dialog box, adjust the picture dimensions if necessary, and then click OK.

7 If another prompt appears requesting a user identifier and password, accept the default values 
and click OK.

Another message appear indicating that the graphic is being uploaded to the server.

Editing a Template Using a Third-party Default HTML Editor
If you prefer to use a third-party HTML editor over the HTML editor, you can do so using the following 
procedure.

To edit a template file using your default HTML editor

1 Navigate to the Offers screen and, from the link bar, select the type of treatment.

2 In the Treatments list, select a treatment, and click the Edit Email or Edit Web Treatment tab.

3 For email treatments, select the HTML template in the list between the Treatments form and the 
Editor.

4 In the HTML Editor toolbar, click the View Source icon.

5 Copy all the text in the workspace to your third-party HTML editor.

6 In the third-party HTML editor, make changes to the template.

Paste the most recently copied text or graphics Paste

Remove unnecessary HTML tags Clean HTML

Switch view to show a preview of the page View as WYSWIWYG (default)

Switch view to show text with HTML tags View as HTML

Table 12. HTML Editor Commands

To do this ... Right click in the workspace and choose ...
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7 Paste the changed template source text back into the HTML editor.

8 In the Edit Email list, associate the HTML file to a treatment.

Adding Attachments to Email Treatments
Use the following procedure to add literature items as email treatment attachments. Be aware that 
some Internet Service Providers limit the size of emails and email attachments that they deliver to 
their subscribers.

To add an attachment

1 Navigate to the Offers screen > Email Treatments view.

2 In the Email Treatments list, click the treatment name.

3 Click the Attachments view tab.

4 In the Attachments list, create a new record.

5 Click the Name select button, select a literature file to attach, and click OK.

6 In the Attachments Label field, enter an attachment label for each file.

Adding Response Forms to Email Treatments
You can include a variety of response forms in an email treatment. Whenever a customer receives 
the email treatment and clicks on the hyperlink for a response form, responses are created for the 
campaign.

Response types are fields in a response record. A response record may be generated by the email 
recipient clicking the response form link or by completing a form on the Web page to which he or she 
has been directed.

Table 13 contains a list of response forms that are unique to email treatments and a brief description 
of each.

To add a response form to an email treatment

1 Navigate to Offers screen > Email Treatments.

2 In the Email Treatments list, click an email treatment name.

3 Click the Edit Email view tab.

4 Click a template to edit.

The template appears in the workspace.
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5 In the Personalization Items tool bar drop-down list, choose Response Forms.

Use the following table as a guide.

Table 13. Response Forms and Descriptions

Response Form  Description

Confirm Subscribe To 
List

Use this in an initial email treatment to activate a double opt-in 
process. When the recipient clicks the embedded link, Siebel 
Marketing sends an email confirm-in treatment with a “subscribe to 
list” response form.

Confirm Unsubscribe 
from List

Use this in an initial email treatment to activate a double opt-out 
process. When the recipient clicks the embedded link, Siebel 
Marketing sends an email confirm-out treatment with an “unsubscribe 
to list” response form.

Forward to friend Navigates customers to a page where they can add the email address 
of friends and from where your company can forward the message.

Customers can also provide a text message to be sent with the email 
treatment. When they submit this form, Siebel Marketing generates a 
Forward to Friend response type record and sends a copy of the email 
to any email addresses that the customer provided. It then 
regenerates the Response Form links in the email for the new 
recipient's email address.

One Click Unsub Sets the Do Not Email check box on the contact profile and displays a 
confirmation message to the customer that states that they have been 
unsubscribed from all email treatments.

Read Receipt Detects that the email message has been opened by the customer. The 
customer is not aware of this hidden event.

This link is used only in HTML to embed a 1 x 1 pixel image in the email 
treatment at the location where a response form is placed. If the 
recipient of the email treatment opens the email, Siebel Marketing 
retrieves this image from the Email Marketing Server and updates the 
Message Open Timestamp in the campaign history table 
(S_CAMP_CON). The following list describes some ways a read receipt 
can be blocked:

■ Newer email applications have preferences options that can 
prevent the display of embedded images.

■ Ports used to make the request for the image may be blocked at 
the recipient's firewall.

■ If you place the read receipt image in the HTML part of a multipart 
MIME email message and the recipient sets up their email 
application to read text emails only, the Read Receipt image 
request does not occur.
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6 In the adjacent drop-down list, choose a response type.

7 Position the cursor at the desired location in the content, and click Insert.

8 When you are finished editing, click Save Template.

Creating Activities for Contacts and Prospects
Siebel Marketing can create an activity for each contact and prospect in your mailing. If you enable 
this option, then Siebel Marketing uses the Email Marketing - Update Status workflow to create the 
new activities. The workflow is called after each wave batch sent. You can customize the workflow if 
needed. Table 14 lists the workflow fields and the values used.

Requested call back Navigates customers to a Web page where they can provide contact 
information and from where your company can arrange a follow-up 
phone call.

Requested More Info Navigates customers to a Web page where they can provide contact 
information and from where your company can send more information 
such as brochures or other collateral.

Requested 
Unsubscribe

Navigates customers to a Web page where they can enter 
communication preferences by channel. For more information, see 
Setting Up and Using Web Marketing on page 215.

Subscribe to List Navigates customers to a Web page where a confirmation message 
displays stating that they have been subscribed to the list. This 
response associates the contact or prospect ID of the respondent with 
a subscription list associated with the treatment.

Unsubscribe from List Navigates customers to a Web page where a confirmation message 
displays stating that they have been unsubscribed. Siebel Marketing 
generates an Unsubscribe from List response type record and removes 
their contact or prospect record from the subscription list associated 
with the treatment.

Table 14. Workflow Field Values

Workflow Field Value

Account Id accountId for the contact or prospect

Campaign Id campaignId

Description treatmentName

Done current date

Opportunity Id opportunityId

Table 13. Response Forms and Descriptions

Response Form  Description
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To create activities for contacts and prospects for an email treatment

1 While creating the Email treatment, click the Advanced tab.

2 Check the Create Activity check box.

Previewing Treatments
You can preview what a treatment looks like when received by a contact or prospect in the following 
ways:

■ Click Verify and Preview in the appropriate Edit Template view. Clicking this button 
previews the selected template and tests the behavior of conditional content to various merge 
field values. For more information, see the topic in this chapter that applies to the template you 
are using.

■ Use the Test Treatment feature. This feature is one way to confirm configurations for email 
and fax treatments. For example, when you use this feature to test email treatments you confirm 
configurations such as Email Marketing Server configuration and proper template setup for use 
in multipart MIME. For more information, see Testing Campaigns That Have Email and Fax 
Treatments on page 151.

Personalization Items
Personalization items are categories of supported embeddable object types. Depending on which 
item type you select, the Personalization Elements list contains the available elements for that item.

The available personalization items are:

■ Events

■ Merge Fields

■ Product Catalog Items

■ Related URLs

■ Response Forms

■ Web Treatments

■ Web Surveys

Status Done

Type Email - Outbound

Table 14. Workflow Field Values

Workflow Field Value
Siebel Marketing User Guide Version 8.0 99



Creating and Using Offers and Treatments ■ Personalization Items
Merge Fields Personalization Item
Use merge fields to customize treatments by contact or prospect. Contacts or prospects can have 
multiple fields associated with them, each field defining some attribute of a contact or prospect (for 
example, the person's last name, their first name, or their account number). For each unique contact 
or prospect, the value of these fields may differ. You insert the merge field personalization element 
in the text and then the value of the Contact or Prospect field is populated into the text where you 
inserted the merge field personalization item.

The following simple example shows two prospects with the first names of Sally and Fred, how the 
personalization item appears in the treatment before and then after the contact or prospect field is 
populated.

Before population in the treatment text:

Hello [Field: First Name]!

When Sally receives the treatment, she gets the following:

Hello Sally!

When Fred receives the treatment, he gets the following:

Hello Fred!

In some contact or prospect records, a value might not exist for a non-numeric merge field. For 
example, the database record from which the value comes is a NULL entry. When the contact or 
prospect field is populated, the merge field may default to one of the following values:

■ Empty string. The value is an empty string (a string containing no characters).

■ Unspecified. The value is the word Unspecified.

For Web offers, surveys, events, and URLs to be available as personalization elements Web 
Treatments, Web Surveys, Events, and Related URLs categories, you must add the records to the 
Web Treatments, Web Surveys Related Events, or Related URLs lists. For more information, see About 
Associating Web Offers, Web Surveys, Events, and URLs with Treatments on page 113.

You can insert any field from the Personalization Elements drop-down menu by selecting and 
inserting it into the body of the email message. For related information, see About Using Hyperlinks 
(HREF) in Treatment Templates on page 86.

For example you may want to personalize the offer with the contact’s name, such as: Exciting Offer 
for [Field: First Name] [Field: Last Name].

Using the Merge Fields category, you would select the personalization element [Field: First Name] 
and insert it into the desired location in the message. You would repeat this procedure to add a last 
name. Typically, the tags for personalization elements are enclosed in brackets ([ and ]).

During run time, the target values are substituted for these personalization elements. The response 
forms, product links, Web offer links, and Web survey links are encoded so that they become URL 
links containing the destination address, with campaign, treatment, and recipient codes included. 
Thus, the URL in any text-based email can become long. The following list contains guidelines for 
setting up personalization elements:
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■ The Merge Fields list is driven by your configuration. If you are using the advanced approach, 
merge fields can be extended using fields from the segmentation module. For more information, 
see Using Merge Fields in Email Treatments on page 101.

■ The list of Merge Fields includes a calculated field called Current Date. This merge field is 
replaced by the Campaign Send Date when the campaign is launched.

■ The Product Catalog Items are limited to those defined for the Product catalog page for the 
products associated with the treatment.

■ The list of Web offers is limited to those defined for this treatment in the Related Web Treatments 
list view tab.

■ The list of Web surveys is limited to those defined for this treatment in the Related Web Surveys 
view tab.

■ The list of related events is limited to those events defined for this treatment in the Related 
Events link bar. When you add a related event, you only display events with active dates and that 
have a status code of Executing or In Progress.

■ Use related URLs to embed hyperlinks to treatments and generic Internet Web pages in a 
treatment. When a Contact or Prospect clicks this link, Siebel Marketing records a Campaign 
Response.

■ Typically, response forms are Web forms that a contact or prospect can use to respond to a 
treatment through the Web. The response forms for an email treatment are Confirm Subscribe 
to List, Confirm Unsubscribe from List, Forward to Friend, One Click Unsub, Read Receipt, 
Request Call Back, Request More Info, Request Unsubscribe, Subscribe to List, and Unsubscribe 
from List.

Using Merge Fields in Email Treatments
Your application can be configured to use email merge fields in the following ways:

■ Basic. Provides a static set of merge fields based on the campaign recipient business component. 
These merge fields are available when your organization has not licensed or deployed the 
marketing segmentation module.

■ Advanced. Provides a flexible set of merge fields based on data from any data source or table 
within the application. The merge fields in this case are controlled by the Personalization Format 
(Email Server list format) that you select for the email treatment.

For instructions on configuring the Basic or Advanced modes for email personalization, see the Siebel 
Marketing Installation and Administration Guide.

In the Basic configuration, each category has a number of personalization elements. For example, 
the Merge Fields category has the following personalization elements (depending on the 
personalization format used):

■ [Field: M/M]

■ [Field: First Name]

■ [Field: Middle Name]
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■ [Field: Last Name]

■ [Field: Account]

■ [Field: Account Location]

■ [Field: Job Title]

■ [Field: Work Phone #]

■ [Field: Home Phone #]

■ [Field: Cellular Phone #]

■ [Field: Fax Phone #]

■ [Field: Email Address]

■ [Field: Current Date]

■ [Field: Source Code]

In the Treatments screen, in the Advanced view tab, you need to select the appropriate 
personalization format for the email treatment in the email treatment form. When you create an 
email treatment, the values for the Email Marketing Server and Personalization Format are set based 
on settings established by your administrator.

The default value for Personalization Format field is "Default Merge Fields". If the field value is not a 
path name, the available merge fields come from the Campaign Recipient business component user 
property. Otherwise, the columns in the report identified by the path are displayed in the Merge 
Fields picklist. You can change the default value for this field by using the Email Personalization 
Format server parameter for your object manager. 

To select a Personalization Format (merge fields) for an email treatment

1 Navigate to the Offers > Email Treatments screen.

2 In the Treatments list, click the name of the email treatment.

3 In the Email Treatment form, click the Personalization Format select button.

4 In the dialog box, select the appropriate format from the folders that appear.

For more information about creating Email Server formats, see Siebel Marketing Installation and 
Administration Guide.

5 In the Edit Email form, from the Personalization Items drop-down list, choose Merge Fields.

The merge fields must appear in the Personalization Elements list.

About Merge Fields in Email Treatments
You can use merge fields in the body of a text or HTML email treatment, in the same way that they 
are used within the text or HTML of other treatment types. Additionally, merge fields may be used 
in the following areas related to email treatments:

■ Subject Text field of the email treatment. The text to appear in the subject line of the email.
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■ From Address parameter value. A parameter of the Email Marketing Server in User Delivery 
Profiles.

■ Reply To Address parameter value. A parameter of the Email Marketing Server in User 
Delivery Profiles.

About Creating Conditional Content
There are two personalization elements that can be used to generate conditional content within an 
email treatment. Each of these is made up of the following personalization elements:

■ If-Then-Else. Determines if a block of text or HTML is removed from an outgoing email by 
verifying if a Merge field value is defined. The merge field is defined if it is NOT an empty string 
or, for numeric merge fields, if it is not a value of 0 (zero). For more information, see If-Then-
Else Personalization Element on page 104.

■ If the merge field is defined, the block of text or HTML remains in the outgoing email.

■ If the merge field is not defined, the block of text or HTML is removed from the outgoing 
email.

■ Named Blocks. Used to decide whether or not to insert a block of text or HTML into an outgoing 
email by comparing one string to another. One string is compared to another to determine if the 
block of text or HTML is inserted. For more information, see Named Blocks Personalization 
Element on page 106.

■ If the two strings are identical, the block is inserted.

■ If the two strings are not identical, the block is not inserted.

The components of these personalization elements must be placed in the correct locations in the text 
or HTML email treatment or an error occurs.
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If-Then-Else Personalization Element
Table 15 shows a list of If-Then-Else personalization element components.

The following is a simple example of the use of an If-Then-Else personalization element. If the first 
name is defined, the contact's or prospect's first and last name appears. If the first name is not 
defined, only the last name appears:

$(if [Field: First Name])
Dear [Field: First Name] [Field: Last Name],
$(else)
Dear Mr. or Mrs. [Field: Last Name],
$(endif)

Nesting If-Then-Else personalization elements (placing one within another) is an acceptable practice. 
The following is an example of nesting these elements:

$(if [Field: First Name])
$(if [Field: Last Name])

Dear [Field: First Name] [Field: Last Name],
$(else)

Dear [Field: First Name],
$(endif)

Table 15. If-Then-Else Personalization Element Components

Personalization Element Description

$(else) The Else component is used after a $(if) or $(elseif) component. 
When an analysis of a preceding $(if) or $(elseif) component 
results in the preceding block of text or HTML being removed from 
the outgoing email, the $(else) component's block of text or HTML 
is not removed from the outgoing email. If the preceding $(if) or 
$(elseif) component does not remove its block of text or HTML, the 
$(else) component removes its block of text or HTML.

$(elseif [Field: FieldName]) The Else-If component is the same as the If component, except that 
it is used after the start of the If-Then-Else personalization 
element.

$(endif) The End-If component closes the current If-Then-Else 
personalization element.

$(if [Field: FieldName]) The If component is required to start an If-Then-Else 
personalization element. It determines if the merge field named 
[FieldName] has a value. If there is a value for [FieldName], the 
text between this If-Then-Else component and the next If-Then-
Else component is not removed from the email.
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$(elseif [Field: Last Name])
Dear Mr. or Mrs. [Field: Last Name],
$(else)
To Whom It May Concern:
$(endif)

Use of indentation indicates the nesting of one If-Then-Else personalization element within another. 
Indentation is not necessary, but makes it easier to read. Also, in this example, each component is 
on its own line. This use of separate lines is also not necessary, but it makes reading the treatment 
easier.

After the Email Marketing Server makes the decision about what text or HTML to remove, the If-
Then-Else personalization element components are also removed (including their trailing line 
breaks).

To insert if-then statements

1 Navigate to the Offers > Email Treatments screen.

2 In the Treatments List, click an email treatment.

3 Select a template to edit.

4 If the If-Then-Else toolbar is not displayed, right-click in the toolbar area and select it.

5 In the primary menu, choose If.

6 In the secondary menu, choose a merge field to be personalized.

7 In the tertiary menu, choose a conditional operator.

8 Enter the value of the merge field to be personalized.

9 Select a location in the template to insert the personalized If statement.

10 Click Insert Rule.

11 Place the conditional content between $(if) and $(endif) tags.

12 (Optional) Add $(elseif) conditions if more than one iteration of the content must appear.

13 Place default content after the $(endif) tag.
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Named Blocks Personalization Element
Table 16 shows a list of Named Blocks personalization element components.

NOTE: The string comparison is case sensitive.

The following is a simple example of the use of a Named Blocks personalization element:

<P>The temperature of your favorite drink is $(InsertBlock "[Field: Favorite 
Drink]").</P>
$(DefineBlock "Coffee")
<B>hot</B>
$(EndBlock)

$(DefineBlock "Iced Tea")
<B>cold</B>
$(EndBlock)

$(DefineBlock "Water")
<B>cool</B>
$(EndBlock)

In this example, the merge field named Favorite Drink is the value Coffee. After the merge fields are 
populated, the following sentence appears:

The temperature of your favorite drink is hot.

The HTML source reads:

<P>The temperature of your favorite drink is <B>hot</B>.</P>

If there is no match for an Insert Block component match string, then the Insert Block component 
is not replaced by any text or HTML. After the Email Marketing Server resolves all matches, the 
remaining Named Block personalization element components are removed (including their trailing 
line breaks and any text or HTML between Define Blocks and End Blocks).

NOTE: The Define Block and End Block components may be placed within the HTML HEADER tags. 
This placement can make the email treatment more readable.

Table 16. Named Blocks Personalization Element Components

Personalization Element Description

$(DefineBlock "MatchString") Define Block component. Starts a block of text or HTML that is 
inserted in place of an Insert Block component when MatchString 
is identical to the MatchString of the Insert Block component.

$(EndBlock) End Block component. Ends a block of text or HTML started with 
the Define Block component.

$(InsertBlock "MatchString") Insert Block component. A block of text or HTML is inserted at the 
location this component is placed when MatchString is identical 
to the MatchString of a Define Block component. This comparison 
is case sensitive.
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To insert named blocks

1 Navigate to the Offers > Email Treatments screen.

2 In the Treatments List, click an email treatment.

3 Select a template to edit.

4 If the If-Then-Else toolbar is not displayed, right-click in the toolbar area and select it.

5 In the primary menu, choose Insert Block.

6 In the secondary menu, choose a merge field.

7 In the secondary menu, choose a merge field to be personalized.

8 Select a location in the template to insert the block.

9 Click Insert Rule.

This inserts the block to be personalized. You need to define the values that have personalized 
content.

To set values for personalized content

1 In the primary menu, choose Create Block.

2 Enter the value of the personalized element to be linked to this block.

3 Click in the workspace after previously inserted Insert Block statement.

4 Click Insert Rule.

5 Place conditional content between $(DefineBlock "merge field") and $(EndBlock) statements.

About Applying Localization Rules to Treatments
Each treatment record contains a locale value. The locale is used to locate and display the localized 
landing page for response forms. When you create an email treatment record, the locale value 
defaults to the value set in your profile. You can change the value to match your business needs. 
When you launch the campaign, the locale assigned to the email treatment is used for all recipients.

The default character set for emails is UTF-8. This is the value set in the Charset attribute for the 
email's Content-Type header. To change the Charset attribute, select an Email Marketing Server 
profile with the correct Charset attribute or request a Administrator to make the changes necessary 
to the Email Marketing Server profile that you use.

NOTE: Internally, templates are maintained using the UTF-8 character set. Therefore, the character 
set represents characters for any written language.
Siebel Marketing User Guide Version 8.0 107



Creating and Using Offers and Treatments ■ About Fax Treatments
The character set for the template you upload must be the default character set configured for the 
operating system you are using (the current code page on Windows or UTF-8 on UNIX). On UNIX 
platforms, an environment variable (SIEBEL_FILE_ENCODING) can be assigned to a character set to 
use in place of UTF-8 when reading templates. If the original template file contains a BOM (Byte 
Order Mark), the character set of the template file can be detected. This detection is useful when the 
character set differs from the platform default character set.

CAUTION: Be careful when using a character set for outgoing email that differs from the platform 
default character set or UTF-8. If the Email Marketing Server character set is not compatible with the 
character set of the original template file that is read from disk, the resulting email text may be 
unreadable.

About Fax Treatments
Fax treatments are available in Siebel Marketing and Siebel Campaigns. Using the Fax Treatment 
view, a marketer can create personalized faxes for targeted distribution during a campaign.

The Fax Treatment view contains the following view tabs:

■ Treatment Details. This form contains additional fields that you can use to specify a predefined 
communications Delivery Profile for fax distribution, an Activity check box that may be used to 
track the treatment as an activity and approval check boxes and fields if the fax treatment 
requires approval from your company’s marketing and legal departments. The Treatment Details 
form also displays a unique identifier for the treatment in the Treatment Code field.

■ Edit Fax. Use this form to choose a treatment template and specify the personalization elements 
that are included in your fax design.

■ Delivery Profile. This read-only list displays parameters of the Siebel Communications profile 
chosen for the fax treatment. For more information on setting up a delivery profile for a fax 
treatment, see Siebel Communications Server Administration Guide. For more information on 
testing and distributing fax campaigns, see Testing Campaigns That Have Email and Fax 
Treatments on page 151.

■ Literature. This list shows the company and product information associated with the media 
treatment. You can add additional items to this list if desired. For more information, see 
Associating Literature with Treatments on page 119.

■ Related Events. Displays events related to fax treatments.

Process of Working with Fax Treatments
To set up fax treatments, perform the following topics:

■ Associating Templates with Fax Treatments on page 109

■ Creating Delivery Profiles and Associating with Fax Treatments on page 110

Related Topics
■ Creating, Modifying, and Associating Products with Offers on page 80
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■ Delivery Profiles for Fax Treatments on page 109

Associating Templates with Fax Treatments
A template may be associated with a fax treatment. To edit the template, see About Creating and 
Editing Treatment Templates on page 84.

To associate a treatment template with a fax treatment

1 Navigate to the Offers screen > Fax Treatments view.

2 In the Fax Treatments list, select the fax treatment, and click the Edit Fax view tab.

3 In the Edit Fax form, create a new record.

4 Click the Template Name select button.

5 In the Pick Treatment Template dialog box, select the predefined template for the fax treatment, 
and click OK.

Only treatment templates that you add to the Treatment Templates list are available for selection. 
For more information, see About Creating and Editing Treatment Templates on page 84.

6 Save the record.

The template contents appear on the right side of the view, and Edit Template and Verify & 
Preview buttons become available.

Delivery Profiles for Fax Treatments
Delivery Profiles are available in Siebel Marketing. They are required for fax treatments. Delivery 
Profiles are created using the Communication Administration screen’s Communications Drivers and 
Profiles view. Fax treatments are distributed using the fax communications driver provided with your 
fax application.

Siebel Communications Server does not interface directly with fax servers. Most popular fax servers 
provide email gateways that connect themselves to an email server such as Microsoft Exchange 
Server or an SMTP server. The host email server recognizes messages with specially formatted email 
addresses and directs those messages to the fax server.

Siebel Communications Server interfaces indirectly with this type of fax server through the host 
email server. Except for the email address format, it makes no difference to Siebel Communications 
Server whether it is sending an email or a fax. Before fax treatments can be sent out, you must select 
one of the defined profiles.

Default parameter values are set for each communications driver within the Communication 
Administration screen’s Communications Drivers and Profiles view. You can create customized 
communications profiles for each of these driver types that override the default values for that driver. 
For example, a profile might specify customized From and Reply-To email addresses.
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For more information about communications drivers and profiles, see Siebel Communications Server 
Administration Guide.

For more information about using delivery profiles, see Creating Delivery Profiles and Associating with 
Fax Treatments on page 110. 

Creating Delivery Profiles and Associating with Fax 
Treatments
Complete the steps in the following procedure to select a communications driver and create a profile 
that you can associate with fax treatments.

To create a delivery profile for fax treatments

1 Navigate to the Administration-Communications > Communications Drivers and Profiles view.

2 In the Communications Drivers list, select a driver, and click the Profiles view tab.

3 In the Profiles list, create a new record:

a In the Name field, enter a name for the new profile.

b In the Organization field, accept the default organization, or click the select button to select 
another organization.

c In the Responsibilities field, click the select button, and in the Responsibilities list, select the 
responsibility associated with profile access.

The Responsibilities field is used in conjunction with Siebel eMail Response. It does not apply 
to outbound email campaigns.

4 Save the profile, and click the Driver Parameters view tab.

5 Edit the parameters for the profile, and save the record.

To associate a delivery profile with a fax treatment

1 Navigate to the Offers screen > Fax Treatments view.

2 In the Treatment Details form, select the treatment record.

3 In the Delivery Profile field, select the delivery profile for the treatment.

Web Treatments
Web treatments are targeted HTML treatments that can be displayed on the Siebel Web Marketing 
microsite. Web treatments are available in Siebel Marketing and Siebel Web Marketing.
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Using the Web Treatments view tabs, you can specify a template containing content for the Web 
Treatment, edit the template and add personalization elements, identify links to related Web offers, 
surveys, related events and related URLs and attach relevant product information that can be 
downloaded by the Web site visitor. Table 17 shows the view tabs available in the Web Treatments 
view.

The following topics detail how to create a basic Web treatment:

■ Associating Templates with Web Treatments on page 112

■ Adding Attachments to Web Treatments Downloads List on page 112

Related Topic
Creating, Modifying, and Associating Products with Offers on page 80

Table 17. Web Treatments View Tabs

View Tab Name Description

Treatment Details This form contains additional fields that you can use if the Web Treatment 
requires approvals from your company’s marketing and legal departments. It 
also provides a unique identifier for the treatment in the Treatment Code 
field.

NOTE: If you select the Inbound Active Flag check box, the Web Treatment 
appears to eligible users in the Web Marketing home page. The Featured 
Treatments applet checks this flag before displaying a Web offer to an eligible 
contact or prospect.

Edit Web 
Treatment

Use this form to attach templates containing the content of the Web 
treatment. To be selected here, templates must first be added to the 
Treatment Templates list. For more information, see About Creating and 
Editing Treatment Templates on page 84.

■ Use the HTML editor to edit the template content as well as select 
personalization items and insert items into the template.

■ Click the Verify & Preview button to verify the template edits and display 
the finished Web treatment as it appears on the Web page.

Downloads Use this list to provide a list of literature related to the offer that is available 
for download by the Web site visitor.

Advanced Contains the Related Web Surveys, Related Events, and Related URLs link 
bars. Use these lists to specify Web surveys, related events, and related URLs 
that you can embed in your Web treatment, using the Edit Web Treatment 
personalization elements controls. For more information, see About 
Associating Web Offers, Web Surveys, Events, and URLs with Treatments on 
page 113.
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Associating Templates with Web Treatments
Complete the steps in the following procedure to associate a template with a Web treatment. To edit 
the treatment template, see About Creating and Editing Treatment Templates on page 84. Templates 
must first be added to the Treatment Templates list to be available for selection in the Edit Web 
Treatment view tab. For more information, see About Creating and Editing Treatment Templates on 
page 84.

To associate a treatment template with a web treatment

1 Navigate to the Offers screen > Web Treatments view.

2 In the Web Treatments list, select the treatment, and click the Edit Web Treatment view tab.

3 Create a new record.

4 Click the Template Name select button.

5 In the Pick Treatment Template dialog box, select the template, and click OK.

To be available for selection, templates must first be added to the Treatment Templates list. For 
more information, see Creating Treatment Templates and Adding to the Template List on page 85.

6 Save the record to associate the template with the treatment.

Adding Attachments to Web Treatments Downloads List
The Web Treatment Downloads list displays literature and other files that can be downloaded with 
the treatment. Literature items must be included in the literature list to be available for selection in 
this view.

The Downloads list shows files that can be included in the selected Web treatment for download. Any 
literature other than treatment templates can be included in a treatment as a download. 

The fields in this view are shown in Table 18.

Table 18. Fields in the Web Treatment Downloads View

Field Comment

Comments Populated from the literature table.

Description Populated from the literature table.

File Name Populated from the literature table.

File Type Populated with the file extension.

Modified Populated with the file modification date.

Name Click the Name select button to select a literature item.

Release Date Populated with the date that the literature item was released.

Size (In Bytes) Populated with the file size in kilobytes.
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Files added here are not yet available for downloading. In this view, you select a set of files to be 
able to include as downloads from your Web treatment. These files then appear in the Personalization 
Elements list of embeddable objects in the HTML Editor tool bar when you choose Downloads from 
the Personalization Items list.

You can select any file from that list and copy it into the template file and that file becomes available 
for downloading. These files are displayed in the Embedded Object list as [Download:Literature 
Item Name].

When the Siebel Marketing software encodes this tag, it uses the Literature Item Name as the 
hyperlink text. The marketer can override this default behavior by using the wildcard (*) functionality 
and manually defining the HREF link, as described in About Using Hyperlinks (HREF) in Treatment 
Templates on page 86.

To attach literature in the Downloads view

1 Navigate to the Offers screen > Web Treatments view.

2 In the Web Treatments list, select the treatment, and click the Downloads view tab.

3 In the Downloads list, select the literature to make available for downloading from the Web 
treatment:

a Click the menu button and create a new record.

b In the Downloads form, click the Name select button.

c In the Pick Literature Item list, select the item, and click OK.

About Associating Web Offers, Web 
Surveys, Events, and URLs with 
Treatments
Through Siebel Marketing and Siebel Web Marketing, you can associate Web offers, Web surveys, 
Events, and Related URLs with treatments. Table 19 shows which treatment elements can be used 
with each channel.

Table 19. Available Channels for Treatment Elements

Related Offer Element Available Channels

Downloads Web offers

Related Events All offer channels

Related URLS Email offers, Web offers

Related Web Offers Email offers, Web offers

Related Web Surveys Email offers, Web offers
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You can, however, relate the same Web offer to more than one email treatment. For example you 
may have a Web Offer and want to associate that Web offer with multiple email offers. In this case, 
each of these email offers has a link to that same Web offer.

Related Web Offers, Related Web Surveys, Related 
Events, and Related URLs links
In the Advanced tab link bar, use the Related Web Offers, Related Web Surveys, Related Events, and 
Related URLs links to add each offer element to the appropriate offer. After you add an element to 
the list, it is available as a personalization element in the appropriate Offer. For example, after you 
add a Web offer on the Related Web Offers link bar, you can navigate to an Edit view and select Web 
Offers in the Personalization Items tool bar. Your newly added Web offer appears in the list of 
elements.

When the Web site visitor clicks a Web survey link on the Offers or Information views, a survey wizard 
appears that steps the visitor through a series of questions about the product. You can use Web 
Surveys to capture customer feedback or qualify leads. Using the Web Survey designer, you can 
design a survey one time, reuse questions and answers across multiple surveys, and deploy the 
survey on the Web and in the Call Center. The hyperlink takes the customer to a predefined Web 
survey page.

NOTE: Web Surveys are created using Siebel SmartScript. For more information, see Siebel 
SmartScript Administration Guide.

The Related Web Surveys list contains a list of Web surveys related to this campaign that can be 
included in the Web Offer page as URL hyperlinks. To display the SmartScript Administration screen's 
Scripts list where you can select and modify the survey, click the survey name in the Related Web 
Surveys list.

The following list contains descriptions of how links to offer elements appear in an offer:

■ Web offer link. The following is an example of how a link to a Web offer appears in an offer. The 
hyperlink is the image (banner_midsize.gif). When you click the link, the Web offer (Introducing 
Diet Vanilla Cake) appears.

<a href="[*Web Offer: Introducing Diet Vanilla Cake]"><img src="banner_midsize.gif" 
border=0 width="149" height="43"></a>

■ Event link. The following is an example of how a link to an Event appears in an offer. The 
hyperlink is Click Here. When you click the words Click Here, the specific Event appears.

<a href="[*Web Offer: Introducing Diet Vanilla Cake]">Click here</a>

■ Web survey link. The following is an example of how a link to a Survey appears in an offer. The 
hyperlink is the image (customer_survey.gif). When you click the image, the specific survey 
appears.

<a href="[*Web Survey: Diet Vanilla Cake Survey]"><img src="images/
customer_survey.gif" border=0 width="156" height="23"></a>
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■ Related URLs link. The following is an example of how a link to a related URL appears in an 
offer. The hyperlink is Click Here. When you click the words Click Here, the specific URL appears, 
showing any specified data elements.

<a href="[*Related URL: DVC URL]">Click here</a>

■ Products link. The following is an example of how a link to a Product URL appears in an offer. 
The hyperlink is the image (order_now.gif). When you click the image, the specific product page 
appears.

<a href="[*Product: Diet Vanilla Cake]"><img src="images/order_now.gif" border=0 
width="81" height="23"></a>

Associating Web Offers, Web Surveys, Events, and URLs 
with Offers
Use the following procedure to associate Web offers, Web surveys, Events, and Related URLs with 
offers.

To associate Web offers, Web surveys, Events, and Related URLs with offers

1 Navigate to the Offers screen.

2 In the link bar, choose the treatment type to associate with an offer element.

3 In the selected offers list, click the offer name.

4 Click the Advanced view tab for the Web offer or offer element to associate with the selected 
offer.

5 In the selected list, create a new record.

NOTE: Related URLs must start with http:// or the Web server address is inserted. If you have 
more than one URL, separate each one with a semicolon (;) and no spaces.

6 In the add dialog box, select the Web offer or offer element, and click OK.

Creating Other Treatment Types
You can create other treatment types, such as direct mail, media treatments and phone, depending 
on the application you use:

■ Contact Call Treatments on page 116

■ Direct Mail Treatments on page 117

■ Media Treatments on page 117

■ Phone Treatments and Direct Sales Treatments on page 118

■ Associating Literature with Treatments on page 119
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Contact Call Treatments
Contact call treatments are available in Siebel Pharma Marketing and Siebel Pharma Campaigns only. 
Contact call treatments are executed through the Siebel Pharma sales application. Use the Contact 
Call treatment view to define specific product messages to be delivered as part of pharma call 
detailing. The contact call treatment view consists of the following view tabs:

■ More Info. This form contains fields that you use if the contact call treatment requires approvals 
from your marketing and legal departments. It also provides a unique identifier for the treatment 
in the treatment code field.

■ Response Templates. Use this list to create potential responses to the product message created 
as part of the contact call treatment. For instructions on how to create response templates, see 
Associating a Response Template to a Contact Call Treatment on page 116.

For more information on executing contact call treatments, see the topic on Recording Marketing 
Responses in Contact Calls in Siebel Life Sciences Guide.

To create a Contact Call treatment

1 Navigate to the Offers screen > Contact Calls Treatments view.

2 In the Treatments list, create a new treatment.

3 From the Channel drop-down list, choose Contact Call.

4 In the Treatments list, complete the remaining fields.

For more information about creating treatments, see Creating, Modifying, and Associating Products 
with Offers on page 80.

5 Click the Contact Call treatment name.

6 In the More Info tab, complete the fields.

Associating a Response Template to a Contact Call Treatment
Response templates associated with a contact call treatment determines the choice of responses that 
can be recorded as part of call reporting in Siebel Pharma.

To associate a response template to a contact call treatment

1 Navigate to Treatments screen > Contact Call Treatments view.

2 Click the treatment name.

3 In the Response Template list, create a new record.
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Direct Mail Treatments
Direct mail treatments are available in the Siebel Marketing application. For instructions about how 
to create a direct mail treatment, see Creating, Modifying, and Associating Products with Offers on 
page 80. 

Using the Direct Mail Treatment view, you can associate Literature documents with a Treatment. 
Siebel Marketing does not provide a mechanism to print direct mail treatments but can pass output 
lists to vendors for execution.

You can generate output or distribution list of contacts during the campaign launch. The customer 
information is arranged according to a predefined list format, and the list can be delivered to the 
appropriate vendors through a predefined method (for example, FTP or email). For more information 
about list output and vendors, see About Previewing and Generating Lists on page 167.

The Direct Mail Treatment contains the following view tabs:

■ Treatment Details. This form contains additional fields that you can use if the Direct Mail 
Treatment requires approvals from your company’s marketing and legal departments. It also 
provides a unique identifier for the treatment in the Treatment Code field.

■ Literature. This list shows the company and product information associated with the treatment. 
To add literature to the list, see Associating Literature with Treatments on page 119.

■ Related Events. Displays events related to direct mail treatments.

Media Treatments
Media treatments are available in Siebel Marketing and Siebel Campaigns. For more information on 
how to create a media treatment, see Creating, Modifying, and Associating Products with Offers. 

Use the Media Treatments view to define indirect treatments. Types of media treatments available in 
the standard product are Billboard, Print Ad, Press Release, Radio, TV, Seminar, and Trade Show. 
When you define indirect treatments, you know the general characteristics of your audience but not 
its exact composition.

The Media Treatments view contains the Treatment Details, Literature and Related Events view tabs.

■ Treatment Details. This form contains additional fields that you can use if the media treatment 
requires approvals from your company’s marketing and legal departments. It also provides a 
unique identifier for the treatment in the Treatment Code field. You can specify the type of media 
to use to distribute the treatment using the Type field.

■ Literature. This shows the company and product information associated with the media 
treatment. You can add additional items to this list if desired. For example, if the media treatment 
type is press release, you can associate the press release content with the treatment for later 
referral. For more information, see Associating Literature with Treatments on page 119.

■ Related Events. This indicates if the media treatment is being used to promote a specific event 
or set of events.
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Phone Treatments and Direct Sales Treatments
Phone treatments and Direct Sales Treatments are available in Siebel Marketing and Siebel 
Campaigns.

Use the Phone Treatments view or Direct Sales Treatments view to define telemarketing treatments 
to be executed using Siebel Call Center or another application. Table 20 shows the view tabs in the 
Phone Treatments view.

Creating Call Guides for Phone Treatments
A call guide is a read-only note field visible to call center agents as they launch campaigns. The 
information in the Call Guide field is useful to agents as they prepare for inbound and outbound 
telephone calls and when they talk to clients. You create the call guide in the Treatments screen.

The Call Guide field is intended to display more detailed information about the campaign, answer 
common questions, and provide treatment options. The following example shows what a Call Guide 
field may contain:

Call Guide Example 
Through the end of December, we are offering a special bonus to our current customers 

upgrading a Basic service agreement to Premium. For $149, we upgrade your service package 

as well as provide a coupon book worth $1,000 toward the purchase of our Signature brand 

of products.

Table 20. Phone Treatments View Tabs

View Tab Name Description

Treatment Details This form contains more fields that you can use if 
the phone treatment requires approvals from your 
company’s marketing and legal departments. It 
also provides a unique identifier for the treatment 
in the Treatment Code field.

Literature This list shows the company and product 
information associated with the phone treatment. 
You can add additional items to this list if desired. 
For more information, see Associating Literature 
with Treatments on page 119.

Related Events Displays events relating to phone treatments.

Advanced This form associates a Treatment Group with the 
phone treatment.

This tab is not available in the Direct Sales 
Treatments view.
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If the customer agrees, the call center agent can click the Script button, and start the call script.

NOTE: A call script is written using Siebel SmartScript. You associate a script with a campaign. For 
more information, see Using SmartScripts with Campaigns on page 134. For more information about 
creating SmartScripts, see Siebel SmartScript Administration Guide.

To create a call guide

1 Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign.

3 Click the campaign name.

4 Click the Design view tab.

5 In the Call Guide text field, enter the information to use for the treatment.

Associating Literature with Treatments
Literature about the products or services offered during a campaign can be associated with a 
treatment using the Literature view tab in the Direct Mail, Media, Phone, and Fax Treatment views. 
To add attachments to email treatments, see Editing Treatments on page 92.

You can associate literature items, such as white papers, presentations, brochures, advertising 
material, and product specifications with your treatment to create a specialized library of 
information. You can use this library when reviewing details of treatments that are being reused in 
current campaigns.

In addition, a call center agent can view the literature while launching the campaign. The agent can 
also include literature items with faxes, email messages, or correspondence sent to a contact. 
Literature items are then included when you create a new correspondence record for a contact.

Before you can select literature to associate with a treatment, you must add the literature items to 
the Literature screen’s All Literature Across Organizations list. For more information about adding 
literature that you can associate with your treatments, see the Siebel Applications Administration 
Guide.

Use the following procedure to associate specific literature items with your treatments.

To associate a literature item with a treatment

1 Navigate to the Offers screen.

2 From the Treatments link bar, select the appropriate treatment type.

3 Click the treatment name.

4 In the Literature list, create a new record.

5 In the Literature form, click the Name select button.

6 In the Pick Literature Item dialog box, select the literature, and click OK.
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7 Planning and Designing 
Marketing Campaigns
This chapter describes how to plan and design marketing campaigns that meet your business needs. 
It includes the following topics:

■ About Siebel Campaigns on page 121

■ Process of Planning and Designing Marketing Campaigns on page 122

■ Process of Setting Up Campaigns on page 127

■ Process of Setting Up Teams and Groups on page 136

■ Process of Setting Up Campaign Execution Options on page 138

■ Process of Setting Up Campaign Quotas on page 143

■ Process of Setting Up Campaign Assignment Skills on page 147

■ Using Siebel Marketing with Siebel Events Management on page 149

■ Testing Campaigns on page 150

■ About Using Response Management on page 151

■ Reviewing and Adding Campaign Elements in Campaign Explorer on page 160

■ Process of Loading Customers in Campaigns on page 161

About Siebel Campaigns
The Siebel Campaigns module is available to users with a license for Siebel Marketing or Siebel 
Campaigns.

A campaign is the initiative in which you convey a marketing message to one or more groups of 
people. Typically, campaigns deliver a promotional offer to retain current customers or to acquire 
new customers across channels of communication. For example, you may launch a phone campaign 
that invites contacts to sign up for a special promotion or deliver a direct mail campaign that provides 
a sample of a new product and a coupon offer to existing customers.

The goal of a marketing campaign is to create an opportunity that ultimately results in a sale, brand 
recognition, or some other type of response. Marketers use both direct and indirect campaigns to 
achieve these objectives.

■ Direct campaigns target individuals using multichannel approaches such as email and telephone. 
Contacts for the campaign are derived by applying segmentation criteria against a database of 
customer information and generating a list or by purchasing or renting a list of prospects. 
Multiple campaigns can use the same segment criteria.
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■ Indirect campaigns target indeterminate groups of people whose general characteristics you may 
know, but whose exact composition you do not know. Examples of indirect campaigns are those 
that use television, radio, print ads, or other forms of media for delivery of the message. An 
indirect campaign is associated with a marketing program’s stage rather than with a specific 
segment or list.

The Siebel Campaigns module is used by Siebel applications such as Call Center and Sales. The 
campaigns are the same as the campaigns that result from a campaign in the marketing application. 
Campaigns contain contacts and prospects, offers, activities, and other campaign execution 
elements.

Using Siebel Campaigns you can distribute your company’s offer using television, radio, billboards, 
direct mail, fax, email, the Web, and phone treatments.

The campaign creation process begins with an administrator, who creates the offers and associates 
the offers and treatments with a campaign, and allocates segments. The administrator then adds the 
literature, contacts and prospects, call summary, and call guide. The administrator also determines 
which script, if any, is associated with the campaign and who is on the campaign team. A campaign 
manager may associate quotas and incentive awards with the campaign to track progress and reward 
performance.

The administrator can monitor the status of campaigns using the Campaign Explorer view to display 
the Contacts, Activities, Offers, and Literature for each campaign, and by using Campaign and 
Response Charts.

Process of Planning and Designing 
Marketing Campaigns
Siebel Marketing’s program and campaign organizational tools manage activities, documentation, 
milestones, and schedules for your marketing campaigns including:

1 Creating Activity Templates on page 123

2 Associating Activity Plans with Programs and Campaigns on page 124

3 Associating Documents with Programs and Campaigns on page 126

4 Viewing Timelines on page 125

About Creating and Using Activity Plans
Siebel Marketing’s Activity Plans views associate predefined planning and milestone activities and 
tasks with a template (activity plan). Then, you can assign the templates to your marketing programs 
and campaigns. This assignment creates one or more activities that are associated with a campaign 
or a program.

NOTE: Activities are not created for contacts loaded into a campaign.
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Activity Plans may be designed to help you plan the marketing program or campaign, or launch it. 
Before you link an activity plan to your campaign, you need to create activity templates or customize 
existing templates to reflect your business process and needs. Use templates to define a generic set 
of activities that may be reused.

For example, a marketing department production manager may design an activity plan template 
called Direct Mail that contains regularly scheduled campaign activities such as meetings with 
creative or budgetary staff and start tasks. Using the Campaign Activity Plans view the manager can 
associate the activity plan template to the current campaign and then assign resources, define 
priorities and status and so on to each predefined task, adding comments where necessary.

The activity plan record is flagged to indicate how the activity plan is to be used. If the activity is 
designated as a planning task, none of its activities are copied to the campaign record when it is 
created. If the activity plan is designed for the execution of the program or campaign, select the 
Recurring check box, and the set of activities are recreated and associated with each occurrence.

If your marketing program or campaign has a mixture of planning and start activities, create two 
plans—one for planning and one for execution tasks—and assign them both to the program or 
campaign.

Creating Activity Templates
Use Activity Plan Templates to create and manage activities for programs and campaigns. You define 
templates using the Application Administration screen’s Activity Templates and Activity Template 
Details views.

A campaign’s activity plan template may include information on the type of activity, duration and 
status, a list of activities associated with the program or campaign (preparation, telephone calls, 
milestones, tasks), and so on.

To create an activity plan template

1 Navigate to the Administration - Data screen > Activity Templates view.

2 In the Activity Plan Templates list, create a new record.

3 In the Template form, complete the fields and save the record.

a Enter a name for the template.

b In the Type drop-down list, choose Program Container for a marketing program template, and 
Campaign as an activity template for campaigns.

c Enter a template description.

d In the Auto Trigger field, select the check box if the activity is associated with the occurrence 
level.

e Select the Public check box if the activity plan may be used by others not on your team.

To create activities for the template

1 Navigate to the Administration - Data screen > Activity Templates view.
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2 In the Activity Plan Templates list, select a template.

3 Click the Activity Template Details view tab.

4 In the Activity Template Details list, create a new record.

5 Complete the necessary fields for each activity assigned to the template.

6 From the Type drop-down list, choose an activity type.

NOTE: Repeat Step 2 through Step 6 to add activities to the template.

7 Save the activity.

Associating Activity Plans with Programs and 
Campaigns
Use the Campaigns or Programs screen’s Activity Plans view to associate a template containing 
predefined activities with a program or campaign. An Activity Plan Template’s type must be set to 
Program Container for marketing programs or Campaign for marketing campaigns to be available for 
selection.

The Activity Plans view has the following elements:

■ The Campaign or Program form, which provides details of the selected campaign or program.

■ The Templates list, which can contain one or many activity plan templates.

■ The Activities list, which displays activities associated with the selected template.

To associate an activity plan and activities with a campaign or program

1 Navigate to the Campaigns or Programs screen.

2 In the Campaigns or Programs list, click the campaign name or program name.

3 Click the Plan view tab.

4 In the Plan link bar, click Activity Plans.

5 In the Activity Plans list, create a new record.

In the new row, the Recurring field contains a check mark.

6 Complete the necessary fields:

a From the Template drop-down list, select a predefined template.

b Edit the existing description if desired, or enter a description of the plan.

c Select Suppress Calendar to populate the check box if you do not want these activities added to 
your calendar view.
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d Clear Recurring if the activity must be not be written to the campaign record for every occurrence 
of the campaign or program.

When you clear the Recurring check box, you indicate that this set of planning tasks is only 
performed one time across all occurrences. By default, each new activity plan is set to 
Recurring when you assign it to a campaign or activity.

A list of activities appears in the Activities list. Note that the dates are populated by using 
the Lead Time column relative to the time that the activity template was associated.

7 To change the times or dates of any of the activities, click the Schedule view tab for the campaign

8 In the Schedule link bar, click Activity List.

Viewing Timelines
Timelines are available for programs, campaigns, event plans, and events. Timelines provide 
calendar views of scheduled, active, and completed marketing tactics in a Gantt chart format. The 
chart is divided into weeks and months. Start field and End field values determine the placement of 
the timeline bars. Timelines help you determine that scheduling is appropriate and on track for 
planned marketing efforts. Timeline bars are color-coded to help you identify the status of programs 
and campaigns. You can place the cursor over a timeline bar to display more details. Table 21 shows 
the Timeline types that appear in the link bar of the Marketing Calendar screen

NOTE: If you cannot view color indicators, refer to Accessibility Guide for Siebel Business 
Applications for assistance.

To view timelines

1 Navigate to the Marketing Calendar screen.

Table 21. Marketing Calendar Timeline Types

Timeline Type Description

Tactics timeline Shows active, completed, and planned marketing tactics including 
campaigns, events, event plans, and programs. You can click the name of 
any tactic displayed in one of the timelines to be navigated to the details 
for that tactic. The path displays the appropriate screen (campaign, event, 
event plan, or program) according to the tactic type.

The Programs 
timeline

Shows active, completed, and planned programs. To display the child 
campaigns and related events, double-click on the folder icon next to a 
program in the chart.

The Campaigns 
timeline

Shows active, completed, and planned campaigns.

Events timeline Shows active, completed, and planned event plans and events.
Siebel Marketing User Guide Version 8.0 125



Planning and Designing Marketing Campaigns ■ Process of Planning and Designing 
Marketing Campaigns
2 In the Marketing Calendar link bar, click a timelines type.

The various timeline types and their corresponding color indicators are shown in the following 
table.

Associating Documents with Programs and Campaigns
Most marketing teams generate documents such as proposals, white papers, press releases, and 
artwork used in advertising. These documents can be attached to programs and campaigns for future 
reference.

To attach documents to programs and campaigns

1 Navigate to the Campaigns or Programs screen.

2 In the Programs or Campaigns list, click a program or campaign.

3 In the Plan link bar, click Documents.

4 Click the Attachments view tab.

5 To add a URL, in the Attachments list, perform the following steps:

a Click New URL.

b In the URL field, enter the URL, and click Add.

6 To attach a file, in the Attachments list, perform the following steps:

a Click New File.

b In the Choose File dialog box, select the file, and click Open.

7 In the Comments field, add information that identifies the file’s contents.

8 (Optional) If you want changes to the original file to be included in the attached file, select the 
Update File check box to set this preference.

To access the attached document
■ In the Documents list, click the Attachment Name to view document details.

Timeline Type Color Indicator

Active Green

Canceled Red

Completed Blue

Planned Yellow

Scheduled Orange
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Process of Setting Up Campaigns
You use campaigns in Siebel Marketing and Siebel Campaigns. Prior to launching a campaign, you 
need to perform some or all of the following tasks:

■ Marketing Segments and Segment Trees on page 41.

■ Process of Creating and Modifying Offers on page 80

■ Creating Campaigns on page 127.

■ Campaign Elements That Can Be Associated with Campaigns on page 130.

■ Associating Offers and Segments with Campaigns on page 131.

■ Using SmartScripts with Campaigns on page 134.

■ Process of Setting Up Teams and Groups on page 136.

■ Using Assignment Manager with Campaign Contacts on page 142.

■ Process of Setting Up Campaign Quotas on page 143.

■ Process of Setting Up Campaign Assignment Skills on page 147.

■ Associating Lists of Prospects or Contacts with Campaigns on page 162.

■ Adding Contacts and Prospects to Campaigns Individually on page 164.

■ Using Waves with Campaigns on page 166.

■ About Previewing and Generating Lists on page 167.

■ Determining Campaign Activities and Milestones. For more information, see the Siebel 
Applications Administration Guide.

■ Preparing Literature Items. For more information, see the Siebel Applications Administration 
Guide.

Creating Campaigns
Use this procedure to create a campaign in the Campaigns screen.

To create a new campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, add a new record.
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3 In the Campaigns form, complete the fields.

To display all fields in the Campaigns form, click the Show more button. The following table 
describes some of the fields.

Field Comments

Approval Status If the value is Revised, the campaign is still being revised.

Assigned Budget The amount of money approved to spend for the campaign.

Budget Request If the campaign has been submitted as part of a Budget Request, the 
Budget Request ID appears.

Campaign Code Populated by Siebel Marketing. You can enter a source code for the 
campaign, or use the default record ID for the code.

The source code for this campaign is available for use as part of the 
source code format for the program. The value must be unique.

Division The internal division responsible for the campaign.

DNIS The telephone number associated with the campaign. This number 
must be set up separately in Siebel CTI (Computer Telephony 
Integration). The DNIS field for a campaign is used in CTI to query for 
this campaign and drive a screen pop to this campaign. For more 
information, see Siebel Communications Server Administration Guide.

Enter only numerals in this field. Do not use hyphens, spaces, 
parentheses, periods, or any characters other than numbers.

Execution Period The predefined time period during which the campaign is active.

Language The language in which the call script and offer was created. If no 
language is specified, the selected SmartScript runs in the default 
language for the application. If the script does not have a translation 
for the language selected, you get an error when you try to run the 
script.

Lead Partner If a lead partner was assigned at the program level and the campaign 
associated with that program does not have a lead partner, the 
campaign inherits the lead partner from the program. The choice of 
Lead Partner is limited to the organizations associated with the 
campaign.

You can change the value, selecting from any of the partners associated 
with a campaign or campaign. This lead partner is copied to any 
campaigns created from this campaign and to responses or 
opportunities that result from this campaign.

Name The name of the campaign.

You can have two campaigns with the same name but the campaign 
code for each campaign must be unique.
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Organization The predefined organization that is responsible for the campaign. You 
can choose more than one organization.

You can also associate Partner Organizations with the campaign. 
Partner organizations are created and administered through Partner 
Administration. For more information, see Siebel Partner Relationship 
Management Administration Guide.

Planned Start/
Planned End

The planned start date defaults to the date you created the campaign. 
The planned end date defaults to 30 days later.

These dates do not affect launching campaigns. A campaign launches 
even if the planned end date has passed.

Priority The priority level for the campaign. This value can be used to refine 
contact frequency rules in segmentation criteria. For example, to 
exclude customers that have been targeted by a Priority 1 campaign in 
the last 30 days.

Product Lines You can associate product lines to the campaign to help categorize the 
campaigns.

Products You can associate products to the campaign to help categorize the 
campaigns.

Program This field populates when the campaign is associated with a specific 
marketing program.

Purpose In the Plan view tab. The purpose of a campaign, for example: “To cross 
sell products to existing customers.”

Region Choose from the list the region in which the campaign is active.

SmartScript Select a call script, if needed, to guide the agent’s interaction with the 
customer. To appear in the list, scripts must be set up in advance using 
Siebel SmartScript. For instructions, see Siebel SmartScript 
Administration Guide.

The call script starts when an agent clicks the Script button in the 
Campaign Contacts or Prospects view.

You can use the Call Guide as an alternative to a SmartScript call script.

If more than one script is associated with a campaign, the script flagged 
as primary runs when the agent clicks the Script button.

Stage This field is populated with stage information when the campaign is 
associated with a specific program’s stage.

Field Comments
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4 Complete the necessary fields for the campaign record.

Campaign Elements That Can Be Associated with 
Campaigns
Table 22 contains descriptions of many elements in the Campaign view tabs that can be associated 
with a campaign.

Status By default, campaign status is Planned (start and end dates in the 
future). Status values may be changed at any time. During automatic 
program execution, the status changes to active when a campaign is 
loaded. At the conclusion of the program, the campaign’s status 
changes to completed. If the program is executed manually, the status 
does not automatically change.

To change the status, use the status drop-down list to choose Active 
(start date in the past and end date in future) or Completed (start and 
end date in the past).

Type Choose from the list the type of campaign you are creating. Options 
include Acquire, Retain, Win-Back, Cross-Sell, and Up-Sell.

Table 22. Campaign Elements That Can Be Associated with a Campaign

Plan and Design 
Element Location and Description

Activity List On the Schedule link bar. Team members can create and assign activities 
related to the campaign.

Activity Plans On the Plan link bar. Templates of activities can be associated with a 
campaign. For more information, see About Creating and Using Activity 
Plans on page 122.

Documents On the Plan link bar. Any team member can associate documents as 
attachments to the campaign.

Execution Options On the Design link bar. The campaign execution options specify the default 
values for these settings each time the campaign is loaded.

Expenses On the Plan link bar. Each campaign can have a forecast that predicts the 
financial performance of the plan. The actual results versus the forecast can 
be tracked for each campaign.

Lead Partner Field in the Campaign Details form view. Anytime a Campaign Plan is loaded, 
the Lead Partner is added to the associated campaign. The lead partner 
must be one of the organizations associated with the campaign.

Field Comments
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Associating Offers and Segments with Campaigns
Before you implement a marketing program, you can associate one or more offer treatments with 
the campaign, depending on your marketing strategy. The Offers list provides information about each 
offer, including the name and description, the offer type, and the source code assigned to this 
particular offer, and any associated product and price list.

When you load a campaign, Siebel Marketing creates a wave record, and copies the associated 
treatments to the wave history. Any views showing the treatments for each campaign have built-in 
visibility to prevent invalid treatments from appearing to end users. A valid treatment is a treatment 
with a current date that falls between its defined activation and expiration dates. If activation and 
expiration dates are not defined for the treatment, the treatment is valid by default. When you load 
and launch a campaign, Siebel Marketing copies the campaign treatments to the wave history.

NOTE: If you plan to change treatments during the campaign (after launching one or more waves), 
do not disassociate the previous treatment. Instead mark the previous treatment as expired (using 
the expiration date), and associate the new active treatment. This method continues to capture and 
report on responses from the previous version of the treatment.

To associate offers with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 Click the Design view tab.

4 In the Offers list, create a new record.

5 In the Add Offer dialog box, select a predefined offer, and click OK.

Offers On the Design link bar. Each time the campaign is loaded or launched the 
associated offers is copied to the campaign. For more information, see 
Associating Offers and Segments with Campaigns on page 131.

Organizations Field in the Campaign Details form view. These are the organizations that 
have visibility to the campaign under All Campaigns. When the campaign is 
loaded, each organization is included on the associated campaign.

Related Events On the Design link bar. After you launch a campaign that has an associated 
related event, campaign contacts are added to the campaign as invited 
attendees. For more information, see Associating Related Events with 
Campaigns on page 134.

Team Members Field in the Campaign Details form view. These are the employee positions 
that have visibility to the campaign under the My Campaigns option. When 
the campaign is loaded, each team member is included on the associated 
campaign.

Table 22. Campaign Elements That Can Be Associated with a Campaign

Plan and Design 
Element Location and Description
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6 In the Treatment list, click New.

7 Select one or more treatments for the offer(s) associated with the campaign, and click OK.

To associate a segment with a campaign

1 In the Marketing Module, create a segment.

2 In the Segment Designer, navigate to the Campaigns screen > Campaign List view.

3 Click the campaign Name.

4 Click the Design tab.

5 In the Design link bar, click Segments/Lists.

6 Click Add Segment to associate the segment.

If the segment has never been used in a campaign previously, click Choose a new segment, and 
select the segment from the folder location where you saved it.

7 To associate more segments, repeat Step 6.

To load a campaign with associated segments

1 After the desired segments are associated, click the menu on the upper campaign form, select 
the Design tab, then select the Segments/Lists view.

2 In the Allocation matrix, check one or more check boxes to allocate the segment or segments to 
your treatments.

3 From the Campaign Form menu, choose Load Campaign to associate the members of the 
segment with the campaign.

4 Pick a time and date for the load request, and then click OK.

NOTE: For more information, see Allocating Segments to Offer Treatments on page 133.

Table 23 describes how prospects and contacts can be used in segments associated with campaigns.

Table 23. Scenarios for Using Segments in Campaigns

Scenario Data Source
Integration 
Object Comments

Segment 
contains only 
contacts

Siebel OLAP or 
Siebel OLTP

Marketing 
Contact

Fully supported. Contacts exist in the Siebel 
transactional database, so data is inserted 
only into the S_CAMP_CON table.

Segment 
contains only 
contacts

Non-Siebel 
database

Marketing 
Contact

Fully supported. New contacts and accounts 
(if mapped) are created in the Siebel 
transactional database.

Segment 
contains only 
prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Prospects exist in the 
Siebel transactional database, so data is 
inserted only into S_CAMP_CON.
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Allocating Segments to Offer Treatments
A single campaign can be used to target multiple segments and distribute multiple offer treatments. 
You can allocate segments, segment trees and internal lists to offer treatments within a single 
campaign using the Campaign allocation matrix view.

To allocate segments to offer treatments

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click the campaign Name.

3 From the Campaign form, click the Design tab.

4 In the Design link bar, click Segments/Lists.

5 In the Segment/Lists list, choose a segment or a list.

If no segments appear in the list, click Add List or Add Segment to add a predefined segment or 
list.

6 Using the Allocation matrix, map each segment and list (on the left) to the treatments (columns). 
Check the box to indicate which segment or list receives each treatment. 

NOTE: If you select more than one treatment for the same segment or list, the contacts or 
prospects are inserted into the campaign history one time for each treatment (multiple entries). 

For example, if Segment A has a Net Count of 100, specify the Allocated number and click the 
Treatment check box to allocate those people to the segment.

Segment 
contains only 
prospects

Non-Siebel 
database

Marketing 
Prospect

Fully supported. New prospects are created 
in the Siebel transactional database.

Make sure that the Campaign Load List 
Format for the segment is configured to load 
data into the Marketing Prospect integration 
object.

Segment 
contains contacts 
and prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Contacts and prospects 
exist in the Siebel transactional database, 
so data is inserted only into S_CAMP_CON 
and S_DD_USER_KEY tables.

Segment 
contains contacts 
and prospects

Non-Siebel 
database

N/A Currently not supported.

Table 23. Scenarios for Using Segments in Campaigns

Scenario Data Source
Integration 
Object Comments
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Associating Related Events with Campaigns
Events can be associated with a campaign so that you can invite contacts and prospects to an event. 
For more information about related events, see Using Siebel Marketing with Siebel Events 
Management on page 149.

To associate events with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaign list, click the campaign name.

3 Click the Design view tab.

4 In the Offers link bar, click Related Events.

5 Create a new record, and click the Name select button.

6 In the Pick Event dialog box, select a predefined event, and click OK.

Using SmartScripts with Campaigns
A SmartScript is a script that the salesperson or call center agent uses to interact with the customer. 
It can be associated with any campaign.

If a SmartScript is associated with a business component and is run for a campaign, then that 
business component’s name must be the same as the value in the Enable Follow-up Actions field for 
the campaign. For example, if the Enable Follow-up Actions field is set to Create Responses, then the 
script’s business component must be Response. If the Enable Follow-up Actions field is set to Create 
Opportunities, then the script's business component must be Opportunity.

A script based on the Opportunity business component can be run only when the value in Enable 
Follow-up Actions is either Create Opportunities or All. A script based on the Response business 
component can be run only when the value in Enable Follow-up Actions is either Create Responses 
or All.

To set up a SmartScript

1 Navigate to the Campaign Management screen.

2 Select a campaign.

3 In the SmartScript field, click the select button.

The Smart Scripts dialog box appears.

4 Select the script from the list of available scripts, and click Add.

NOTE: To add the remaining scripts used in this campaign, repeat Step 3 and Step 4.

5 In the SmartScript dialog box, select the check box of the primary script, and click OK.
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Creating and Applying Campaign Templates
Using templates can save you time and effort. For example, many mailed campaigns use the same 
patterns of offers, such as an initial contact offer, a follow-up offer, and a thank-you or welcome offer. 
Email campaigns have a repeated patterns as well, starting with an initial offer, followed by 
confirmations for people opting in and opting out, followed by a welcome offer for new customers. 
By creating and using templates, you can save yourself time and effort and make your campaigns 
more consistent.

You can save any campaign as a reusable campaign template. The template retains many of the 
planning details from the campaign such as the goals, expenses, offers, documents, segments, lists, 
and activity plans. After you create a campaign template, you can reapply the template to any new 
campaigns. You can also share the template with other employees in your organization.

To save a campaign as a campaign template

1 Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign to use as a template.

3 In the Campaign form, click the menu button, and choose Save as Template.

This menu option is active only if your administrator has given you permission to use this action 
(using the Marketing access groups).

4 In the Save As Template dialog box, enter a name, and click OK.

To make changes to the new template

1 Navigate to the Marketing Templates screen > Campaign Templates view.

2 Query for the template you created in Step 4 of the previous procedure.

3 In the template list or form, make the necessary changes.

To apply a campaign template to a campaign

1 Navigate to the Campaigns screen.

2 In the Campaigns list, create a new campaign, or select a campaign to which to apply the 
template.

3 In the Campaign form, click the menu button, and choose Apply Template.

4 In the Apply Template dialog box, select a template to apply, and click OK.

5 When asked if you want to continue, click OK.

The Message dialog box, appears, confirming that the template was applied.

6 In the Message dialog box, click OK.
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Process of Setting Up Teams and Groups
Many organizations assign groups of agents to particular campaigns based on skill or territory.

The most direct way to provide access to the campaign is by assigning positions to a team. However, 
if you have a large call center where agents are organized by predefined groups of agents, you can 
set up assignments one time and then assign the group to each campaign. Setting up campaign 
groups lets you add the key positions to a campaign group, without having to remember individual 
employees.

Some call centers do not have predefined groups, or the groups change often. In this case you can 
assign positions directly to the campaign team. Every employee position in the team has access to 
the campaign. To work with campaign teams and groups, perform the following tasks:

■ Assigning Teams to Campaigns on page 136. (Used by Siebel Marketing and Siebel Campaigns)

■ Setting Up Campaign Groups on page 137. (Used by Siebel Campaigns)

■ Associating Groups with Campaigns on page 137. (Used by Siebel Campaigns)

Assigning Teams to Campaigns
Campaign teams are used by Siebel Marketing and Siebel Campaigns. Campaign teams are set up 
by assigning individual employees to a team that is associated with the campaign. Each employee 
position on the campaign team has access to the campaign in the Campaigns screen.

If you are working with partners in developing the campaign, you can also include a partner as a 
team member by adding that partner’s position. The partner may then view the campaign in the 
Partner Portal, in the Campaign Management screen.

To assign a team to a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 In the Team field, click the select button.

The creator of the campaign is assigned as the primary member of the Campaign Team. This 
position may be removed from the team only after you select a different member of the team to 
be the Primary.

4 In the Team Members dialog box, select employees from the Available list, and click Add.

To select multiple consecutive employees, hold down SHIFT as you select each name. To select 
multiple nonconsecutive employees, hold down CTRL as you select names.

5 Click the Primary field to select the primary team member, and click OK.

The default primary team member is the position that created the campaign.
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Setting Up Campaign Groups
Campaign groups are positions within your company, not individual employees. After you add a group 
to a campaign, anyone occupying a position listed in the group has access to the campaign. 
Campaign groups are used by Siebel Campaigns and can be associated with a campaign in Siebel 
Marketing.

To create a campaign group and add group members

1 Navigate to the Campaign Management screen.

2 In the Campaigns link bar, click Campaigns Groups.

3 In the Campaign Groups list, add a new record.

4 Enter a name and description for the group.

5 In the Campaign Groups list, select the group.

6 In the Positions list, add a new record.

7 In the Add Positions dialog box, select the positions for the group, and click OK.

Associating Groups with Campaigns
After you have created the campaign group, you can associate the group with your campaign. 
Campaign groups are used by Siebel Campaigns.

To add a group to a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns link bar, click Campaigns Groups.

3 In the Groups list, create a new record.

4 Enter a name and description for the group.

5 In the Campaigns link bar, click Campaigns List.

6 Select the campaign.

7 In the Group field, click the select view button.

8 In the Add Groups dialog box, select the group from the available list, and click Add.

9 Click OK.
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Process of Setting Up Campaign 
Execution Options
Campaign execution options are available in Siebel Marketing and Siebel Campaigns. Use the 
campaign execution options to specify campaign contact ownership and control the user’s ability to 
edit campaign contacts and prospects. You specify the ownership type and complete the default 
owners (organization and position). In addition, you can apply assignment rule groups (optional) that 
perform owner assignment.

Campaign contact ownership is a feature to control team members visibility into the campaign 
contacts. Team members accessing the Campaign Contacts view can display only those campaign 
contacts and prospects that they own.

You create these assignment rules in the Assignment Rules view in the Assignment Administration 
screen. For more information, see Siebel Assignment Manager Administration Guide. You select a 
rule group for a campaign in the Campaigns screen.

To establish execution options and apply Assignment Manager rules to campaign contacts, perform 
the following tasks:

■ Setting Up Execution Options for Campaigns on page 138

■ Using Assignment Manager with Campaign Contacts on page 142.

Setting Up Execution Options for Campaigns
You can select the default execution options for each campaign when you set up the campaign. After 
the campaign is loaded, you can modify the execution options for the associated campaign at any 
time.

To assign contact ownership, make sure that you select the appropriate Campaign Contact Ownership 
value, your default owners, the Contact editing flags, and an Assignment Manager rule group.

To set execution options for the campaign

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click a campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Execution Options or Execution Options - Advanced and complete the 
fields.

NOTE: Some fields exist only in the Execution Options - Advanced link.

Execution options fields are described in the following tables:

■ Assignment options (Table 24 on page 139)

■ Collaboration options (Table 25 on page 140)

■ Delivery options (Table 26 on page 141)
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Execution Options
■ Load Options (Table 27 on page 141)

Table 24 describes the actions executed by each Execution option field.

Table 24. Execution Options - Assignment Option Fields

Field Action

Assignment Rule 
Group

Required if you select Yes - Assignment Manager in the Campaign Member 
Ownership field. Use if you want Assignment Manager to assign the 
organization owner and position owner to contacts and prospects in the 
campaign. Select a rule group to apply to contacts in the campaign.

Campaign Member 
Ownership

Controls assignment of position owner and organization owner during the 
load process. Values are:

■ No. You do not want to assign ownership. When you select this option, 
the Organization Owner and Position Owner fields are left empty on the 
campaign contacts and prospect records.

■ Yes - Manually. When you select this option, the load process populates 
the Default Position Owner and Default Organization Owner to the 
Campaign History table (S_CAMP_CON) for the contacts and prospects 
in the load. After the load process, you can manually assign organization 
and position owners on the campaign contacts and prospect records.

■ Yes - Assignment Manager. You want Assignment Manager to assign 
ownership based on Assignment Manager rule groups. The load process 
invokes the Assignment Manager engine at the end of the process to 
assign the campaign members based on the rules in the selected 
Assignment Rule Group.

Default Organization 
Owner

(Optional) Default value that is populated into the Default Organization 
Owner field during the load process when assignment is enabled (Yes - 
Assignment Manager or Yes - Manually).

The list of organizations is restricted to the organizations associated with 
the campaign. After the value is populated, it may be updated if the 
assignment engine reassigns names. For more information, see Siebel 
Assignment Manager Administration Guide.

Default Position 
Owner

(Optional) Default value that is populated into the Default Position Owner 
fields during the load process when assignment is enabled (Yes - 
Assignment Manager or Yes - Manually).

The list of positions is restricted to the Default Organization Owner 
organizations associated with the campaign. After the value is populated, it 
may be updated if the assignment engine reassigns names. For more 
information, see Siebel Assignment Manager Administration Guide.

Lock Campaign 
Team Assignment

Campaign managers sometimes create assignment rules that assign 
additional positions to the campaign team. This lock flag excludes this 
campaign from the rules, so that new team members would not be assigned.
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Table 25 describes the collaboration options for each Execution option field. 

Table 25. Execution Options - Collaboration Options

Field Action

Enable Contact 
Editing

Default is on (True). Clear the check box to prevent anyone from changing 
the owner fields and adding and deleting contacts. This flag controls the 
ability to edit the following fields on the campaign contact or prospect 
record:

■ Contact Last Name

■ Done Flag

■ Organization Owner

■ Prospect Last Name

■ Position Owner

In addition, when this value is True, the New and Delete buttons are 
available.

NOTE: A contact can only be deleted by the Position Owner to whom it is 
assigned. The Delete button is unavailable to other users.

Enable Partner 
Editing of Contacts

Default is on (True). Clear the check box to prevent partners from editing 
the fields and using the buttons controlled by the Enable Contact Editing 
check box.

Enable Followup 
Actions

This value controls which buttons (Create Oppty, Create Order, Create 
Response, Script) are active in the Campaign agent views (Campaign 
Members). The following list describes the values:

■ Create Opportunities. The Create Response and Create Oppty buttons 
are active.

■ Create Orders. The Create Response and Create Order buttons are 
active.

■ Create Responses. The Create Responses button is active.

■ All. All buttons are active.

Enforce Approvals When this option is active, the campaign cannot be launched unless the 
Approval Status for the campaign and its associated offers is Approved. You 
receive an error if you try to launch a campaign and the conditions are not 
met.

Control Campaign This flag denotes that this campaign is meant to be used as a control group 
for a test and control program. Control campaigns are hidden from the 
outbound call center agent views (Campaign Members - Outbound), 
because control groups do not receive offer messages. Control Campaigns 
do appear in the Inbound version the Campaign Members view, because you 
want to be able to capture unsolicited responses.
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Table 26 describes the delivery options for each Execution option field.

Table 27 describes the load options for each Execution option field.

Table 26. Execution Options - Delivery Options

Field Action

Route Contacts This flag controls whether or not campaign contacts are routed to mobile 
clients. By default all routing rules for campaign contacts are disabled.

Use Pregenerated 
Files

When this option is checked, the launch option uses the most recent list 
export file for the wave being launched. This option is useful if you have a 
short time to deliver all of your email, and you want to regenerate the list 
file before you launch the campaign. 

To generate an email list file or a list export file for other channels, use the 
Campaign > Export > List Distribution view

Route Prospects This flag controls whether campaign prospects are routed to mobile clients. 
By default all routing rules for campaign prospects are disabled.

Table 27. Execution Options - Load Options

Field Action

Load Behavior Controls what happens to the previous wave or load when the user opts to 
load the campaign again. The following is a list of choices:

■ Overwrite Campaign History. Purges entire existing campaign history 
and creates a new load.

■ Create New Wave. Creates an additional load or wave for the latest load.

■ Add to Existing Wave. Finds the most recent good wave (not purged or 
suspended) and adds the campaign load members to the existing wave.

Allow Repeated 
Contacts with Load

Controls whether a specific contact or prospect ID can appear more than one 
time in the same load in the campaign for the same treatment.

The unique index in S_CAMP_CON (campaign members or contacts table) is 
based on Campaign ID, Load Number, Contact/Prospect ID, Token Number 
and Treatment ID. By default the application always populates a value of 1 
in the column, so that uniqueness is driven by the contact and campaign. 
However, if you turn off this option, the token number becomes a running 
number so there is no uniqueness enforced at the table level. This scenario 
is typical in certain industries such as Life Sciences where there is a many-
to-many relationship between contacts and accounts. For example, in the 
pharmaceutical industry, doctors are affiliated with multiple hospitals and 
the pharmaceutical companies send offers to all of their active addresses in 
the same campaign.
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Using Assignment Manager with Campaign Contacts
After setting execution options, you can load and launch the campaign. If you chose to automatically 
assign an owner and associate an assignment rule group with the campaign, Assignment Manager 
runs against the contacts in S_CAMP_CON at the end of the campaign loading process.

Before launching a campaign, you can add or delete campaign contacts and prospects or change the 
organization and position owners associated with a contact or prospect.

When this editing process is complete, you can run assignment manager against the campaign 
contacts and prospects to make sure ownership and visibility are correct. 

To run Assignment Manager

1 Click the Run Assignment Manager button in the Execution Options view tab.

2 Select a campaign.

Assignment Manager runs using the campaign history table (S_CAMP_CON) for that campaign’s 
contacts and prospects. For example, partners or employees may add new contacts to the 
campaign during the review process. Because these new leads may not have the correct owner, 
you can rerun Assignment Manager to assign these new records.

NOTE: You cannot run Assignment Manager until the campaign has successfully loaded.

To automatically assign owners to campaign contacts

1 Navigate to the Campaigns screen.

Source Code Format The source code format to be used to generate source codes for the 
campaign. If the format is also associated with the program level, the value 
is carried over when a campaign is created on the program flow.

Generate Source 
Codes during Load

Generates source codes for waves that have not been launched at the 
completion of the campaign load. If the option is disabled, you need to 
manually generate the source codes using the Generate Source Codes menu 
option in the campaign screen.

Capacity Limit per 
Load

If this value is set to a value greater than 0 (zero), the campaign load stops 
inserting campaign members as soon as the capacity is reached. For 
example, you could limit the campaign size to no more than 1000 people for 
each load.

Max Errors This setting controls when the campaign load (EAI) process aborts. The load 
process tabulates the number of rejected records that were not inserted due 
to errors (bad data and so on). After the Max Errors value is passed, the 
campaign load process aborts. When this value is 0 (zero), all inserts and 
updates for the batch are backed out.

Table 27. Execution Options - Load Options

Field Action
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2 Click the campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Execution Options.

5 Verify that the values in the following fields are correct:

■ Default Organization Owner

■ Default Position Owner

■ Assignment Rule Group

6 Load and Launch the campaign.

When the Campaign is loaded, Assignment Manager assigns owners to the campaign contacts.

7 To run Assignment Manager again, click the Run Assignment Manager button and select a 
campaign to load and launch.

8 Click Run Assignment Manager.

The Run Assignment Manager button is only available if you choose Yes - Assignment Manager 
in the Campaign Contact Ownership field.

9 In the Pick Campaign dialog box, select a campaign, and click OK.

Process of Setting Up Campaign Quotas
Quotas are used by Siebel Marketing and Siebel Campaigns and may be set up for a campaign as an 
incentive for agents to meet target goals. A quota is a goal, such as a monetary goal for generating 
a certain amount of revenue for a campaign, or it may be a nonmonetary goal such as making a 
certain number of calls within a time period.

To develop a quota plan with measurable objectives and rewards for success, use the following 
process and the quota view tabs to define details. To set up campaign quotas, perform the following 
tasks:

1 Creating Campaign Quota Plans on page 143

2 Defining Quotas for the Plan on page 144 

3 Assigning Awards to the Campaign Quota Objective on page 145

4 Assigning Campaign Quota Plan Participants on page 146

Creating Campaign Quota Plans
Use the following procedure to set up quota plan for your campaign. Then, using the procedures that 
follow, define the details of the quota plan.

To create a quota plan

1 Navigate to the Campaign Management screen.
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2 Click the campaign name.

3 Click the Design view tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, create a new record.

6 Complete the fields for the quota plan.

The following table describes some of the fields.

Defining Quotas for the Plan
After you define the quota plan, add quota objectives that participants must meet to receive 
incentives. Prior to adding new quotas, add the appropriate Quotas, Awards, and Plan Participants.

To add quota objectives to the quota plan

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, click the plan name.

The quota plan details appear in the Plan form, and quota objectives appear in the Quotas list.

6 In the Quotas list, create a new record.

7 In the Add Quota Objectives dialog box, select an objective, and click OK.

Repeat Step 6 and Step 7 to add additional quota objectives to the quota plan.

To edit quota objective values 

1 Navigate to the Campaign Management screen.

Field Comment

Active Flag Set to True when you create the quota.

Description Description of the quota plan.

End Populated when the Period field is completed. 

Internal Division Name The name of the internal division associated with this quota.

Period (Required) The time period for which the quota is active.

Plan Name (Required) Enter a relevant name for the Quota Plan.

Start Populated when the Period field is completed. 
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2 In the Campaign list, click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, click the plan name.

The quota plan details appear in the form, and quota objectives appear in the Quotas list.

6 Select the quota objective record and change values in the appropriate fields.

Information about some fields in the quota objective record is described in the following table.

The next time you select the quota record, your modifications appear.

Assigning Awards to the Campaign Quota Objective
Quota plan participants may receive awards for meeting campaign objective goals. A number of 
awards for different performance achievements may be set up using the Awards view tab list. These 
awards can then be assigned to quota objectives.

To assign predefined awards to a quota objective

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, select the campaign.

3 Click the campaign name.

4 Click the Design tab.

5 In the Design link bar, click Quotas.

6 In the Quotas list, click the plan name.

The quota plan details are displayed in the form, and quota objectives appear in the Quotas list.

7 Click the Award select button and, in the Pick Quota Incentive dialog box, select the award for 
meeting the quota.

After you click OK, the selection appears in the Award field.

Field Comment

Description Contains a detailed summary of the quota objective. You can edit this 
field.

Measure (Read only) Values are Revenue and Units. You typically add a Target 
Amount quota for a revenue measure and a Target Quantity quota for a 
units measure.

Quota Type (Read only) Values are Amount and Quantity.
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8 In the Target Quantity field, click the calculator button, and use the calculator to enter the 
number of units that represents the quota target.

To create new awards

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

5 In the Quotas list, click the plan name.

The quota plan details are displayed in the form, and quota objectives appear in the Quotas list.

6 In the Administration - Sales Quota link bar, click Awards.

7 In the Awards list, create a new record.

8 Complete the necessary fields for the award.

Some fields are described in the following table.

Assigning Campaign Quota Plan Participants
Assign eligible participants to your quota plan using the Participants view tab.

To add participants to the campaign quota plan

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Quotas.

Field Comment

Amount In the field, click the arrow, and use the calculator controls to enter the 
dollar amount for the award. If the type is cash, then this value is the 
amount of cash given with the award.

Award Date In the field, click the arrow, and use the calendar controls to specify the 
date the reward is given.

Description Enter a description of the award.

Name Enter a reference name for the award.

Type Select the award type from the drop-down list. Options are Dinner, 
Cash, Trip, and Other. Your administrator may change these values to 
reflect your company’s requirements.
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5 In the Quotas list, click the plan name.

Quota objectives appear in the Quotas list.

6 Click the Quota Plan Participants view tab.

7 In the Participants list, create a new record.

8 In the Participants list, create a new record, and complete the fields.

This field updates if you change the participant’s start or end date. You can also edit the Prorate 
field directly. For each plan participant, quotas are calculated by multiplying the prorate by the 
target amount or quantity.

For example:

Prorate=((Participant’s End Date – Participant’s Start Date) + 1) / ((Period End Date – Period 
Start Date) + 1)

Repeat this procedure to add other participants.

Process of Setting Up Campaign 
Assignment Skills
Campaign assignment skills are set up only in Siebel Campaigns. Setting up campaign assignment 
skills is a way to identify which employees have certain skills and define the attributes of each skill.

Assignment Manager uses assignment skill rules to assign telesales agents to a campaign. 
Assignment skills are categories, such as Product or Language. Campaign Skill Items are subsets of 
campaign skills. For example, a skill item for the product campaign skill may be 486 Laptop or 
Pentium Desktop. A skill item for the language campaign skill may be French or English.

When associating skills with a campaign, first define the assignment skill, and then assign properties 
to the skill using the Campaign Skill Item list. Fields in the Campaign Skill Item list vary according 
to the skill. Repeat these procedures to add as many skills as needed to the campaign.

To set up assignment skills for a campaign, perform the following tasks:

1 Associating Assignment Skills with Campaigns on page 147

2 (Optional) Defining Campaign Skill Items on page 148

3 (Optional) Deleting Assignment Skills and Campaign Skill Items on page 148

Associating Assignment Skills with Campaigns
Use the following procedure to define and associate assignment skills required for your campaign.

To associate multiple assignment skills with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.
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3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, create a new record.

6 Complete the fields, typing comments that describe the skill and how it is used in the campaign.

Defining Campaign Skill Items
Use the following procedure to define items for each campaign skill associated with your campaign.

To associate skill items with a skill

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select a skill.

6 Scroll down to the Campaign Skill Item list, and create a new record.

7 In the Campaign Skill Item list, complete the fields defining the properties for each skill item.

Deleting Assignment Skills and Campaign Skill Items
You can delete assignment skills and campaign skill items. When you delete an assignment skill, its 
campaign skill items are deleted.

To delete an assignment skill and its campaign skill items

1 Navigate to the Campaign Management screen.

2 Click the campaign name.

3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select the skill, and delete the record.

You have deleted the assignment skill and the campaign skill items that were associated with it.

To delete a campaign skill item

1 Navigate to the Campaign Management screen.

2 Click the campaign name.
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3 Click the Design tab.

4 In the Design link bar, click Assignment Skills.

5 In the Assignment Skills list, select the skill.

6 Scroll down to the Campaign Skill Item list, and select an item to delete from the assignment 
skill.

7 Delete the skill record.

Using Siebel Marketing with Siebel 
Events Management
Sales and marketing professionals can use the Siebel Events Management module to create, 
coordinate, and manage events across the enterprise, resulting in improved client interaction and 
expansion of the marketing message.

Siebel Events Manager is integrated with Siebel Marketing, so you can create complex, multistage 
event marketing programs. Marketing administrators can use the Program Flow view to associate 
events with marketing campaigns. Upon execution of the campaign, attendees are invited to the 
event and populated in the event attendee list. Siebel Marketing tracks responses when the 
attendees decide to accept the invitation and begin the registration process. As a result, event 
managers can track each attendee through the life of the event, from invitation, to confirmation, and 
to attendance.

Customers who have purchased the required license options for both Siebel Marketing and Siebel 
Events Management, can invite contacts or prospects to an event through an email marketing 
campaign. Sending this kind of invitation involves creating a target segment or list of invites, 
associating a related event to a campaign and email offer, and launching the campaign to send out 
email invitations with an embedded Event Web site URL. During execution, campaigns that have a 
related event automatically add the campaign contacts or prospects to the event as attendees, with 
a Registration Status of Invited.

Unlike contacts, prospects are not required to log in to the events Web site to register for an event. 
Therefore, this method for inviting prospects may be particularly useful in the case where third-party 
prospect lists are imported and not promoted to contacts. Invited prospects appear in the Events 
screen, Attendees subview.

Promoting an Event Using a Campaign
This task assumes that you have already created an Event and Offer. In most cases, you would invite 
contacts or prospects using an Email Offer. Siebel Marketing also supports other types of offers, such 
as Direct Mail, Fax, or SMS. However, the automatic embedding of the Siebel Events Web site URL 
only works with an Email Offer. 
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To promote an event using a campaign

1 Creating a campaign and adding a Related Event.

For more information, see Creating Campaigns on page 127 and Associating Related Events with 
Campaigns on page 134.

2 Launch the campaign.

For more information, see Launching Programs and Campaigns on page 171.

3 To display the invited contacts or prospects after the campaign launch, navigate to the Event 
screen > Attendees view.

Promoting an Event Using a Program
This task assumes that you have already created the events, campaigns and offers and that these 
entities are associated (such as associating an offer to a campaign and an event to a campaign). In 
most cases, users invite contacts or prospects using an Email Offer. Siebel Marketing also supports 
other types of offers, such as Direct Mail, Fax, or SMS. However, the automatic embedding of the 
Siebel Events Web site URL only works with an Email Offer. 

To promote an event using a program

1 Create a program.

For more information, see Creating Programs on page 67.

2 Navigate to the Programs screen, and click the program name.

3 In the Program Flow workspace, select the campaign used to promote the event.

4 In the Objects palette, click and drag the event icon onto the program flow workspace.

5 Select the event from the Pick Event dialog box.

6 Launch or schedule the program as you normally would.

For more information, see Executing Programs on page 77.

7 After each campaign launch, display the invited contacts/prospects by navigating to the Event 
screen > Attendees view.

Testing Campaigns
You can test outbound email and fax campaigns in Siebel Marketing and Siebel Campaigns before 
actually sending them to target recipients. You can preview the offer delivery distribution and then 
launch the email campaign using the Send functionality.

When you use the test offer feature, a sample of the offer is sent to you. 

To test campaigns and offers, see the following topics:

■ Scenario for Testing Campaigns on page 151

■ Testing Campaigns That Have Email and Fax Treatments on page 151
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Scenario for Testing Campaigns
The marketing manager of a telecommunications company plans to roll out a campaign that targets 
mobile communications customers whose service agreements expire in the next quarter. The 
campaign features an email containing information on the latest offers. The business goal is to retain 
the accounts of those customers by offering incentives for signing a new service agreement.

The marketing manager uses Test Offer to view the content and format of the email before it is sent 
to targeted customers.

Testing Campaigns That Have Email and Fax Treatments
Test Treatment sends you samples of email or fax treatments associated with a particular campaign. 
Before testing email treatments, make sure you complete the following tasks:

■ Make sure the treatment is active. The date in the Activation Date field for the email 
treatment must have arrived, and the date in the Expiration Date field must be current or in the 
future for the Test Treatment command to be enabled.

■ Associate the treatment with a campaign. Associate the treatment with an active campaign. 
For more information, see Associating Offers and Segments with Campaigns on page 131.

To test email and fax campaign treatments

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 In the Campaign form, manually enter the required information for the values in the merge fields.

4 Click the Design view tab.

5 In the Design link bar, click Offers.

6 In the Treatments list, select an email treatment.

7 Click the menu button, and choose Test Treatment.

8 For email treatments, choose a merge field from the Merge Fields list.

9 For fax treatments, choose from the list of available team members in the Campaign Team dialog 
box.

10 Verify the email treatment has been sent to the specified email address.

About Using Response Management
Siebel Marketing and Siebel Campaigns use Response Management. Whenever prospects or contacts 
respond to an offer through any channel (by inbound email, the Web, a call center, or sales 
representative), their responses may be captured in detail using the Responses screen. Using 
Response views, you can determine which contacts to pursue as opportunities.
Siebel Marketing User Guide Version 8.0 151



Planning and Designing Marketing Campaigns ■ About Using Response Management
Campaign media can be different from response media. Recipients of an Internet campaign can 
respond through a call center, and recipients of a direct mail offer may respond by going to a Web 
offer URL. A Web site can capture response details, while phone calls or direct mail responses must 
be recorded manually.

NOTE: In Siebel Marketing, inbound email replies are not automatically captured as responses. You 
must configure your email response product to support inbound email processing. For Siebel Email 
Response set-up instructions, see Siebel Email Response Administration Guide.

There are several response types and each response type has several parameters that store details 
about a given response. You can modify an automatically captured response if you have permission. 
Responses are tracked for an offer and for a campaign.

To use Response Management, you may perform some or all the following optional tasks:

■ Adding Response Information to Prospect or Contact Records on page 152

■ Using Automatic Source Code and Treatment Code Lookups on page 153

■ Adding Products to Responses on page 154

■ Adding Orders to Responses on page 154

■ Adding Opportunities to Responses on page 155

■ Adding Attachments to Responses on page 155

■ Response Type Definitions on page 156

■ Promoting Responses to Opportunities on page 159

■ Creating Automatic Responses from Opportunities and Orders on page 160

Adding Response Information to Prospect or Contact 
Records
The All Responses list displays responses to selected campaigns and offers. Use this view to add 
response information to existing prospect or contact records, to promote a contact to an opportunity, 
to specify the response type and channel, and to score the response. Use an optional Details form 
to enter more information about the response.

To add response information to prospect or contact records

1 Navigate to the Responses screen.

2 In the Responses list, create a new record.
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3 In the Responses list or form, complete the fields, using the following table as a guide.

Using Automatic Source Code and Treatment Code 
Lookups
Behind each Responses view is an automatic business service that looks up and decodes information 
based on any source codes or treatment codes added in a response.

Fields Comment

Last Name Select the Last Name for a prospect or contact.

Some fields are populated based on this selection. These include:

■ The first name of the respondent.

■ The account associated with the respondent. If no account is 
associated, use the Account select button to choose one.

■ The account address (city, state, country, telephone number, and so 
on), that are associated with the respondent are automatically filled 
in the form.

Lead Partner Choose a partner organization to associate with the response. If a lead 
partner was assigned at the program level or campaign level, that 
partner appears in this field. If you do choose to change the Lead 
Partner value, the drop-down list shows only those partners associated 
with the campaign source.

Response Method (Optional) The method used to capture the response.

Campaign Name (Optional) Choose which campaign the customer is responding to. If the 
customer is not responding to a specific campaign, you can select only 
the treatment.

Treatment Name (Required) Only treatments associated with the selected campaign 
appear in the list.

Score Enter a numeric value that represents a score for the response.

Source Code In Siebel Marketing and Siebel Campaigns, source codes are assigned 
to each campaign contact according to the source code format 
associated with the program stage. If the source code is included in offer 
materials, then it can be accessed by the recipients in their responses.

Treatment Code Each treatment has an unique treatment code. If the treatment code is 
included in the offer materials, then it can be accessed by the recipients in 
their responses.
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Source Code Lookups
To perform a source code lookup, enter the campaign contact’s source code into the Source Code 
field on the response form and leave the field. You do not have to save the record to perform the 
lookup. As soon as you click or step off the field, the lookup service determines whether the 
campaign is recognized and whether the contact name can be uniquely determined. If the source 
code is recognized, the correct campaign name is defaulted. If the contact name can be uniquely 
determined within a campaign, the contact name is also defaulted. The source code value is stored 
in the campaign history table (S_CAMP_CON) for each contact record.

Treatment Code Lookups
To perform an treatment code lookup, enter the treatment code in the response form. When you save 
the record, if the lookup service recognizes the treatment code, it defaults the correct treatment 
name.

NOTE: If the source code or the treatment code is not recognized by the application or if the two 
codes conflict, neither values is saved and the response record is not committed to the database.

If your deployment does not require source code lookups, you can disable the Response Lookup 
business service using Siebel Tools.

Adding Products to Responses
This view tab displays a list of products associated with the response, for example, products for which 
a respondent requested information using a product link in an email or Web treatment.

To add products to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, click the description.

3 Click the Products view tab.

4 In the Products list, create a new record.

5 In the Add Products dialog box, select the product from the list, and click Add.

The list contains products that have been associated with the treatment.

Adding Orders to Responses
This view tab displays a list of the respondent’s product orders. An order record contains information 
on the order status, the order number, type, account associated with the order, the date, priority, 
and description of the order.

To add orders to a response

1 Navigate to the Responses screen > Responses view.
Siebel Marketing User Guide Version 8.0154 



Planning and Designing Marketing Campaigns ■ About Using Response Management
2 In the Responses list, click the description.

3 Click the Orders view tab.

4 In the Orders list, create a new record.

5 In the Add Orders dialog box, select the order from the list, and click Add.

Adding Opportunities to Responses
This view tab displays a list of opportunities associated with the response.

To add opportunities to a response

1 Navigate to the Responses screen > Responses view.

2 In the Responses list, click the description.

3 Click the Opportunities view tab.

4 In the Opportunities list, create a new record.

5 In the Add Opportunities dialog box, select the opportunity from the list, and click Add.

Adding Attachments to Responses
This view tab displays a list of documents and other items that are associated with the response 
record.

To add attachments to a response

1 Navigate to the Responses screen.

2 In the Responses list, click the description.

3 Click the Attachments view tab.

4 To add a URL, in the Attachments list, perform the following steps:

a Click New URL.

b In the URL field, enter the URL, and click Add.

5 To attach a file, in the Attachments list, perform the following steps:

a Click New File.

b In the Choose File dialog box, select the file, and click Open.
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Response Type Definitions
The information captured and stored in the Response Details view depends on the response type that 
you select in the Response Type field of the response record. For each response type value, Table 28 
identifies some of the field names in which information is captured and describes the captured 
information.

NOTE: A Response is not automatically created when you click a Related Events link in an email or 
Web treatment. Siebel Marketing and Siebel Campaigns do not provide responses for Clicked on 
Related Event.

.

Table 28. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description

Accepted 
Invitation

Summary Indicates user accepted invitation.

Attended Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect attended the event.

Cancelled Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect canceled.

Clicked on event 
URL

Description Contains Event Name. Indicated that the contact or 
prospect clicked on the URL in the invitation email.

Clicked on 
Product URL

Summary Name of the product. The list of product URLs the 
respondent clicked appears in the Responses screen, 
Products view.

Clicked on Web 
Treatment

Summary Name of the Web treatment that the treatment recipient 
clicked. 

Completed Web 
Survey

Summary Name of the Web survey that the treatment recipient 
clicked.

Confirm 
Subscribe to List

Summary Indicates that the user's request to subscribe has been 
processed. An email is sent to confirm this status.

Confirm 
Unsubscribe to 
List

Summary Indicates that the user's request to unsubscribe has been 
processed. An email is sent to confirm this status.

Confirmed Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect confirmed his or her attendance.

Declined 
Engagement

Description Indicates that the user declined participation in the topic.

Declined 
Invitation

Summary Indicates that the user declined the invitation.
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Downloaded Info/
File(s)

Downloaded File Name of the downloaded file.

Subject Subject of the file.

Summary Optional comment.

Forward to a 
Friend

Comment Allows user to include personal note to friend who is 
receiving the forwarded message.

Email Address Input area for Email address of friend who is receiving the 
message.

First Name Input area for First Name of the friend who is receiving the 
message

Last Name Input area for Last Name of the friend who is receiving the 
message.

Gave Referral Summary Indicates user provided a referral.

Invited Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect was invited.

No Interest Summary Indicates the user was not interested in topic.

No-Show Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect did not arrive at the event.

One Click Unsub Summary Indicates that the user's request to unsubscribe has been 
processed.

Pending Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect is currently in the process of 
registering.

Read Receipt Not applicable An optional response type that requires additional 
configuration to support automatic creation.

Marketers can embed an HTML tag in HTML emails that 
Siebel Marketing can use to count each time the email is 
opened (read). The read receipt tag contains an image 
request. When that image is requested it is interpreted as 
an opened email.

Rejected

Requested 
Unsubscribe 
Response

Subject Can store the subject line of an inbound email or be edited 
manually.

Summary Contents of the email. Applies only to campaign 
responses.

Time of Day 
(Subscribe by 
phone)

Indicates the respondent’s preference for a time if the 
respondent wishes to subscribe by telephone. Choices are 
Morning, Afternoon, and Evening.

Table 28. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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Requested call 
back

Phone # Respondent’s phone number.

Priority Priority level of the callback request. Choices are Urgent, 
High, Medium, and Low.

Summary Stores the comments for a Web-generated response or can 
be edited manually.

Time of day Indicates the respondent’s preference for the time of 
callback. Choices are Morning, Afternoon, and Evening.

Topic Can store the subject line of an inbound email or be edited 
manually. The list of products for which the respondent 
requested a callback appears in the Responses screen, 
Products list.

Requested 
Further 
Engagement

Description Indicates that the user has requested further discussion

Requested more 
info

Comments Stores the comments for a Web-generated response. 
Other comments may be entered manually.

Requested more 
info

Email Email address, if the delivery method is email.

Requested more 
info

Fax Fax number, if the delivery method is fax.

Requested more 
info

Phone Phone number, if the delivery method is phone.

Requested more 
info

Ship Method The preferred method of delivery—direct mail, email, fax, 
or phone—that the customer has specified be used for 
delivery of information.

Requested more 
info

Street Address, 
City, State, ZIP, 
Country

The address to which the information is mailed if the 
preferred delivery method is direct mail.

The list of products for which the respondent requested 
information appears in the Responses screen, Products 
list.

Requested more 
info

Topic Can store the subject line of an inbound email or be edited 
manually.

Requested 
Unsubscribe

Email, Fax, 
Phone, Direct Mail

The choices are subscribe and unsubscribe.

Respondent 
Interested

Description Indicates that the responder has shown interest in topic.

Table 28. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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Promoting Responses to Opportunities
If the customer is interested in the product offered by the campaign, you can promote the response 
to an opportunity. If the customer is an existing contact, the account is associated with the 
opportunity. If the customer is a prospect, the customer is promoted to a contact, and then 
associated with an account.

To promote a response to an opportunity

1 Navigate to the Responses screen.

Respondent 
Purchased

Not applicable This response is not created automatically. You must use 
Siebel Business Process Designer to capture responses of 
this type.

The orders for this purchase are displayed in the 
Responses screen’s Orders view.

Respondent 
unreachable

Summary Optional comment.

Response created 
opportunity

Summary The list of opportunities can be accessed by selecting the 
Responses Opportunities view.

Submitted Source 
Code

Subscribe to List Summary Indicates that the user's request to subscribe has been 
processed.

Unclassified 
Response

Not applicable The response does not fall into one of the main response 
type categories or is a campaign response that requires 
manual processing.

Subject Subject of the email. Applies only to campaign responses.

Summary Contents of the email. Applies only to campaign 
responses.

Unsubscribe to 
List

Summary Indicates that the user's request to unsubscribe has been 
processed.

Waitlisted Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect has been waitlisted due to 
exceeded capacity.

Walk-in Description Contains Attendee Status and Event Name. Indicates that 
the contact or prospect arrived at the event without 
registration.

Table 28. Response Type Field Values in the Response Details Form

Response Type Field Name Captured Information and Description
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2 In the Responses list, click the Description name.

3 In the Response form, click Create Opportunity button.

The Opportunity form appears, with the response information in the form, and the contact 
information in the Campaign Leads Contacts list.

Creating Automatic Responses from Opportunities and 
Orders
When you create an opportunity in the All Contacts/Prospects view using the Create Opty button, 
Siebel Marketing and Siebel Campaigns create a response record using the Create Auto Response 
business service.

For opportunities, the response is created for each contact added to an opportunity after a campaign 
is associated as an opportunity source. To create the response, associate a campaign with the 
opportunity using the Source field MVG (multivalue group) and then add a contact to the opportunity. 
All responses default to a type of Created Opportunity.

For orders, the response is created whenever a campaign is associated with a sales order. To create 
the response, you associate a campaign with the Sales Order using the Campaign field. All responses 
default to a Type of Respondent Purchased.

Associating an Opportunity with a Campaign
To associate an opportunity to a campaign, you use the Source field on the Opportunity form to select 
the campaign name. Each opportunity can be associated with multiple sources, if appropriate, but 
only one can be designated as the primary source.

When this association is made, the opportunity appears under the Campaign Track Results tab in the 
Opportunities view with the Sourced from Marketing flag checked.

Associating an Order with a Campaign
To associate an order with a campaign, you use the Campaign field on the order form to select the 
campaign name.

Reviewing and Adding Campaign 
Elements in Campaign Explorer
You can use the Campaign Explorer view in Siebel Marketing and Siebel Campaigns to review 
subcampaigns, contacts, activities, and offers for each campaign. The left pane of this view contains 
an explorer, and the right pane shows the details of the selected campaign.

You can use the detail list to add folder items. For example, to add an activity, you select the Activity 
folder in the left pane, and the Activities list appears on the right. Then, from the list, you add a new 
activity record.
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To review campaign elements

1 Navigate to the Campaign Management screen > Explorer view.

2 In the Campaign Explorer, expand the folders for each campaign to display subfolders of 
campaign elements.

3 Click a folder to display detail of the subcampaign, contacts, activities, and offers in the list on 
the right.

To add items to folders

1 Navigate to the Campaign Management screen > Explorer view.

2 In the Campaign Explorer, expand the campaign item to show its folders.

3 Click the folder.

4 In the details list, add a new record and complete the fields.

Process of Loading Customers in 
Campaigns
When you load a campaign, the campaign members are added to the campaign history by loading 
segments and lists (as well as any names added manually using the user interface). For more 
information about segments, see Marketing Segments and Segment Trees on page 41.

The following types of lists are used by Siebel Marketing and Siebel Campaigns:

■ External lists. You can import purchased or rented lists into your application using List 
Management. When you use List Management with Siebel Data Quality you can scrub lists for 
duplicates during the import process. For more information, see Process of Importing and 
Managing External Lists on page 187.

■ Internal lists. You can also use List Management to maintain lists created from records that 
already exist in your contacts or prospects databases. For more information, see Process of 
Creating and Managing Internal Lists and Subscription Lists on page 201.

■ D&B lists. D&B lists are generated from D&B libraries of companies based on criteria you define. 
The D&B module provides a library of incorporated businesses that you can market to. Using the 
D&B screen you can create a list of D&B contacts to use in your campaign. For more information, 
see the chapter about D&B in Siebel Applications Administration Guide. 

■ Reviewing and Adding Campaign Elements in Campaign Explorer. For more information 
on integrating List Management with D&B, see Integrating List Management with D&B on 
page 212.

NOTE: When a campaign has both segments and lists, the segments load before the lists.

To load customers in a campaign, you perform the following tasks:

1 Associating Lists of Prospects or Contacts with Campaigns on page 162

2 Adding Contacts and Prospects to Campaigns Individually on page 164
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3 Viewing Campaign Contacts and Prospects on page 164

4 Loading Campaigns on page 165

Associating Lists of Prospects or Contacts with 
Campaigns
This topic discusses associating an imported (or purchased) list and an internal list of prospects or 
contacts with a campaign.

When you associate a purchased list with a campaign, you import the list, and then associate the list 
with a campaign. Prospects are only visible in the Campaign Contacts list if you successfully import 
the purchased list before associating it with a campaign. If contacts or prospects are added to a list 
after you associate that list with a campaign, you need to suspend the wave that did not include the 
new customers and load the campaign again.

CAUTION: If you associate an empty list (a list prepared for import but not yet imported) with a 
campaign and then import the list, the prospects are not associated with the campaign and are not 
visible in the Campaign Prospects list.

After you associate a list with a campaign, the Contact/Prospect List does not immediately display 
data. You must load the campaign before the members are added to the campaign history. The list 
is populated after the Marketing Campaign Load workflow process runs, and you may need to refresh 
the browser view to display the newly associated names. For more information, see Siebel Marketing 
Installation and Administration Guide.

Use the following procedure to associate available imported or internal lists of contacts and prospects 
with your campaigns. Before you associate a list with a campaign, make sure that the Siebel Server, 
the Object Manager component, and Workflow Process Manager component are running.

NOTE: You can only associate active campaign lists with a campaign.

To associate a list of prospects or contacts with a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaign list, click the campaign name.

3 Select the Design view tab.

4 In the Design link bar, click Segments\Lists.

5 Click the Add List button.

6 In the Add Lists dialog box, select a list, and click OK.

NOTE: When you associate a campaign list with a campaign, contacts in that list are associated 
with the campaign. If you change the campaign list to be inactive or if you delete it, the contacts 
still appear in the Contacts/Prospects list for that campaign.
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Troubleshooting the Contact/Prospect List
The Contact/Prospect list may not show contacts or prospects that have been recently associated 
with the list. To resolve the problem, look for it in Table 29.

Table 29. Contact/Prospect List Troubleshooting

Symptom Diagnostic Steps and Cause Solution

The newly 
associated contacts 
or prospects do not 
appear in the 
Contact/Prospect 
List

Marketing Campaign load is not 
yet complete or the browser 
display has not yet been 
refreshed.

Wait for the Marketing Campaign Load 
workflow process to complete and then 
refresh the browser.

After waiting for the 
Marketing Campaign 
Load workflow 
process to complete 
and after refreshing 
the browser, the 
newly associated 
prospects or 
contacts do not 
appear in the 
Contact/Prospect 
List

None of the campaign waves 
have been launched.

Launch one or more waves, or launch the 
campaign.

None of the customers in the 
campaign meet the search 
specification for the view.

Modify the search specification. Consider 
the following possibilities:

■ Campaigns that are Launched or 
Completed

■ Campaign Wave that is launched

■ The campaign contact record that is 
assigned to the position of the user

■ The campaign contact records that is 
not Marked for Deletion

■ Control Campaign flag = N

■ Contact and Prospect Do Not Call 
Flag = N

The campaign contacts and 
prospects have been assigned to 
a different organization and/or 
position.

In the Campaign Management > Design 
> Execution Options view, check the 
values for Campaign Member Ownership, 
Default Organization Owner, and Default 
Position Owner.
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Adding Contacts and Prospects to Campaigns 
Individually
In addition to loading a campaign from segments, lists, or both, you can add individual contacts and 
prospects to a campaign. The ability to add or delete contacts and prospects can be controlled in the 
Execution Options view by using two flags (Enable Contact Editing and Enable Partner Editing of 
Contacts). If these flags are checked, the New and Delete buttons are available. The buttons are 
available in Siebel Campaigns in the Campaign Administration views, but not the other Campaign 
views. For more information, see Process of Setting Up Campaign Execution Options on page 138.

After you add a list of contacts and prospects to a campaign and then load the campaign, these 
contacts and prospects appear in the All Contacts/Prospects view and in the All Contacts/Prospects 
across Organizations view.

You can also add contacts and prospects one at a time. For more information, see Chapter 9, 
“Managing Lists.”

To add a contact or prospect to a campaign

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, click the campaign name.

3 Click the Execute view tab.

4 In the Execute link bar, click All Contacts/Prospects.

The list of available contacts or prospects appears, with information on the selected contact or 
prospect record displayed in the Contact or Prospect Details form.

5 To add a contact, click Pick Contacts.

6 To add a prospect, click Pick Prospects

7 In the Pick dialog box, perform one of the following actions:

a Select one or more existing records, and click OK.

b Click New to create a new contact or prospect, then enter the information, and click OK.

8 In the Contacts and Prospects Detail form, complete the fields.

Viewing Campaign Contacts and Prospects
If you have access to the campaign, you can view the assigned contacts and prospects using one of 
the following procedures.

To view marketing contacts and prospects

1 Navigate to the Campaigns screen > Campaigns List view.

2 In the Campaigns list, click the campaign name.
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3 In the Execute link bar, click All Contacts/Prospects.

The Contacts/Prospects list appears, showing only the assigned contacts and prospects for that 
campaign.

Loading Campaigns
After you associate your lists, segments, and segment tree cells with your campaign, you can load 
the campaign. Campaigns can be loaded from the Campaign form in any of the Campaign 
Management views or from the Campaigns list.

To load a campaign from the Campaigns screen

1 Navigate to the Campaigns screen.

2 From the Campaigns list, click the campaign name.

NOTE: Make sure you have allocated your segments, lists or segment tree nodes to treatments 
before you load the campaign.

3 In the Campaign or Campaign Details form, click the menu button, and choose Load Campaign.

NOTE: The Load Campaign option is active only if your administrator has given you this privilege 
using the Marketing access groups.

4 In the Load Campaign dialog box, assign the date and time for the load to start, and then click 
OK.

5 Click the Execute view tab to review the load status.

6 In the Execute link bar, perform the following steps:

a To display the history of each wave that has been loaded, click Execution Status.

b To display details of the load process, click System Tasks.

7 Click Refresh to update the load status.

About Reviewing Contacts and Prospects in Active 
Campaigns
Sales people and contact center employees can use the Campaign Members dashboard to review the 
contacts and prospects in active campaigns. The Campaign Member views display a queue of active 
campaign contacts/prospects and a campaign summary, contact and prospect summary.
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Campaign Members screen displays the active campaign members according to several levels of 
visibility. Table 30 shows the levels of visibility available.

The Campaign agent views only display campaign members (contacts and prospects) that are in 
active campaigns and for which campaign waves have been launched to the contact center. Any 
waves that have not been launched by a member of the campaign team or administrator do not 
appear.

Using Waves with Campaigns
When you create a campaign, a default wave record is also created. The default record allocates 
100% of the contacts in wave A. If the campaign is part of a marketing program, you set up the 
waves in the Programs screen. For more information, see Setting Up Waves for Campaign Loads on 
page 73.

For stand-alone campaigns, you create waves in the Campaign screen. The delay between waves can 
be defined as hours or days.

To set up multiple waves for a stand-alone campaign

1 Navigate to the Campaigns screen.

2 Click a campaign.

3 Click the Design view tab.

4 In the link bar, click Wave Settings.

Table 30. Levels of Visibility in the Campaign Members Screen

Level of Visibility Description

My Campaign Members Displays campaign contacts/prospects that are specifically 
assigned to the employee's position.

All Campaign Members - Outbound Displays campaign contacts/prospects in active, launched 
campaign waves and the campaign members that are 
assigned to the employee's organization. This view does 
not display any members of control campaigns.

All Campaign Members - Inbound Displays campaign contacts/prospects in active, launched 
campaign waves and the campaign members that are 
assigned to the employee's organization. This view 
includes members of control campaigns.
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5 Add new wave records, and save the wave records.

Use the following table as a guide.

About Previewing and Generating Lists
You can create output lists of contacts for export to a fulfillment partner or another application. Direct 
mail vendors often require specific formatting of campaign lists. When a campaign is ready for 
launching, the target list may be exported according to a flexible list format and distributed using 
FTP or email. You can define, manage, and preview the list format without the intervention of an 
administrator. Default formats can be assigned for each vendor.

You can preview a sample of the list to determine if the output file layout is what you want and then 
generate the actual distribution list that is sent to vendors.

After a list has been generated, the records in it do not change even when the contacts and prospects 
who meet the segmentation criteria change. If you modify the members of the campaign, you must 
regenerate the list files using the latest data.

Lists can be generated manually using the List Distribution view in the Campaign screen or scheduled 
as part of a scheduled launch of a program stage or stand-alone campaign.

Field Comment

Wave Code Enter a wave code, up to 10 characters. You cannot save the record without 
a wave code. The wave code appears as part of the source code for the 
campaign member if you set up the source code format to include it. The wave 
code for the default wave is A.

Description Describe the characteristics of the wave.

Lag The default is 0. Enter the amount of time the wave is delayed after loading 
a campaign. The maximum lag for the waves cannot be greater than number 
of days between the start date and end date of the campaign.

The wave is launched when the server processes the Launch Campaign 
request.

This server process can be scheduled or can be manually started using the 
right-click menu in the Program Flow workspace.

Lag Unit Choose either Hours or Days.

% The default percentage is 100 for a single wave. If you are planning multiple 
waves, first reduce the percentage number in the first wave and enter the 
percentage of contacts that are included in the second wave. The total percent 
values cannot exceed 100%.
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Previewing Lists
Prior to launching a campaign, check that the list generation works properly. To do this, preview the 
list and inspect how the list data appears in the fields. The preview uses the first 500 rows of contact 
data, and these 500 contacts may or may not be in your final generated lists. They are used only to 
model how the list format looks with actual data.

To generate this preview file, your Export List Format must be built so that it exports data from same 
data source where the campaign load data is also extracted. Typically, this is the Siebel Data 
Warehouse or another data mart or data warehouse where the segment members are extracted 
during campaign load.

To generate a preview list

1 Verify that an export list format exists and meets list format requirements.

2 Navigate to the Campaigns screen, and in the Campaign list, click the campaign name.

3 Click the Execute view tab, and in the Execute link bar, click List Distribution.

4 Select either List Export or Email Personalization as the type of list format.

5 If you selected Email Personalization, select an Email offer in the Offer field.

6 If you select List Export, then create a new record in the Vendor list.

a Using the Vendor select button, select a vendor.

b Using the Export List Format select button, select one or more export list formats. Be sure to 
select an appropriate list format type for the type of channel (direct mail, email, and so on).

NOTE: Select the list format that you created in Step 1 from the folders.

7 Click Generate Output Lists to generate the preview file.

8 In the dialog box, select one or more waves, and then click OK.

a Give the server a few minutes to process the job, and then click the Refresh button in the 
Generated Lists applet. 

b (Optional) To monitor the job, click System Tasks in the Execute link bar.

When the file is created, it appears in the Generated Lists list. If the list format has splits set up in 
the formatting, multiple files appear in the list. Refer the Content Description column to view details 
about the file contents. Drill on the list name to open it, or save it to your computer.

Manually Generating Campaign Lists
The following procedure explains how to manually generate a list for a campaign.

To generate a list for a campaign

1 Navigate to the Campaigns screen, and in the Campaign list, click the campaign name.

2 Click the Execute view tab, and in the Execute link bar, click List Distribution.
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3 Click New to create a new list distribution entry.

4 Select a vendor.

If the vendor has a default list format, that format name appears in the Export List Format field.

5 Click the Export List Format select button.

6 In the Pick Export List Format dialog box, select your list format from the folders.

7 Click Generate Output Lists to generate the file.

8 Give the server a few seconds or minutes to process, and then click the Refresh button in the 
Generated Lists applet. 

If desired, use the System Tasks view under Execute tab to monitor the job.

When the file is created, it appears in the Generated Lists list. If the list format has splits set up 
in the formatting, multiple files appear in the list. See the Content Description column to view 
details about the file contents. You can click the list name to open it, or save it to your computer.
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8 Launching Programs and 
Campaigns
This chapter describes how to launch programs and campaigns, a process which sends output lists 
of contacts to a fulfillment partner or another application. It includes the following topics:

■ About Launching Programs and Campaigns on page 171

■ Process of Launching Campaigns on page 172

■ Process of Using the Schedule Calendar View on page 175

■ Displaying Campaign Charts in Siebel Campaigns on page 178

■ Process of Displaying Response Charts in Siebel Campaigns on page 183

About Launching Programs and 
Campaigns
When a campaign is ready for launch, the target list of contacts may be exported to a fulfillment 
partner or another application. Because direct mail vendors often require specific formatting of 
campaign lists, you can define, manage and preview the output list format without the intervention 
of an administrator.

When you launch a campaign, the Server Request Broker starts the Marketing Campaign Launch 
workflow process. This process sends contact list files to specified vendors, most commonly using 
FTP (file transfer protocol), and email offers are sent to targeted recipients.

You can launch a marketing program in the following ways:

■ Launch a campaign manually. You can launch a campaign using the campaign form menu in 
any of the campaign views or by right-clicking on the campaign object in the program flow. For 
more information about manual execution, see Launching Campaigns Manually on page 172.

■ Launch a program stage automatically. You can schedule a stage of a program to launch 
automatically (including all the campaigns in the stage) from the Program screen. In the 
Schedule view tab, click the Calendar link. For more information about automatic execution, see 
Process of Using the Schedule Calendar View on page 175.

■ Launch a campaign automatically. You can schedule a campaign to launch automatically from 
the Campaign screen. In the Schedule view tab, click the Calendar link. For more information, 
see Process of Using the Schedule Calendar View on page 175.

You launch email campaigns through the Siebel Email Marketing Server. Export list files and faxes 
are distributed through the Siebel Communication Server. Make sure that your Email Marketing 
Server and Communication Server are online so that the launch completes successfully.
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When you launch a campaign, you must know which campaign wave or waves you want to launch, 
especially if your campaign is a recurring campaign. In most cases, the wave you want is the most 
recent wave. However, when you launch the campaign, make sure that you select the correct wave 
from the Launch Waves dialog box.

NOTE: On the Marketing Server component, a parameter called Wave Batch Size determines the 
number of subwaves created. Each subwave creates a new request or thread to the email sending 
daemon.

For email campaigns, the Email marketing server can process parallel tasks for improved scalability. 
To enable the generation of email files for each thread, be sure to split the Email Server list format 
correctly.

Process of Launching Campaigns
You may choose to manually launch one or more waves of a campaign. You can launch a campaign 
using the applet menu on the campaign form in any of the campaign views or by right-clicking on 
the campaign in the program flow.

To launch a campaign, perform the following tasks:

■ Launching Campaigns Manually on page 172

■ Launching Email and Fax Campaigns on page 173

■ Checking Campaign Launch Status on page 174

■ Suspending and Relaunching Email Campaigns on page 174

Launching Campaigns Manually
Before launching a campaign manually, make sure you have performed the following tasks:

■ Add a position to the marketing Administrators Access Group. The position of the person who 
launches the campaign must be a member of the Marketing Administrators access group. If the 
position is not part of this access group, the launch buttons are unavailable. For instructions, see 
Siebel Marketing Installation and Administration Guide.

NOTE: This requirement also applies to a partner using the Siebel Partner Portal.

■ In the Campaign List Distribution view, set up vendors and export list formats.

■ Load any segments, segment tree cells, and lists that you plan to use into the campaign history.

■ If you plan to send offers that use a distribution profile, test the campaign to make sure that the 
profile is set up correctly and that offer is sent with expected results. For more information on 
testing campaigns, see Testing Campaigns on page 150.

You may choose to manually launch one or more waves of a campaign. You can launch a campaign 
using the applet menu on the campaign form in any of the campaign views or by right-clicking on 
the campaign in the program flow.
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After performing tasks in Launching Campaigns Manually on page 172 you are ready to launch the 
campaign. Launching a campaign calls the Marketing Campaign Launch workflow process. After 
launching a campaign, you can check the results by looking at history records for programs, stages, 
and campaigns.

To manually launch campaigns 

1 Navigate to the Campaigns screen, and in the Campaigns list, click the campaign name.

2 From the campaign form menu, choose Launch Campaign.

The Launch Campaign Dialog Box contains the valid waves that are available for launching. 
Waves with a status of Loading, Load Failed, Scheduled, Launched, Purged, or Purge Failed do 
not appear.

3 In the Launch Campaign dialog box, select one or more waves to launch, and click OK.

Launching Email and Fax Campaigns
If you have tested your email or fax campaign, and the results are satisfactory, you are ready to send 
the email offers to campaign recipients.

To send email and fax offers

1 Navigate to the Campaign Management screen.

2 In the Campaigns list, select the campaign.

3 Click the campaign name.

4 Click the Design view tab.

5 In the Campaigns form, click the menu button, and choose Launch Campaign.

6 In the Launch Waves dialog box, select a wave to launch, and click OK.

Understanding the Marketing Campaign Launch 
Workflow Process
When you launch a campaign, the Marketing Campaign Launch workflow process initiates. For more 
information about workflow processes, see Siebel Business Process Framework: Workflow Guide.

Siebel Marketing sends the exported list file to each vendor in the List Distribution list of the Waves 
view, using distribution adapters and profile information. For example:

■ Email. Siebel Marketing emails the exported list file to the vendor’s primary contact.

■ FTP. Each vendor has a profile specifying the host name, user name, and password. Siebel 
Marketing sends the exported list file using File Transfer Protocol to the vendor’s FTP server.
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For each wave, the server receives a request to send each valid offer in the campaign on the day the 
program is executed, adding to that date any lag days defined in the wave. Only those contacts or 
prospects assigned to a particular wave receive the offer.

Checking Campaign Launch Status
After you launch a campaign you can check its status and determine if it was successfully launched 
or if it failed.

To monitor campaign launch status

1 Navigate to the Campaigns screen, and in the Campaigns list, click the campaign name that you 
launched.

2 Click the Execute view tab.

3 In the Execute view link bar, click System Task.

4 In the System Tasks list, search for the Campaign Launch and Wave Launch jobs.

Use the Wave # field to find the wave that you launched.

5 In the System Tasks list, click Refresh to update the values in the record.

The Status field has three indicator boxes as shown in the following table.

6 To display the Task Log list, scroll down.

NOTE: If you cannot view color indicators, refer to Accessibility Guide for Siebel Business 
Applications for assistance.

If campaign launch fails, you can display an error log using the Administration - Server Management 
screen’s Tasks view.

Suspending and Relaunching Email Campaigns
A wave of a campaign can be suspended and relaunched in the event of an error or need to roll back 
a wave. For example, if email offers are not delivered because of a setup problem in the Email 
Marketing Server, you can relaunch the wave to resend the offers. Also, if you launch a wave into the 
call center, you can recall the wave so that it no longer appears to sales agents until the wave is 
relaunched.

Position Color Meaning

1 Red An error occurred. The error message appears in the System Tasks and 
Task Log lists.

2 Yellow Pending. The launch has not yet completed.

3 Green The launch completed successfully with no errors.
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To suspend a campaign wave

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click a campaign name.

3 Click the Execute view tab.

4 In the Execute link bar, click Execution Status.

5 Locate the Wave with a Launched or Launch Failed status.

Use the Wave # field to confirm that you are displaying the correct wave.

6 To suspend the wave, select the wave record and click Suspend Wave.

7 After the wave is suspended, Suspended appears in the Status field.

Make the necessary corrections, and then relaunch the campaign wave.

To relaunch a suspended campaign wave

1 Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign to relaunch.

3 Click the Execute view tab.

4 In the Execute link bar, click Execution Status.

5 Locate a wave to relaunch.

Use the Wave # field to confirm that you are displaying the correct wave.

6 In the Wave list, select the wave record, and click Launch Wave.

Launching a suspended wave resends any email offers and vendor list files. It also causes the 
campaign members in the wave to reappear in the call center.

To identify and resend failed emails

1 Navigate to Administration-Communications > Outbound Request Overview.

2 Using the Description and Request # fields, locate your email campaign.

3 If the Status does not indicate successful completion, check the Status Message field to 
determine the cause.

4 After you have resolved the cause, resend the failed emails by clicking Submit.

Process of Using the Schedule Calendar 
View
When you complete a program design using Program Flow, you can schedule a stage of the program 
for execution using the Schedule calendar view.

To use the schedule calendar view, perform the following tasks:
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■ Scheduling a Stage Execution on page 176

■ Scheduling the Execution of Campaigns on page 177

■ Understanding the Marketing Campaign Launch Workflow Process on page 173.

Schedule Calendar View
When you complete a program design using Program Flow, you can schedule a stage of the program 
for execution using the Schedule calendar view. During automatic program execution, the Campaign 
Load and Marketing Campaign Launch workflow processes run for each campaign in the stage. If the 
stage is recurring, when the run of the stage is completed, it reschedules itself for the next run. For 
more information about workflow processes, see Siebel Business Process Framework: Workflow 
Guide.

The Schedule view displays the details of the selected program in the Program form at the top and 
a calendar at the bottom.

Scheduling a Stage Execution
Use the following procedure to schedule stages of a program for automatic execution.

To schedule the execution of a stage

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 Click the Schedule view tab.

4 In the Calendar view, click the calendar icon for the date that the program starts.

5 In the activity form, complete the fields using the following table as a guide.

Field Comment

Comment Enter more information about the program schedule, if desired.

Description This field displays the previously added program description. Enter more 
information if desired.

Frequency If the program is repeating, choose the repeat cycle from the list. Options are 
Daily, Weekly, Monthly, Quarterly, and Yearly.

Planned 
Completion

The default value in this field is the program’s end date. Click the calendar 
select button, use the calendar controls to set the date and time.

Planned Start The default value in this field is the program start date. Click the calendar 
select button, and use calendar controls to set the start date and time for 
program execution.

Stage (Required) You must select the stage of the program that is to execute.
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6 Select the Active Flag so that the scheduling takes effect.

If you select the active flag, the stage executes as soon as the activity time arrives. If you do 
not select the active flag, no execution occurs.

7 Click Save This One when you are ready to save the schedule.

The stage name and launch time appear in the Schedule calendar. The calendar also reflects any 
recurrence of the stage.

To edit the schedule

1 Navigate to the Programs screen.

2 In the Programs list, click the program name.

3 Click the Schedule view tab.

4 In the Schedule’s calendar, click the program name.

Make sure the Active Flag is still checked so that execution occurs.

5 In the Schedule form, make changes, and click Save This One.

To delete a schedule

1 Navigate to the Programs screen.

2 In the Programs list, click the Schedule view tab.

3 In the Schedule’s calendar, click the program name to open the Schedule form.

4 Click the menu button, and choose Delete This One.

If the stage repeats over time, you are asked if you want to delete a single instance or every 
repeating instance.

Scheduling the Execution of Campaigns
Campaigns can be created and set up to execute according to a schedule.

CAUTION: Do not perform this procedure if you already plan to schedule the parent stage for the 
same campaign. Doing so causes the campaign to be launched twice.

Type (Required) The Type field displays Stage Execution as the default. If Stage 
Execution does not appear in the field, select it from the list.

Until If the stage repeats over time and you want to delete every repeating 
instance, choose Delete All.

Field Comment
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To schedule the execution of a campaign

1 Navigate to the Campaigns screen, and in the Campaign list, click the campaign name.

2 Select the Schedule view tab.

3 In the Schedule calendar, click the calendar icon in the day that the campaign starts.

4 In the activity form, in the Activity Type field, select Campaign Load and complete the remaining 
fields.

NOTE: Be sure to check the Active Flag for the scheduling to take effect. If the active flag is set, 
the campaign load launches as soon as the activity time arrives. If the active flag is not set, no 
execution occurs.

5 Click Save This One when you are ready to save the schedule.

The campaign name and load time appear in the Schedule calendar. The calendar also reflects 
any recurrence of the activity.

6 Click New to create another activity.

7 In the activity form, in the Activity Type field, select Campaign Launch, and complete the 
remaining fields.

Make sure to set the start time of the campaign launch activity so that the preceding campaign 
load activity completes before the corresponding campaign launch begins.

8 Verify that the Active Flag is set so that the scheduling takes effect.

9 Click Save This One when you are ready to save the schedule.

The campaign name and launch time appear in the Schedule calendar. The calendar also reflects 
any recurrence of the activity.

Displaying Campaign Charts in Siebel 
Campaigns
Only Siebel Campaigns uses Campaign charts, and you use these charts to review performance and 
graphically display results in a chart for areas such as incentive compensation, completed calls, lead 
quality by campaign, and so on. When you display a chart, the saved query in the upper-right corner 
filters the information shown in the chart.

To display charts in Siebel Campaigns, perform any of the following tasks:

■ Displaying Campaign Achievement Charts on page 179

■ Displaying Call Status Analysis Charts on page 179

■ Displaying Call Status Analysis by Employee Charts on page 180

■ Displaying Lead Quality Analysis by Campaign Charts or Response Charts on page 180

■ Displaying Opportunity Revenue Analyses on page 181

■ Displaying Order Revenue Analysis Charts on page 182

■ Displaying Campaign Trend Analyses on page 182
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Displaying Campaign Achievement Charts
The Campaign Achievement chart displays the results of the Sales Quota Plan set up for each 
campaign. The chart represents the percentage achievement of quota for each campaign and applies 
Incentive Compensation functionality to campaigns.

To prepare for generating the Campaign Achievement charts.

1 Create a quota plan, and associate quota plan objectives and participants with the plan.

Quotas are discussed in Creating Campaign Quota Plans on page 143. 

2 Enter achievement values by performing these tasks:

a Navigate to the Sales Quotas screen.

b In the Quota Achievement list, select the quota plan.

c Enter the amount you achieved compared to quota numbers.

You can add Achievements manually or by using a workflow process that completes 
achievements based on actions in Siebel Call Center.

You can display the Campaign Achievement Chart from the Achievement Analysis view of the Sales 
Quota screen or the Charts view of the Campaigns screen.

To display Campaign Achievements in Siebel Campaigns

1 Navigate to the Campaigns screen.

2 In the Campaigns link bar, select Charts.

3 In the drop-down list, select Campaign Achievements.

4 In the Objects Against Achievement list, select the plan name.

5 In the By drop-down list, select Campaign Name or Objective Name.

6 Select the chart type from the third drop-down list.

7 Click Go to display the chart.

Displaying Call Status Analysis Charts
The Call Status Analysis chart displays the number of calls that have been completed compared to 
the number of calls that have not been completed for each campaign. This chart can be used by a 
call center manager to determine which campaigns are lagging and where to shift resources.

To update the Call Status field

1 Assign any contacts and prospects you are contacting to the campaign.

For more information, see Adding Contacts and Prospects to Campaigns Individually on page 164.
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2 After each contact or prospect is called, update the status in the Call Status field in the Contacts 
or Prospects list or form.

The chart is based on information from this field. A Call Completed flag indicates that the call is 
completed and the number of contacts and prospects targeted by the campaign.

Displaying Call Status Analysis by Employee Charts
The Call Status Analysis by Employee chart displays completed and uncompleted calls by a specified 
employee for each campaign. The values for this chart may be derived from lists of contacts and 
prospects assigned to the position and the Calls Completed field for the contact or prospect record 
in the Contacts or Prospects view.

A campaign list can be associated with a position. When such association occurs, the position 
becomes the owner of the Campaign Contacts or Campaign Prospects. If the OwnerID is assigned, 
then only the employees of that position can display the Campaign Contacts or Prospects for a 
particular campaign. If the list is not assigned, then the OwnerID is NULL and any employee assigned 
to the Campaign Team or Campaign Group can display the Contacts or Prospects view.

To prepare for generating the Call Status Analysis by Employee chart

1 If the employee position is evaluated based on lists of contacts and prospects, assign the lists to 
the position in the Campaign Lists view.

The position becomes the owner of the list’s contacts and prospects.

When you associate a list with a campaign, if the Position field is not empty, then the OwnerID 
or each contact or prospect in that list is associated with that position.

Most companies do not assign the contacts or prospects to a position, so the OwnerID is NULL. 
In such cases, the chart shows only one employee: Unknown.

2 Update call status in the Campaign Contacts view.

The chart draws its values on which contacts have been called based on the Done flag in the Call 
Status field. Make sure this field reflects the current status of the call.

Displaying Lead Quality Analysis by Campaign Charts or 
Response Charts
The Lead Quality Analysis by Campaign chart displays the opportunities that have been created for 
the campaign when the Response Type is set to Opportunity. Using this chart, you can display 
opportunities by number of opportunities, by total opportunity revenue, or by average opportunity 
broken out by lead quality.
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To prepare for generating the Lead Quality Analysis by Campaign chart

1 In the Campaigns list, click the campaign name, click the Responses view tab, and verify that 
the Response Type field is set to Opportunity.

2 In the Opportunities screen, for each opportunity created for a campaign, make sure values are 
entered in the Lead Quality, Revenue, and Source fields.

You can use the My Opportunities or All Opportunities views to display the opportunities you need 
to check.

The Lead Quality by Response chart displays the opportunities that have been created for a campaign 
when the campaign’s Response Type is set to Response. The chart displays opportunities by number 
of opportunities, by total opportunity revenue, or by average opportunity broken out by lead quality.

To prepare for generating the Lead Quality by Response chart

1 In the Campaigns list, make sure the Response Type is set to Opportunity.

The Response Type field is in the Response’s view tab, after drilling down on the campaign name.

2 In the Opportunities screen, make sure that the Revenue, Lead Quality, and Source fields are 
completed for each opportunity.

Displaying Opportunity Revenue Analyses
You can display opportunity revenue analyses on two charts:

■ Opportunity Revenue Analysis Chart

■ Opportunity Revenue Analysis by Employee Chart

Opportunity Revenue Analysis Chart
The Opportunity Revenue Analysis chart displays the campaign’s Number of Opportunities and the 
Expected Revenue for those Opportunities. The left axis is Opportunity Revenue and the bar chart 
corresponds to Revenue. The right axis is the Number of Opportunities and the line chart corresponds 
to Revenue.

When using the chart, Opportunity Revenue Analysis by Campaign, only campaigns set to response 
type Response are used to create the chart.

This chart displays the relationship between the amount of revenue and the number of opportunities 
for campaigns. For example, a campaign administrator may use the chart to identify campaigns that 
are generating a high volume of opportunities but have a low potential for revenue and campaigns 
which generate a smaller number of opportunities but have a higher potential revenue for each 
opportunity.

Before generating the chart, navigate to the Opportunities screen and make sure that the Revenue 
field contains a value for each opportunity associated with the campaign.
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Displaying Opportunity Revenue Analysis by Employee Charts
The Opportunity Revenue Analysis by Employee chart shows the number of Opportunities and the 
potential revenue for opportunities for each employee. This chart displays information in the same 
way as the Opportunity Revenue Analysis chart, but it targets employees in the analysis.

To prepare for generating the Opportunity Revenue Analysis by Employee chart

1 Navigate to the Opportunities screen.

2 Select an opportunity associated with the campaign.

3 Make sure that the Revenue contains a value.

4 In the Sales Team field, enter the User ID of the agent generating the opportunity.

Displaying Order Revenue Analysis Charts
The Order Revenue Analysis Chart shows the total revenue for orders generated by campaign. Before 
you can create this chart, you must verify that an order is associated with a response. If it is not, 
you can associate it using the following procedure.

To associate an order to a response

1 Navigate to the Campaigns screen.

2 Select a Campaign with the Response Type set to Response.

NOTE: This chart only shows data for campaigns with Response Type set to Response.

The Response Type field is in the Response’s view tab, after drilling down on the campaign name.

3 Click the campaign name.

4 Click the My Contacts/Prospects view tab.

5 Click Create Response.

6 For this response, click the Orders tab, and create a new record.

7 Click the Order number to enter details for the order.

Displaying Campaign Trend Analyses
You can display campaign trend analyses using two charts:

■ Campaign Trend Analysis Chart

■ Campaign Trend Analysis by Employee Chart
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Displaying a Campaign Trend Analysis Chart
The Campaign Trend Analysis chart displays the total number of responses for each campaign over 
a period of time. The period can be set to day, week, month, quarter, or year.

Before generating the chart, review responses for each campaign by navigating to the Campaigns 
view, selecting the campaign, and clicking the Responses view tab.

Displaying a Trend Analysis by Employee Chart
The Campaign Trend Analysis by Employee chart displays the total number of responses generated 
by each employee across campaigns over a period of time. The period can be specified by day, week, 
month, quarter, or year. 

To verify that each response is associated with an employee

1 Navigate to the Campaigns screen.

2 In the Campaigns list, click the Name.

3 Click the Track Results view tab.

4 In the Track Result link bar, click Responses.

5 Review the list of responses, making a note of the description and user.

6 Navigate to the Responses screen.

7 For each response you found in Step 5, make sure that the Created By field contains the User ID 
of the employee who handled the response and, therefore, owns it.

Process of Displaying Response Charts 
in Siebel Campaigns
Siebel Marketing and Siebel Campaigns include response charts. Use response charts to analyze 
response to your campaigns in areas such as opportunities, revenue, campaign offers, and so on. 
When you display a chart, the saved query in the upper-right corner filters the information shown in 
the chart.

To display response charts in Siebel Campaigns, perform the following tasks:

■ Accessing the Response Charts on page 184

■ Displaying the Campaign Analysis (Response) Charts on page 184

■ Displaying the Opportunity Analysis (Response) Charts on page 184

■ Displaying the Offer Analysis (Response) Charts on page 185

■ Displaying the Offer Type Analyses (Response) Charts on page 185

■ Displaying the Revenue Analysis (Response) Charts on page 186

■ Displaying the Average Opportunity Revenue Analysis (Response) Charts on page 186
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Accessing the Response Charts
Response charts analyze the response to your campaigns in areas such as opportunities, revenue, 
campaign offers, and so on.

To access Response charts

1 Navigate to the Responses screen > Charts view.

2 In the Charts view use the visibility filter to select the type of data to display.

3 In the drop-down list below the Show field, select the type of chart, and click Go.

To change the type of chart, select a different type, and click Go.

Displaying the Campaign Analysis (Response) Charts
The Campaign Analysis chart displays the total number of responses for each campaign. Before you 
can create this chart, you must verify that the response is associated with a campaign. If it is not, 
you can associate it using the following procedure.

To associate the response to a campaign

1 Navigate to the Responses screen.

2 In the Campaign Name field, associate the response with a campaign.

Displaying the Opportunity Analysis (Response) Charts
The Opportunity Analysis chart displays the total number of opportunities created for each campaign, 
based on the Source field in the opportunity record. Before you can create this chart, you must verify 
that opportunities have been created for the campaign.

If no opportunities have been created for the campaign, you can create them using the following 
procedure.

To verify the opportunities are created

1 Navigate to the Responses screen.

2 For each response to your campaign, verify that opportunities are created (if applicable).

To create an opportunity for the campaign

1 Select the response record in the Responses list.
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2 In the Response form, click Create Opportunity.

An opportunity is created for the campaign and the campaign name is entered in the Source field 
for the opportunity.

Displaying the Offer Analysis (Response) Charts
The Offer Analysis chart shows the total number of responses for each offer based on the offer 
associated with the response. Before you can create this chart, you must verify that the correct offer 
is associated with the response.

To verify the correct offer is associated with the response
Perform the following tasks before generating the chart:

1 Navigate to the Responses screen.

2 For each response to campaigns featuring the offer, make sure the correct offer is associated with 
the response by reviewing the response record’s Offer field.

Displaying the Offer Type Analyses (Response) Charts
You can display offer type analyses (response) through two different charts:

■ Offer Type Analysis (Response) Chart

■ Offer Type Analysis (Response) by Campaign Chart

Displaying Offer Type Analysis (Response) Charts
The Offer Type Analysis chart displays the total number of responses for each offer type across all 
campaigns. Before you can create this chart, you must verify that the offer is identified for the 
response.

To verify the offer is identified for the response

1 Confirm that each offer associated with the campaign has an offer type and offer name specified. 
For more information about finding or completing these fields, see Creating, Modifying, and 
Associating Products with Offers on page 80.

2 Add the responses received during the campaign.

The offer is identified for the response in the Offer Name field.

3 Generate the chart, using the procedure on Process of Displaying Response Charts in Siebel 
Campaigns on page 183.
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Displaying Offer Type Analysis (Response) by Campaign Charts
The Offer Type Analysis by Campaign chart displays the total number of responses for each offer type 
for each campaign. Each campaign can have many offers.

To generate the Offer Type Analysis by Campaign chart

1 Confirm that each offer associated with the campaign has an offer type and offer name specified. 
For more information about finding or completing these fields, see Creating, Modifying, and 
Associating Products with Offers on page 80.

2 Confirm that the offers you want in the chart have been added to the campaign. For more 
information about this procedure, see Associating Offers and Segments with Campaigns on 
page 131.

3 Add the responses received.

4 Generate the chart, using the procedure on Process of Displaying Response Charts in Siebel 
Campaigns on page 183.

Displaying the Revenue Analysis (Response) Charts
The Revenue Analysis (Response) chart displays the total revenue for each campaign and the total 
number of opportunities for each campaign. The bar chart shows the revenue by campaign and the 
line graph shows the number of opportunities for each campaign.

Values for this chart are derived from the Revenue and Source fields in the Opportunity screen’s My 
Opportunities or All Opportunities list. The revenue number is derived from the sum of the Revenue 
fields in the Opportunity records, with the Source field set to the campaign name. Before generating 
this chart, make sure to complete these fields for opportunities used in this analysis.

Displaying the Average Opportunity Revenue Analysis 
(Response) Charts
The Average Opportunity Revenue Analysis chart displays the average revenue for each campaign. 
For each opportunity created for the campaign, the revenue is added and the average is taken across 
opportunities created for the campaign.

Values for this chart are derived from the Revenue and Source fields in the Opportunity screen’s My 
Opportunities or All Opportunities list. The revenue number is derived from the average of the 
Revenue fields in the Opportunity records, with the Source field set to the campaign name. Before 
generating this chart, make sure to complete these fields for opportunities used in this analysis.
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This chapter describes how to create and manage lists of contacts and prospects within applications 
for use in marketing campaigns. It includes the following topics:

■ Siebel List Management Module on page 187

■ Process of Importing and Managing External Lists on page 187

■ Process of Creating and Managing Internal Lists and Subscription Lists on page 201

■ Promotion of Prospects to Contacts on page 206

■ Process of Viewing and Maintaining Lists on page 209

■ Integrating List Management with D&B on page 212

Siebel List Management Module
The List Management module is available to users with a license for Siebel Marketing or Siebel 
Campaigns.

NOTE: The Siebel Campaigns module can be added to any base application, including Siebel Sales, 
Siebel Call Center, and Siebel PRM.

Use List Management to create and manage lists of contacts and prospects within your applications 
for use in marketing campaigns. A list is defined as a grouping of contact or prospect records in the 
Siebel database.

Contacts are customers already in the Siebel database. Prospects are potential customers that have 
yet to be screened, qualified, and promoted to contacts. By using this distinction, List Management 
can eliminate prospects that do not qualify for promotion to contacts.

For example, you rent a magazine subscriber list containing 1,000 names and addresses. You want 
to contact these people, but because the list is rented, you may not add the records into your Siebel 
database as contacts unless they become customers generating revenue. You must be able to 
remove the names from your database when you return the list. Use Siebel List Management to 
identify these names and addresses as temporary prospects until they can be promoted to contacts.

Process of Importing and Managing 
External Lists
External lists are created by importing an external file into your application using the List Import 
utility. Imported lists can come from any source, as long the list can be saved in one of the supported 
file formats, including Comma Separated, Tab Delimited, and Fixed Width. Common examples of list 
sources include rented or purchased lists from marketing bureaus, registration lists from trade shows 
or events, and output lists from other applications.
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When you integrate Siebel Marketing or Siebel Campaigns with Siebel Data Quality (optional 
module), incoming records can be cleansed and matched against existing contacts and prospects in 
the database. This additional process helps prevent creation of duplicate records for incoming 
prospects that are already contacts. For more information about Siebel Data Quality, see Siebel Data 
Quality Administration Guide.

To import and manage external lists, perform the following tasks:

■ Verifying Preinstallation Requirements on page 188

■ Creating Records for Importing External Lists on page 191

■ Matching Approach and Match Resolution on page 192

■ Selecting Matching Approach and Match Resolution on page 193

■ Mapping External List Columns to Database Columns on page 194

■ Maintaining Attributes for List Records on page 197

■ Mapping Fields on page 198

■ Applying List Import Formats on page 199

■ Displaying Import Status and Error Messages on page 200

Related Topics
■ About Importing External Lists on page 191

■ Launching Import Requests and Tracking the Import Status on page 195

■ Campaign and Response Data on page 196

■ List Import Format Settings on page 199

Verifying Preinstallation Requirements
Before importing a list, you need verify the status of the server components, the data quality 
settings, and the structure of the incoming data.

Verifying Status of Server Components and Tasks
Before importing a list, you need to verify that server components are enabled and that server tasks 
are running.

To enable server components and run tasks, you use the Administration - Server Configuration 
screen, Components view. For more information, see Siebel System Administration Guide.

Make sure that the following server components are enabled and the following server tasks are 
running:
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■ List Import Service Manager: Enabled.

Clicking Launch Import in the List Import view tab of the List Management screen submits the 
import request. The actual import is performed by the List Manager server component on the 
Siebel Server.

■ Server Request Processor: Running.

■ Server Request Broker: Enabled or running.

To import a list, you must be connected to the Siebel Server. If the client cannot detect a running 
Siebel Server at the time you launch the import, you receive a warning message. You can continue 
to submit the import request if you are sure that a Siebel Server is available to handle the request 
later.

For the request to be queued, you must have a Siebel Gateway Name Server running in the 
background. The request is routed through the gateway name server to a Siebel Server that has the 
List Import Service Manager server component enabled. If you do not have a gateway name server 
running, you receive an error message:

Unable to connect to gateway name server.

Verifying Data Quality Settings
When you use the optional Data Quality module, you must verify the settings for the following server 
components before importing files:

■ Data Quality Manager.

■ List Import Service Manager.

■ The object manager for the application in which your users promote prospects. For example, if 
you promote prospects using Call Center, you need to enable the Call Center Object Manager.

If you need to enable a server component, see Siebel Marketing Installation and Administration 
Guide. For more information about data quality configuration, see Siebel Data Quality Administration 
Guide.

To verify the data quality settings

1 Verify that these server components are set to Enabled.

2 Verify the component parameters for these server components are set for deduplication and data 
cleansing.

To enable Data Matching:

a Use the Components view in the Administration - Server Configuration screen and query for each 
of these server components.

b Click the Component Parameters view tab, query for the DeDuplication parameters, and verify 
that the DeDuplication Enable Flag is set to TRUE.

To enable Data Cleansing during import, query for the Data Cleansing parameters. The Data 
Cleansing Enable Flag must be set to TRUE.
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3 Verify the matching threshold for List Import.

The Match Threshold setting in the Data Quality Settings view of the Data Administration screen 
determines if an incoming name is considered a match with existing data. You can specify a 
different threshold for List Import than the rest of the Data Quality module.

CAUTION: Reboot Siebel Server before launching any import tasks so that new parameter 
values take effect. Otherwise, the old parameter values remain in effect.

4 Make sure that you set the Data Quality Settings in the Data Administration screen.

You must generate and refresh the match keys for the existing contact and prospect data before 
importing any files.

To specify a different threshold for List Import

1 Navigate to the Components view of the Administration - Server Configuration screen.

2 Select the List Import Service Manager.

3 Click Component Parameters and query for Dedup Threshold.

4 Set the value to the match score threshold that you want to apply to the List Import utility.

Validating the Structure of the Incoming Data
Some columns for a prospect correspond to an LOV (List of Values) or MLOV (Multilingual List of 
Values) field in the application. Be sure that your incoming data for these columns only use values 
from the LOV or MLOV. Any nonmatching values are set to NULL in the new prospect record.

The date format is set in the Regional and Language Options control panel for the machine on which 
the Siebel Server is running. For date fields, make sure you use the correct date format that 
corresponds to the locale settings for your environment.

Common Issues to Check If the Import Is Not Complete
■ Check the license keys.

■ Check that Disable DataCleansing and Disable DeDuplication settings are not selected. These 
settings override those specified in the Server Administration screen. They are specified in the 
Application Administration screen > Data Quality Setting.

■ Check User Preference > Data Quality settings. They override those specified in Application 
Administration.

■ If a key is generated but Siebel Marketing did not find any duplicates, verify if the search type is 
too low and threshold is too high. To change it, use Application Administration-> Data Quality 
Setting.

■ If you are having troubles updating records with List Import, enter it using the List Management 
screen and check the record’s score. List Import assigns the same score. Check to see if the score 
is below the threshold you normally put (instead of the very low threshold you used for the 
troubleshooting test).
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■ Both Real Time DeDuplication and List Import with DeDuplication Enable will insert keys into the 
key tables. Make sure the following new keys are inserted:

■ Account: S_ORG_DEDUP_KEY table. ACCNT_ID column stores the row id of the account

■ Contact: S_PER_DEDUP_KEY table. PERSON_ID column stores the row id of that contact

■ Prospect: S_PRSP_DEDUPKEY table. PRSP_ID column stores the row id of that prospect

■ Batch Key Generate generates keys for old records in the database. If you enable Real Time 
DeDuplication, you do not need to run Key Refresh that often.

■ Make sure you have enabled DeDuplication in the correct Object Manager. The Data Quality 
Manager is only used by Batch mode tasks, it is not the central server for all Real Time 
DeDuplication requests. You must enable Real Time DeDuplication in Call Center, but not Data 
Quality Manager.

■ You cannot match against records that did not have keys generated. You need to run Key 
Generate first if you want to find duplicate records in existing table.

■ Key generation must be run at regular intervals. This is done to refresh the generated keys and 
to include newly added or changed records. Both Batch and Real-Time matching require access 
to the match keys generated by the key generation process.

■ To catch duplicate records for a record entered before DeDuplication was enabled, run Batch Key 
Generate which is used to generate keys for old records in the database.

■ If you are using a custom SRF file, test with the standard SRF file.

About Importing External Lists
Lists that you import must be in text (TXT) format. When you import a list, List Management 
performs the following tasks:

■ Loads the list names into the prospects table as individual records.

■ Matches incoming names to existing records and handles the matches according to your 
requirements, based on your settings of Matching Approach and Match Resolution values.

■ Saves and reuses the file structure you develop during the import process by mapping the 
columns of the file.

■ Controls the matching and address cleansing settings applied by Siebel Data Quality (optional 
module).

When the import is finished, the imported list and its associated contacts and prospects display in 
the List Contacts and Prospects list.

Creating Records for Importing External Lists
Before you import an external list, you must create a record in your application that describes the 
list. This record tells the list import utility what file to import.
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To create a record for importing an external list

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, create a new record and complete the fields.

The following table describes some of the fields.

3 Save the record.

Matching Approach and Match Resolution
You need to specify how you want duplicates handled before importing a list. If Siebel Data Quality 
is not installed or enabled, you can elect to the use the exact match matching approach. If Data 
Quality is enabled, you can use Data Quality (intelligent matching) as the only matching approach 
or you can use Data Quality with exact matching. For more information, see Siebel Data Quality 
Administration Guide. You can choose one of three modes for match resolution, as described in this 
topic.

Reject Import Record Mode
In this mode, if a match is detected by the matching process, any incoming records matching existing 
contacts or prospects are not added as new records in the database. Instead, the matching record 
which already exists in the database is associated with the list. Each skipped record is recorded in 
the List Import log file for reference. If the incoming record matches more than one existing record, 
the record with the highest matching score is added to the list and listed in the list import log file.

Field Comments

Data Type List Import attempts to determine the format of the attached text file. Values 
are:

■ Comma Delimited. If the first row of data in the file contains a comma in 
any of the field values, a best practice is to use tab delimited format to 
make sure that the correct file format is detected.

■ Fixed Width

■ Other Delimited. You can enter another character as the delimiter. If you 
attempt to add >1 character, the value is truncated.

■ Tab Delimited

List Name (Required) This field is populated when you add the record, but you can 
modify the name.

List Type Automatic. The possible values are Imported, Internal and D&B. If Siebel 
Marketing detects an incorrect file type during attachment, you can change 
it.

Source The company from which the list was purchased. The company must be an 
account record in the Siebel database.
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Overwrite Existing Record Mode
In this mode, if a match is detected by the matching process, any incoming records can overwrite 
the existing match in the database. The columns that can be overwritten are set by the administrator 
for the List Import Format used by the file. To set which fields are updated by an incoming record, 
navigate to the List Import Formats view in the List Management screen and select the Allow Field 
Updates check box. For reference, the List Import log file records all records that are updated as well 
as the old and new values for any updated fields.

If you use Overwrite Existing Record as the matching approach and an imported field value does not 
match any value on the bounded LOV, then the application does not change the field on the existing 
prospect record (the original value is preserved).

NOTE: Update Existing Duplicates Mode only updates prospect records. It does not update contact 
records.

Create Additional Record Mode
In this mode, matches are detected but the incoming record is added to the database as new 
prospect without changing or overwriting the preexisting record. Using this mode the administrator 
can resolve any matches later on a case-by-case basis or by using the Siebel Data Quality module. 
To resolve duplicates, you can use the Duplicate Prospect Resolution view tab in the Data Quality 
view of the Data Administration screen. In resolve mode, all matches are recorded in the list import 
log file.

NOTE: If the matching process detects a matching contact, the match results do not appear in the 
Data Quality resolution views. This process can only display matching prospects for resolution.

Selecting Matching Approach and Match Resolution
You need to specify how to handle duplicates before importing a list.

To select a matching approach

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select your list.

The following table describes some of the fields.

Field Comments

Additional 
Actions

Assign to Campaigns, Responses, or Campaigns and Responses. Used 
whenever the import file contains campaign history or response data 
about contacts and prospects. For more information, see Campaign and 
Response Data on page 196.

Cleanse Data 
During Import

A check box for which the default is off. When this flag is checked, 
incoming records are cleansed by Siebel Data Quality. If your company 
has not licensed Siebel Data Quality, this feature is not functional.
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3 Click the list name.

4 Click the List Import view tab.

5 Select a Matching Approach.

The choices are:

■ Exact Matching Only. This option uses the fields marked as Exact Match Fields in the List 
Import Format and queries for any existing contacts or prospects that exactly match the 
values from the incoming record.

■ Intelligent Matching Only. This option uses the data quality matching service to search for 
matching contacts or prospects.

■ Exact and Intelligent Match. This option uses both exact matching and data quality matching. 
The option first searches for an exact match in the existing contacts and prospects, and then 
uses intelligent matching to search for matches if no exact match is found.

■ No matching. This option disables matching for the import job.

6 In the Match Resolution drop-down list, select an action to apply.

For more details, see Matching Approach and Match Resolution on page 192.

Mapping External List Columns to Database Columns
Every column in the file to import must be mapped to an existing column in the prospects table in 
the Siebel Database or to an attribute created for this purpose. If you import response or campaign 
data, you can also map to response and campaign fields. For more information about mapping 
attributes, see Adding Additional Attributes to a List on page 198.

CAUTION: Make sure that you map every column before launching the import.

To map list columns to database columns in the prospect table

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Import view tab.

4 Scroll down to the List Import Format list and map every column to an existing database column 
in the prospect table or to an attribute created for this purpose.

List Import 
Format

Indicates the saved column sequence for the file. Formats can be 
reused across lists. For more information, see Applying List Import 
Formats on page 199.

List Import Mode For descriptions, see Matching Approach and Match Resolution on 
page 192.

Field Comments
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5 In the List Import Format list, save the format in one of the following ways:

a The first time you save a format, click Save as New.

Save as New retains the original format and saves the modified format separately. Saved 
formats appear in the List Management screen’s List Imports Formats view tab.

b Click Save to overwrite the original format.

Use this save option if you make changes to the mappings and want to preserve them.

To verify which database columns are used for matching and update

1 In the form in the List Import view, copy the name of the List Import Format in the List Import 
Format field.

2 In the List Management link bar, click List Import Formats.

3 Query for the name that you copied in the List Import view.

The lower list displays the columns that you mapped from the import file.

4 In the Exact Match Column field, check each column from the list to use for an exact match.

NOTE: These settings are only used when you have selected Exact match or Exact and Intelligent 
match as the matching approach.

5 In the Allow Field Updates field, check the fields to allow to be overwritten when using the 
Overwrite existing record match resolution.

Launching Import Requests and Tracking the Import 
Status
After creating a list record, identifying the Matching Approach and Match Resolution, and mapping 
list columns to database columns, you can import the list and track the status of the request.

To launch a list import request

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Import view tab.

4 In the List Import form, click Launch Import.

After you submit the import request, the status field on the List Import list contains a value of In 
Progress. You can refresh this view to track the status of your request. When the import is finished, 
the status field contains a value of Successfully Completed.

There are three methods that can be used to view the status and details of an import job:

■ During the import process, end users and administrators can review the List Import task status 
in the List Management > System Tasks view.
Siebel Marketing User Guide Version 8.0 195



Managing Lists ■ Process of Importing and Managing External Lists
■ Administrators can also view the log details for the List Import server task in the Components 
view in the Server Management Administration screen. In the Component Tasks list, select tasks 
for the List Import Service Manager.

■ Administrators can also review List Import log files.

Campaign and Response Data
List Import can be used to import campaign and Response Data about contacts and prospects. For 
example, your company may run a campaign against a target list of contacts, but it collects the 
responses in an external application or through an outside service company. You can import the 
response results from these sources and attribute the responses to the original campaign.

The List Import view provides the following additional actions that you can select in the Additional 
Actions field to include response and campaign data in the file:

■ Assign to Campaigns. Adds the contacts and prospects in the import file to the campaign 
included in the file. This action does not create any response data.

■ Assign to Responses. Creates response records for the contacts or prospects in the list. The 
action does not add, delete, or modify the set of contacts and prospects already associated with 
the campaign.

■ Assign to Campaigns/Responses. This action takes contacts and prospects records from the 
import file, adds them to the campaign, and creates responses for them.

Campaign and response data is not created unless you select one of these additional actions, even 
if you mapped response or campaign fields. If you do not select an additional action, the import utility 
ignores response and campaign columns and only creates a list of contacts and prospects.

The List Import view includes the following response fields for mapping import data:

■ Offer Code

■ Offer Language

■ Offer Name (required)

■ Response Date

■ Response Description (required)

■ Response Method

■ Response Score,

■ Response Status

■ Response Type (required)

The List Import view includes the following campaign fields for mapping import data:

■ Campaign Name (required)

■ Campaign Source Code
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When mapping, response and campaign fields, be sure to map all the fields required to create a 
response in the application. The import provides some default values you do not include all the 
required fields.

■ If you do not specify Offer Name, the response defaults to the primary offer for the campaign.

■ If you do not specify Response Type, the type defaults to Unclassified Response.

■ If you do not specify Response Description, the type defaults to Imported Response.

If you enable the response business service that performs automatic lookups for Campaign Source 
Code and Offer Code, you can map the Campaign Source Code and Offer Code fields as an alternative 
to Campaign Name and Offer Name. In this case, the import utility performs the lookup and defaults 
to the related Campaign Name and Offer Name. For more information, see About Using Response 
Management on page 151.

NOTE: The Campaign Source Code field in the List Import mappings indicates the source code value 
assigned individually to each Campaign Contact and Prospect. It does not refer to the Source Code 
field in the Campaign record (the field displayed on the Campaign form).

Maintaining Attributes for List Records
Prospects have a predefined set of information fields. These are the standard types of information 
about your prospects that normally include address, phone number, email address, and so on. These 
values are defined in Siebel Tools under the Prospect Business Component.

If the list to import has attributes not contained in the standard prospect table, you can create 
additional attributes to capture the data. After they are created, additional attributes appear on the 
list of available columns that can be mapped in the List Import view.

An additional attribute can contain any type of information, as long as it can be contained in a single 
field and can relate directly to the prospect record. For example, additional attributes may include 
hobbies, special contact information (for example, pager #), product interests, survey responses, or 
demographic attributes.

Creating Additional Attributes for List Records
To make an additional attribute available during list mapping, you must first make sure your desired 
attribute exists and then associate the attribute with the specific list.

To create additional attributes

1 Navigate to the List Management screen > Additional Attributes view.

2 In the Additional Attributes list, create a new record.

NOTE: The maximum number of additional attributes is 19, and no attribute can map to an 
empty column.

3 In the Additional Attribute field, enter the name of the new attribute.

You can create the overall attribute type, such as Hobby or Pager #.
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4 Enter a description for the additional attribute, if needed.

Adding Additional Attributes to a List
After you create the additional attributes needed to capture the data in the list to import, you must 
add them to your specific prospect list and map them to one of the List Import columns.

To add additional attributes to a list

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Additional Attributes view tab.

4 In the List Additional Attributes list, create a new record.

5 In the Pick Additional Attribute dialog box, select the attribute, and click OK.

Mapping Fields
After you import a list, you must map the fields in the imported list to the fields in the Prospect 
Business Component. When you do this mapping, the values in the list fields are transferred 
accurately into the correct fields in the prospect records.

When there is a dedicated column in the prospect table, map the fields in the imported list to existing 
fields in the prospects record. Try to avoid mapping fields to additional attribute columns in the 
database extension table. When a value is stored in the main Prospect table, there is more flexibility 
to configure the location where the promoted field value is mapped on the Contact record in the 
promotion map in the repository. Additional Attribute values can only be promoted to Contact 
Category data.

To map fields when importing a list

1 Navigate to the List Management screen.

2 In the List Management link bar, click Additional Attributes.

3 Query for each attribute to use, and verify that they exist.

4 In the List Management link bar, click Lists.

5 Click a list name and click the List Additional Attributes view tab.

6 To associate attributes with the list, in the attributes list, create a new record.

7 In the Pick Additional Attribute dialog box, perform the following steps:

a To create new attributes, create a new record, and in the attributes list, enter a name and 
description.

b To associate predefined attributes to the list, select an attribute, and click OK.

8 Associate the attributes with the list using the List Additional Attributes tab.
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9 Navigate to the List Import view tab.

10 At the top of each column in the external list, select the appropriate field or attribute to which 
the column is to be mapped.

11 Click Save as New.

12 At the top of each column in the external list, select the appropriate prospects record attribute 
to which the column is to be mapped.

13 Create additional attributes for columns in your list which have no corresponding Prospect field.

Applying List Import Formats
Before you import a file, you must save the List Import Format (the sequence of columns that 
correspond to your file). The list format name consists of the list name followed by the saved date/
time stamp. For example, My Target List 09/1/2004 12:30:15pm. For more information, see Mapping 
External List Columns to Database Columns on page 194.

To apply an existing List Import Format to your list

1 Navigate to the List Management screen.

2 Click the list name.

3 Click the List Import view tab.

4 In the List Import Formats field, click the select button.

5 In the List Import Formats dialog box, select a format to use. If necessary, perform a query to 
locate the format.

NOTE: You may not be able to apply an existing format to a fixed-width file if the data was originally 
created for comma separated or tab delimited file. For CSV or tab delimited files, the column width 
value defaults to 20, and this value may not match the width of the fixed width file that is being used.

List Import Format Settings
You can administer the precise settings associated with your list import format. If the Import Format 
is to be used in Overwrite Existing Record match resolution, you can specify which columns are 
allowed to be overwritten in the database. The Allow Field Updates column in the lower list indicates 
which columns are set to be overwritten. If the column is checked, that field is overwritten in any 
existing prospect record that matches the incoming record. By default, all columns are unchecked, 
so that no existing information can be overwritten without the administrator’s consent.

If you are using Exact Match or Exact and Intelligent Match as the matching approach, you need to 
specify the columns that will used to perform the exact match query. In the List Import Mappings 
list, check the box in the Exact Match Column column for each list field to be used in the exact match 
query.
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For files with a fixed width file type, the server detects the column width and displays the width in 
the List Import Formats view. To display the column width settings, from the visibility filter, select 
List Import Formats and in the List Import Formats list, select the list that relates to your list. If the 
List Import Format was originally created from a comma separated or tab delimited file, the value 
defaults to 20, although the width does not have any effect during the import task.

NOTE: Columns mapped to Additional Attributes cannot be updated in Update Mode. If you check 
Allow Field Updates for this column in the List Import Formats view, the application ignores the 
setting.

List Import can load a text file in one of three types: comma separated, fixed width, and tab 
delimited. For files with a fixed-width data type, you can specify the width of each column. The 
default width is 20. The bottom list displays the column sequence that you have defined in the List 
Import list. Enter the width in the Width field.

Displaying Import Status and Error Messages
When you launch an import task, the List Import list displays the status of the task. The status may 
show any of the following messages: Submitted Import Request, In Progress, Successfully Complete, 
Error, or Completed with Errors.

You can view the detailed results of the List Import task by reviewing the log file from the Siebel 
Server. The log file contains the following information:

■ The status of the file import task (in progress, completed, or error)

■ The number of incoming records

■ The number of records imported

■ Notification of any record that experienced an error

■ Notification of any record that detected a duplicate contact or prospect

■ Notification of any record that was updated (update mode only)

■ Notification of any response record or associated campaign that experienced an error

To view the system task for the List Import job

1 Navigate to the List Management screen > System Tasks view.

2 Query for tasks in which the Process Name is List Import and the User is the user who submitted 
the import job.

3 Sort the tasks by date and find the task for your list import job.

To verify that the task is for the correct file, see the logging messages in the lower list.

To view the log file for the List Import job

1 Navigate to the List Management screen > System Tasks view.
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2 Query for tasks in which the Process Name is List Import and the User is the user who submitted 
the import job.

3 Sort the tasks by date and find the task for your list import job.

To verify that the task is for the correct file, read the logging messages in the lower list.

4 In the lower list, read the Log File field to find the name of the log file.

5 Open the log file using any text processing application.

Process of Creating and Managing 
Internal Lists and Subscription Lists
List Management creates lists of contact and prospect records stored within your applications. 
Internal lists are created within the List Management module by querying existing contact or 
prospect records in the database.

After you have created these lists, you can reuse the list any number of times for campaigns. Lists 
are used by Siebel Marketing and Siebel Campaigns. You can use lists in List Management to serve 
as subscription lists for Email campaign.

To create and manage internal lists, perform the following tasks:

■ Associating Prospect Lists in Siebel Marketing on page 201

■ Creating Internal Lists on page 203

■ Adding Prospects or Contacts to Internal Lists on page 204

■ Creating Lists of Prospects Using Additional Attributes on page 204

■ Creating and Managing Subscription Lists on page 205

NOTE: For more information about managing lists, see the chapter on global target list management 
in the Siebel Applications Administration Guide.

Associating Prospect Lists in Siebel Marketing
Marketing campaigns can include prospects in a using one of the following approaches:

■ Associating an internal list of prospects with the campaign.

■ Associating a segment from the Marketing segmentation module where the campaign load list 
format is configured to load the Marketing Prospect integration object.

To associate an internal list with a campaign

1 Navigate to the Campaigns screen > Campaign List view.

2 Click the campaign Name.

3 Click the Design tab.
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4 In the Design link bar, click Segments/Lists.

5 Click Add List to associate an internal list.

To associate more lists, repeat Step 5.

6 After the desired lists are associated, click the menu on the upper campaign form and choose 
Load Campaign to associate the members of the list to the campaign.

7 Pick a time and date for the load request, and click OK.

Marketing campaigns can include prospects in a using one of the following approaches:

■ Associating an internal list of prospects with the campaign.

■ Associating a segment from the Marketing segmentation module where the campaign load list 
format is configured to load the Marketing Prospect integration object.

To associate a segment of prospects with a campaign

1 In the Marketing Module, create a segment. Make sure that the Campaign Load List Format for 
the segment is configured to load data into the Marketing Prospect integration object.

2 Navigate to the Campaigns screen > Campaign List view.

3 Click the campaign Name.

4 Click the Design tab.

5 In the Design link bar, click Segments/Lists.

6 Click Add Segment to associate the segment.

If the segment has never been used in a campaign previously, click Choose a new segment, and 
select the segment from the folder location where you saved it.

7 To associate more segments, repeat Step 6.

8 After the desired segments are associated, click the menu on the upper campaign form, and 
choose Load Campaign to associate the members of the segment to the campaign.

9 Pick a time and date for the load request, and click OK.

Table 31 describes how prospects and contacts can be used in segments associated with campaigns.

Table 31. Scenarios for Using Segments of Contacts and Prospects in Campaigns

Scenario Data Source
Integration 
Object Comments

Segment 
contains only 
contacts

Siebel OLAP or 
Siebel OLTP

Marketing 
Contact

Fully supported. Contacts exist in the Siebel 
transactional database, so data is inserted 
only into the S_CAMP_CON table.

Segment 
contains only 
contacts

Non-Siebel 
database

Marketing 
Contact

Fully supported. New contacts and accounts 
(if mapped) are created in the Siebel 
transactional database.
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Creating Internal Lists
The contacts or prospects you target for each campaign vary depending on the campaign objective. 
For example, you may want to select the contacts who have a certain job title or live in a specific ZIP 
or Postal Code. In another campaign, you may want to combine sets of contacts or prospects that 
were selected by several different criteria into a single list.

You create an internal list of contacts or prospects in the List Management screen using the Contacts 
or Prospects view. You can also use these views to add contacts or prospects to existing lists.

NOTE: To create an internal list, your employee login must have a responsibility associated with it 
that includes the List Management views.

You can reuse lists in any number of campaigns or marketing programs.

To create an internal list of contacts or prospects

1 Navigate to the List Management screen > Contacts or Prospects view.

2 In the Contacts or Prospects list, select the individuals that you would like to include, or perform 
a query to find this information.

3 After you receive the results of your query, you can select any number of the records for inclusion 
in the list.

4 With the desired records selected, click Add to List.

5 In the Pick List dialog box, click Create New List.

6 In the second Pick List dialog box, enter a name for the list, and click OK.

7 In the Pick List dialog box, select the list you created and click OK.

Segment 
contains only 
prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Prospects exist in the 
Siebel transactional database, so data is 
inserted only into S_CAMP_CON.

Segment 
contains only 
prospects

Non-Siebel 
database

Marketing 
Prospect

Fully supported. New prospects are created 
in the Siebel transactional database.

Segment 
contains contacts 
and prospects

Siebel OLAP or 
Siebel OLTP

Marketing 
Person

Fully supported. Contacts and prospects 
exist in the Siebel transactional database, 
so data is inserted only into S_CAMP_CON 
and S_DD_USER_KEY tables.

Segment 
contains contacts 
and prospects

Non-Siebel 
database

N/A Currently not supported.

Table 31. Scenarios for Using Segments of Contacts and Prospects in Campaigns

Scenario Data Source
Integration 
Object Comments
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8 To display the new list, in the List Management link bar, click Lists.

NOTE: The list type is defaulted to Internal. You can rename the list to give it a more appropriate 
reference name or type at any time.

Adding Prospects or Contacts to Internal Lists
Adding to an existing internal list is similar to creating a new internal list. You can use Add to List to 
attach prospects to a list of type Internal, D&B, or Imported. You can attach prospects from the All 
Prospects list or the Prospects by Category list.

To add contacts or prospects to an internal list

1 Navigate to the List Management screen > Contacts or Prospects view.

2 In the Contacts or Prospects list, select the individuals to include or perform a query to find this 
information.

After you receive the results of your query, you can select multiple records for inclusion in the list.

3 With the records selected, click Add to List.

4 In the Pick List dialog box, select the appropriate list, and click OK.

5 To display the new list, in the List Management link bar, click Lists.

6 Select the appropriate list, and click the list name.

7 Click the List Contacts and Prospects view tab to verify that your selected contacts or prospects 
have been added.

Creating Lists of Prospects Using Additional Attributes
You can create lists of prospects by querying the additional attribute data for prospects. For example, 
you may create an additional attribute for hobby and then record these values for many of your 
prospects. For a campaign, you may want to create a list of prospects with certain hobbies, such as 
sailing or painting.

You can create a list of prospects by using the Prospects by Category list. In this list, the New Internal 
List and Add to List functions are also available. Query the list of prospects using the appropriate 
attribute and attribute value. Then, select the desired records and either create a new list or add to 
an existing list.

Due to the many-to-many relationship between prospects and attributes, you cannot have multiple 
combinations of attributes and values in a single query. To create of a list that combines queries, for 
example Hobby = Skiing AND Preferred Language = Spanish, perform separate queries, and use the 
Add to List function to combine the results.

To create an internal list of prospects using attributes

1 Navigate to the List Management screen > Prospects by Category view.
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2 In the Prospects by Category list, select one or more prospects to include in your internal list.

3 With the desired records selected, click Add to List.

4 In the Pick List dialog box, click Create New List.

5 In the second Pick List dialog box, enter a name for the list, and click Save.

6 In the Pick List dialog box, select the list you created, and click OK.

7 To display the new list, in the List Management link bar, click Lists.

To add to an internal list using prospect attributes

1 Navigate to the List Management screen > Prospects by Category view.

2 In the Prospects by Category list, select the prospects that you would like to include in your 
internal list, or perform a query if necessary.

After you receive the results of your query, you can select any number of the records for inclusion 
in the list.

3 With your desired records selected, click Add to List.

4 In the Pick List dialog box, select the appropriate list, and click OK.

5 To display the new list, in the List Management link bar, click Lists.

6 Select the appropriate list, and click the list name.

7 Click the List Contacts and Prospects view tab to verify that your selected contacts or prospects 
have been added.

Creating and Managing Subscription Lists
You can use lists in List Management to serve as subscription lists for Email campaigns. A 
subscription list is a set of contacts or prospects that have indicated that they wish to receive 
communications about a certain topic. After creating a subscription list, you can associate the list 
with an Email Offer. Any responses to Subscribe or Unsubscribe from List then adds and removes 
members from this list.

Before you can create a subscription list, create an internal list of contacts, prospects, or both using 
one of the following methods:

■ The Add to List button in the List Management views

■ The Create Target List feature (Siebel Industry Applications only)

■ EIM or other custom configuration

To create a subscription list

1 Navigate to the List Management screen > Lists view.

2 Find the list you created.
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3 Change the Type to Subscription.

To associate the subscription to an email offer

1 Navigate to the Offers screen > Email Offers view.

2 Query for an Email Offer with which to associate the list.

3 Click the offer and in the form below, add the subscription list.

Promotion of Prospects to Contacts
When a prospect satisfies a set of screening criteria, he or she can be promoted to become a contact. 
The new contact record contains the same name and address information as the prospect record. 
The additional attribute data associated with the prospect is promoted to categories and category 
values for the new contact.

NOTE: You can have duplicate contacts in the same account. For example, duplicate contacts from 
different companies might belong to the same account.

When you promote a prospect, the application checks for the following items:

■ List Management confirms whether Data Quality deduplication is enabled. If so, the promotion 
matches the prospect against existing contacts. If a match is found, a pop-up window appears 
showing the matching contacts. You can then pick or ignore the matches and proceed with the 
promotion:

■ If the user chooses an existing contact from the pop-up window, the prospect record is 
marked as Promoted and its associations with any campaigns, lists, or responses are linked 
to the selected contact.

■ If the user ignores all matches in the Pop-up Window, the promotion continues as if no match 
was detected.

■ If Data Quality finds no matching contact or Data Quality is not enabled, the promotion checks 
whether the combination of the Account Name and Account site fields matches an existing 
account record.

■ If the combination of the Account Name and Account Site fields match an existing account record, 
one of the following occurs:

■ If the account name exists but the account site is empty, the promotion compares with 
existing accounts that have the same Account Name and Account Site. If an identical account 
exists, the promotion links the contact to the existing account. For the prospect address 
fields, either an update or an insert on the Account Address is performed, based on the 
combination of Street Address, City, and State (Industry Applications also use Postal Code 
as well). If there is not a match with an existing account, a new account is created and the 
prospect personal address becomes the account address.

■ If no account location or account name is specified, an account is not created or associated 
with the promoted prospect. The prospect personal address becomes the contact personal 
address.
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Promoting Single or Multiple Prospects
You can promote a single prospect or multiple contacts, using the Prospects More Info view or the 
views in the List Management screen. You can promote multiple prospects using the Promote Many 
button in some views in the List Management screen. This action promotes any prospects for which 
Data Quality does not find any matches.

CAUTION: Promotion is only intended for promoting relatively small numbers of prospects at one 
time (fewer than 100). If you select more prospects, the process could take many minutes to 
complete. To see the promotion result, you must query repeatedly until the process completes.

Prospects that have at least one matching contact are not promoted when you click Promote Many. 
If you do not enable Data Quality, selected prospects are promoted to contacts.

When a prospect is promoted, a contact record is created with matching field information, and the 
prospect is removed from the list of prospects.

To promote a single or multiple prospects using the Prospects More Info view

1 Navigate to the List Management screen > Prospects view.

2 Use one of the following methods to promote prospects:

■ In the Prospects list, select a prospect record, and click Promote.

■ To promote multiple prospects, select the prospect records to promote, and click Promote 
Many.

To promote a single or multiple prospects using the views in the List Management 
screen

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Contacts and Prospects view tab.

4 Use one of the following methods to promote prospects:

■ In the Contacts and Prospects list, select a prospect record, and click Promote.

■ To promote multiple prospects, select the prospect records to promote, and click Promote 
Many.

To promote a prospect to an opportunity using views in the Campaigns screen

1 In Navigate to the Campaigns screen.

2 In the Campaigns list, select a campaign.

3 Click the Overview view tab.

4 In the Overview list, select a prospect record, and click Create Opportunity.
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About Promoting a Prospect’s Response to an Opportunity
A prospect that responds to a campaign offer can be promoted by promoting the response to an 
opportunity in the Responses screen. For more information, see Promoting Responses to 
Opportunities on page 159.

Promotion Map Modifications
List Management provides a default path for information to move from the prospect record to the 
contact record during promotion. Prebuilt maps specify where in the contact record prospect fields 
are copied when a prospect is promoted. List Management provides three prebuilt maps for moving 
prospect information during promotion. Table 32 contains prospect information.

Using Siebel Tools, you can redirect any of these prospect fields to a field associated with another 
business component. For example, you may decide that you do not want to use the Alias field for the 
prospect and would like it to hold some other information such as a Back Office Account ID. You may 
also want to promote that ID to populate a specific field on the contact record, possibly an extension 
column added to your implementation. To view or change the promotion map, in Siebel Tools, 
navigate to Business Components >List Mgmt Prospective Contact > Business Component User 
Properties.

You can display the destination business component by looking under Business Component User 
Properties for the List Mgmt Prospective Contact and searching for the Map Name in the Name 
column. The path for the map is displayed as Destination Business Component: Source Business 
Component. For example, Contact: List Mgmt Prospective Contact.

In this case, all three default maps use the List Mgmt Prospective Contact business component as 
the source.

Table 32. Prospect Information

Map Name
Information 
Promoted

Source Business 
Component

Destination 
Business 
Component

LM Contact Map Contact related 
information such as 
First Name, Email 
Address, and Job Title

List Mgmt Prospective 
Contact

Contact

LM Account Map Account related 
information such as 
Annual Revenue and 
Line of Business

List Mgmt Prospective 
Contact

Account:List Mgmt 
Prospective Contact

LM Business Address 
Map

Business Address 
information such as 
City, Country, and 
Postal Code

List Mgmt Prospective 
Contact

Business Address
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To modify the promotion map, you can change a user property in the map to promote the information 
to a different field in the Destination Business Component for the map.

Alternatively, if you wish to promote user properties to a destination business component other than 
the three default maps, you could create a new map for those user properties.

Modifying Map Entries
To insert or modify a map entry, first determine which map to use for a given set of source and 
destination fields. Then add an entry using the following syntax:

Name: Promotion Map:[Destination Integration Component].[Field Name of Destination 
Integration Component]
Value: [Field Name of Source Integration Component]

■ Map Name. The name of the map specified under the corresponding row in the Business 
Component User Properties.

■ Destination Field. Field in the Destination Business Component to receive source data. The 
Destination Business Component is map specific but configurable.

■ Source Field. Field in the Source Business Component from which to extract data. Source 
Business Component is map specific but configurable.

Example:

Name: Promotion Map.Contact.First Name
Value: First Name

Each map only works with a specific source and destination Business Component. However, you can 
make copies of the Business Components and rename them.

To modify the source and destination Business Components of these mappings, modify the following 
Business Component User Prop:

Name Column: [Map Name]

Value Column: [Destination Business Component]:[Source Business Component]

Process of Viewing and Maintaining Lists
A list in Siebel Marketing is a group of contact or prospect records in the Siebel database.

To view and maintain lists, perform the following tasks:

■ Displaying Lists of Contacts or Prospects on page 210

■ Deactivating or Deleting Lists on page 210

■ Removing Prospects or Contacts from Lists on page 211
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Displaying Lists of Contacts or Prospects
You can view the list members and details about them in several ways. If you know the name of the 
list, you can start at the Lists view. To display other lists a contact or prospect may be on, you can 
also start at the Contacts or Prospects List view.

To display a contact or prospect list from the Lists view

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select the list record.

3 Click the list name.

The List Contacts and Prospects view appears. This view shows the contacts or prospects on the 
list you selected. If the Contact column is checked, the person is a contact. In addition, the 
person’s name appears either in the Contact Last Name or Prospect Last Name column to further 
identify if the person is a contact or prospect.

4 Click the Last Name, and one of the following views appears:

■ If you clicked a Contact name, the Contacts > Contacts List view appears, with the Activities 
view tab selected.

■ If you clicked a Prospect name, the List Management > Prospects view appears, with the 
More Info view tab selected.

To view contact or prospect information from the Contacts or Prospects List view

1 Navigate to the List Management screen > Lists view.

2 From the List Management link bar, click Contacts or Prospects.

Depending on which you chose, the Prospect List view or Contact List view appears.

3 Select the record of the Contact or Prospect you are interested in.

4 Click the Last Name, and one of the following views appears:

■ If you clicked a Contact name, the Contact Detail view appears, with the Activity view tab 
selected.

■ If you clicked a Prospect name, the Prospective Contact Market Segment view appears, with 
the Prospect Additional Attributes view tab selected.

Deactivating or Deleting Lists
You can deactivate or delete lists using the following procedures.
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Deactivating Lists
Many times lists are acquired from outside sources such as other companies, Web sites, and events 
such as seminars and trade shows. Because this data typically represents prospective customers who 
are not active customers, you may wish to deactivate any remaining prospects who have not been 
promoted to contacts. Additionally, lists can be generated by different users for a specific campaign 
or business situation, so you may want to keep lists active only for a specified period of time.

To deactivate a list

1 Navigate to the List Management screen and select the Lists view.

2 In the Lists list, select a list to deactivate.

3 In the Lists form, change the status to Inactive, or set the expiration date.

The expiration date is an information-only field and does not affect your use of the list.

Deleting Lists
This action deletes the list as well as the association with any contact or prospect records.

NOTE: Deleting a list does not delete the contact or prospect records, only the association between 
the list and contact or prospect records. This is because those names may also be used on other lists.

To delete a list

1 Navigate to the List Management screen and select the Lists view.

2 In the Lists list, select a list to delete.

3 Click the menu button and choose Delete Record.

Removing Prospects or Contacts from Lists
You can remove prospects or contacts from lists using the following procedures.

Removing Prospects from Lists
A prospect cannot be removed from a list using the List Contacts and Prospects view, because the 
prospect may appear on more than one list. You have more control over individual prospect lists 
when you remove the association between the prospect record and its list. If you remove the list 
associations for a prospect, the prospect record is deleted.

To remove a prospect from a list

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Contacts and Prospects view tab.
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4 In the List Contacts and Prospects list, select a record to remove, and click the first or last name 
of the prospect.

5 Click the Prospect Lists tab.

6 In the Prospect Lists list, select and delete the list or lists from which to remove the prospect.

If you select and delete all of the lists, the prospect record is also deleted.

You can also purge all prospects from a list using the following procedure.

NOTE: The contacts that remain in a purged list do not load into campaigns. Do not associate a 
purged list with a campaign.

To purge all prospects from a list

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, select the list record.

3 In the lower form, click Purge List.

4 When the confirmation dialog appears, click OK, and then click OK again to submit the request.

This action removes all prospects where the Promoted By and Promoted Date are NULL 
(indicating they have never been promoted).

5 To confirm the prospects were deleted, drill down on the name of the list in the upper list applet, 
and go to the List Contacts and Prospects view tab.

Removing Contacts from Lists
Contacts can be removed from all lists, but the Contact record remains in the database.

To remove a Contact from a list

1 Navigate to the List Management screen > Lists view.

2 Click the list name.

3 Click the List Contacts and Prospects view tab.

4 In the List Contacts and Prospects list, delete the record.

Integrating List Management with D&B
List Management can be used in conjunction with Siebel Dun & Bradstreet (D&B) Integration Solution 
to generate lists of prospects from the D&B dataset. Within Siebel Dun & Bradstreet Integration 
Solution, you can perform a query on D&B accounts and generate a list of prospects from the results 
of the query. These prospects can then be targeted in a campaign and promoted to active contacts.
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List Management uses the D&B D-U-N-S number to provide data consistency throughout this 
process. The D-U-N-S number is associated with prospects derived from the D&B data. After a D&B 
prospect is promoted to a contact, the D-U-N-S number is used by the D&B update routine to 
continually refresh the data for those new contacts and their associated account information.

Viewing Account Data for D&B Prospects
The account related to a D&B prospect may already exist as a Siebel account. You can use the 
following procedure to view account information after you promote an account from a D&B account 
to a Siebel account.

To view the account information for a D&B prospect

1 Navigate to the List Management screen > Lists view.

2 In the Lists list, click the D&B list name.

3 In the List Contacts and Prospects list, click the name in the Prospect Last Name field.

NOTE: Make sure you select the Prospect Last Name and not the Contact Last Name.

4 Click the More Info view tab.

5 In the Prospects list, click the Matched Account Name.

If there is no matching account name, the field is blank.

Promotion of D&B Prospects
When you promote a D&B prospect to a contact, promotion checks if a Siebel account with the same 
D-U-N-S number exists and the following actions occur:

■ If a Siebel account exists with that D-U-N-S number, the promotion proceeds according to the 
standard promotion process in Promotion of Prospects to Contacts on page 206. After the 
promotion, any other prospects from that same D&B account are removed from the list.

■ If there is no Siebel account with that D-U-N-S number, the application invokes the D&B account 
promotion, which then promotes the account and its associated contacts, industry information, 
and other information. For more information, see the D&B chapter in the Siebel Applications 
Administration Guide.

NOTE: List Management does not promote a prospect with an invalid D-U-N-S number. A D-U-N-S 
number is considered invalid if it is not contained in the D&B Accounts table.
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10 Setting Up and Using Web 
Marketing
This chapter describes how to set up and use Oracle’s Siebel Web Marketing. It includes the following 
topics:

■ About Siebel Web Marketing on page 215

■ Web Marketing and Web Site Visitors on page 215

■ Siebel Web Marketing Installation Requirements on page 217

■ Control of User Access to the Web Marketing Web Site on page 218

■ Default Responsibilities and Users for Web Marketing on page 218

■ Default Campaigns and Default Offers on page 219

■ Use of Siebel Personalization with Web Marketing on page 219

■ Customization of the Web Marketing User Interface on page 220

About Siebel Web Marketing
Siebel Web Marketing is an optional Siebel Marketing module that provides you with the tools and 
templates to manage and execute Web-based marketing. It provides the Web site visitor with a 
method of viewing a Web offer, downloading literature, and using preconfigured Web response forms 
to request more information or request contact by telephone.

You can modify the look and feel of Web Marketing to match your existing Web site. Siebel Web 
Marketing Web sites can be deployed in more than one language. 

Web Marketing and Web Site Visitors
A Web site visitor can navigate to the Web Marketing home page by entering the URL in a browser 
or by clicking a hyperlink on another Web page. At this point, the visitor to the Web page is 
anonymous and can choose to register, log in (with an existing user name and password), or continue 
to navigate anonymously. When the anonymous visitor arrives at the Web Marketing home page, the 
default campaign offers and the details for the first offer in the Featured Offers list appear. If the 
visitor registers or logs in, the visitor sees other campaign offers for which he or she is eligible. For 
more information about default offers and default campaigns, see the description of featured offers 
in Web Marketing Offers Page on page 223.

If a contact logs in using the contact’s user ID and password, any responses generated by this 
customer are tagged with the customer’s account ID and with the associated campaign ID. For more 
information about setting up users, see Default Responsibilities and Users for Web Marketing on 
page 218.
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Web site visitors can also navigate to the Web Marketing site by clicking an embedded URL from 
within an email offer. Only contacts or prospects receive these offers. When an email contact or email 
prospect clicks an embedded URL, the Web Offer page for this offer appears. Any responses to the 
offer from this contact or prospect are tagged with the associated campaign ID and offer ID, so 
marketers can track response rates for specific campaigns. For a list of responses that are captured, 
see Response Management on page 221.

Visitors to your Web Marketing home page are categorized as follows:

■ Anonymous Visitor on page 216

■ Email Contact on page 216

■ Email Prospect on page 217

■ Logged-In Contact on page 217

Anonymous Visitor
Any visitor can enter the Web Marketing URL into a Web browser and navigate to your Web Marketing 
home page. This visitor sees no personalized Welcome message and responses are not captured 
when the visitor clicks a Recommended Product link or downloads literature. However, an anonymous 
visitor can create a product information or call response by clicking the Send Product Information or 
Request a Call link in the Offers page or Information page. The profile information that the 
anonymous visitor enters creates a prospect record that is associated with the responses.

Email Contact
When a contact clicks an embedded link in an email, your Web Marketing home page appears and 
the Contact Id is set in an anonymous session. At this point, the email contact is not logged in. The 
contact must be a registered contact and must log in to access profile information in the My Accounts 
link or to perform any other tasks that require the contact to be a registered contact. The email 
contact can generate responses by clicking a Recommended Product link, downloading literature, or 
requesting product information or a telephone call.

In the Web Marketing home page, the contact can log in. After logging in, the email contact becomes 
a logged-in contact.

If an email contact clicks the My Accounts link during an anonymous session, the User Login (user 
registration) view appears, requiring the anonymous visitor to log in before continuing.
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Email Prospect
When a prospect clicks an embedded link in an email, your Web Marketing home page appears, and 
the Prospect Id is set in an anonymous session. At this point, the email prospect is not logged in. 
The prospect must become a registered contact and must log in to access profile information in the 
My Accounts link or to perform any other tasks that require the prospect to be a registered contact. 
The email prospect can generate responses by clicking a Recommended Product link, downloading 
literature, or requesting product information or a telephone call.

In the Web Marketing home page, the email prospect must register as a new contact before the 
prospect can log in. In the User Login applet, the email prospect can enter a user ID and password 
or click the New User link to register as a new contact and obtain a user ID and password.

In the User Login view, the User Login (user registration) view appears, requiring the anonymous 
visitor to log in or to register as a new user before continuing. When registration is complete, the 
prospect is converted to a new logged-in contact. However, the original email prospect’s responses 
are not associated with the new contact record. After logging in, the email prospect becomes a 
logged-in contact.

NOTE: If an email prospect clicks the My Accounts link during an anonymous session, the User Login 
(user registration) view appears, requiring the anonymous visitor to log in or to register as a new 
user before continuing.

Logged-In Contact
This contact has access to the My Account link and can perform all other tasks that a registered 
contact is eligible to perform. The logged-in contact can generate responses by clicking a 
Recommended Product link, downloading literature, or by requesting product information or a 
telephone call. These responses are associated with the contact record in the database.

Siebel Web Marketing Installation 
Requirements
Before you install and use Web Marketing, you must install the following:

■ Siebel Web Engine and related components. To deploy information on the Web and customer 
applications, you must install the Siebel Web Engine and the components on which it depends. 
These include a Web server, Siebel Gateway Name Server, and Siebel Server. For more 
information about installing components, see the Siebel Server installation guide for the 
operating system you are using.
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■ Siebel Applications. To perform administrative tasks such as server administration, creating 
Web offers, and managing marketing activities, you must install an employee application such as 
Siebel eSales and add the Siebel Web Marketing license key. For more information about 
installing an employee application, review the appropriate administration guide, for example, 
Siebel eSales Administration Guide. 

NOTE: Siebel Web Marketing is an add-on module to Siebel Marketing. Siebel Web Marketing 
requires the Web Marketing Object Manager component, which is part of the Marketing Component 
Group. For more information about installing Siebel Marketing, see Siebel Marketing Installation and 
Administration Guide and the Siebel Server installation guide for the operating system you are using.

Control of User Access to the Web 
Marketing Web Site
To control user access in your Siebel Web Marketing Web site, the following options are available:

■ Using external authentication using LDAP (Lightweight Directory Access Protocol)

LDAP is an Internet protocol that email programs use to look up contact information from a 
server.

■ Creating database users for LDAP to use in database access

■ Defining visibility for views and products

■ Assigning a proxy employee

■ Creating users through registration or user administration

■ Associating users with accounts

■ Allowing various levels of access such as Anonymous, Implicit login, and Explicit login

■ Customizing access to home and login pages. For more information about the New User link, see 
Web Marketing Offers Page on page 223.

■ Using Web Single Sign-on (SSO) functionality

■ Allowing another application to log in

■ Adding fields to registration forms

Default Responsibilities and Users for 
Web Marketing
Responsibilities control which views the users can display. The views to which a user has access 
determines the links and page tabs that the user gets. For example, if a user has a responsibility 
that does not permit access to the Credit Cards view, no Credit Cards link appears in the My Settings 
view. If no views within a business object are visible, the page tab that maps to that business object 
is not displayed.

The responsibilities predefined for Siebel Web Marketing include:
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■ Web Anonymous User. Grants view visibility to anonymous users such as anonymous visitors, 
email prospects, and email contacts. For more information about these user types, see Web 
Marketing and Web Site Visitors on page 215. This responsibility allows the user to access views 
that do not have the Requires_Explicit_Login flags set to TRUE in Siebel Tools. For more 
information, see Using Siebel Tools.

■ Web Registered User. The end user of the application in a business-to-consumer model such 
as a logged-in contact. For more information about these user types, see Web Marketing and Web 
Site Visitors on page 215. This user has registered and is recognized by the application either 
through their login, or because the user enters the site by clicking an embedded link in an email 
offer.

■ Web Corporate User. The end user of the application in a business-to-business model. A Web 
corporate user is associated with an account and must be authorized by the Web Delegated 
Customer Administrator to access the site. An administrator can add new Web corporate users.

Default Campaigns and Default Offers
Assigning a default campaign and offer is part of the Web Marketing setup process. An offer 
associated with the default campaign can be designated as the default offer. 

You specify the default campaign and default offer in the Application Administration screen in the 
System Preferences view. To assign a default campaign, complete the Default Campaign Code field. 
To assign the default offer, complete the Default Offer Code field.

The default campaign and default offer determine which offers are presented to the customer during 
that customer’s Web Marketing session. These offers appear in addition to any targeted offers such 
as an embedded link in an email offer.

For more information about default offers and default campaigns, review the Featured Offers topic 
in Web Marketing Offers Page on page 223

Use of Siebel Personalization with Web 
Marketing
Siebel Personalization delivers personalized content and offers to a customer profile, needs, 
interests, and history. Personalized content includes greeting users by name, presenting them with 
content targeted to their needs and interests, and showing them recommended products and offers 
based on their needs and history.

Using Siebel Personalization, you can define rules to show and hide content dynamically during a 
visitor's experience with Siebel Web Marketing. Personalization deployment rules can depend on data 
such as user's profile information, date ranges, company information, products and services that 
visitor has already purchased or reviewed, and specific session information.
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The home page in Siebel Web Marketing includes the salutation applet in the upper-left corner. It 
typically includes a personal greeting, but it can be configured to deliver targeted content such as 
product promotions, announcements, birthday greetings, and offer updates. The home page also 
contains a list of recommended products and featured offers, both of which can be personalized 
based on user-specific information. Conditional expressions can be used to hide applets under certain 
conditions.

You manage personalization in the Personalization Administration screen in your application. For 
more information about administering personalization, see Siebel Personalization Administration 
Guide.

Customization of the Web Marketing 
User Interface
The product provides a set of Web templates and cascading style sheets (CSS) to create the look and 
feel of an application. Customers can create their own look and feel by modifying corporate logos, 
colors, and fonts in the style sheets and Web templates. When you modify these elements, make 
sure you save a backup copy in case you want to restore the original files.

NOTE: These elements are not automatically upgraded during the upgrade process.

The Siebel Web architecture uses the Siebel Web Engine (SWE) to dynamically generate HTML pages. 
The SWE uses configuration information in the Siebel Repository (SRF) and HTML layout information 
in the Siebel Web Template (SWT) to merge data with the template when creating the HTML page.

Web Templates
A Web template defines the layout and formatting elements of the user interface (UI), such as views, 
applets, and controls. These UI elements are associated with the templates by using Siebel Tools. 
The associated information is stored in the SRF file. For example, you may have a View object with 
three applets. You associate a View Template with the view, and map each applet to a placeholder in 
that template. The advantage of this approach is that the UI objects in the repository are not hard-
coded in individual templates. As a result, a number of View objects can share the same template if 
they share the same layout. The same process and design applies to applet objects.

The three primary templates types are Container, View and Applet. The final HTML pages created by 
the SWE places the applet in the view and the view in the container. Siebel Business Applications 
provide numerous applet and view templates with the product. They can be viewed in Tools, but are 
edited in an external editor. For more information about the physical user interface layer, see Using 
Siebel Tools.

To change the look and feel of your Web site, the following modifications are available:

■ Adding or removing applets

■ Changing colors

■ Changing controls

■ Making fields in a form appear
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■ Modifying behavior caused by clicking a button

■ Modifying views and applets

■ Modifying Web Templates

For more information about customizing the user interface, see Using Siebel Tools.

Web Marketing Without Frames
Customer and partner applications use HTML frames for compatibility when running in browser-based 
applications. HTML frames creates portions of the browser window that can scroll independently of 
the rest of the window. For example, you can place the navigation elements in one frame and content 
in another frame. You can scroll the content while the navigation elements remain in a fixed location.

Customer and partner applications can be implemented without using frames. Before choosing this 
method, consider the following limitation. In an unframed application, all UI elements exist in the 
same window. Therefore, the contents list may scroll off the page you scroll down. For example, if 
you scroll down to review content, the navigation elements may not be visible.

Full-Text Search
Siebel Search for Customers is a subset of the Siebel Search product. Use it to scan database tables 
and documents for pertinent information. Siebel Search is included with every license of an Oracle 
Siebel application. For more information about Siebel Search and Siebel Search for Customers, see 
Siebel Search Administration Guide.

Response Management
Use Siebel Web Marketing to capture a series of responses during a customer interaction. Table 33 
lists the responses captured.

Table 33. Responses Captured by Siebel Web Marketing

Response Description

Clicked on Product URL Captured when the recipient clicks the embedded link for the product 
in an email or Web offer.

Clicked on Web Offer Captured when the recipient clicks the embedded link for a Web offer 
in an email offer.

Clicked on Web Survey Captured when the recipient clicks the embedded link for the Web 
survey in an email or Web offer.
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Additional responses and events can be captured through configuration. For more information, see 
the event tracking topics in Using Siebel Tools.

Siebel Web Marketing Web Site
The Siebel Web Marketing Web site consists of the Offers page, the Information page, and their 
related views. Using the navigation bar, you can manage your personal profile by changing 
preferences in the My Settings view.

Completed Web Survey Captured when the recipient clicks Finish on the Web survey view. 
The survey answers are captured if the Save Answer field is checked 
for the question on the SmartScript Administration views. For more 
information, see Siebel SmartScript Administration Guide.

Downloaded Info/File Captured when the recipient clicks the embedded link for the 
document that is downloaded in a Web offer.

Requested call back Captured when the recipient submits a request after clicking the 
embedded link in an email or Web offer.

Requested more info Captured when the recipient submits a request after clicking the 
embedded link in an email or Web offer.

Requested Unsubscribe Captured when the recipient submits a subscription preference 
updates after clicking the embedded link in the email offer. In 
addition to the response, the contact profile is updated.

Submitted Source Code Captured when a contact or prospect enters a source code and offer 
code in the Do you have Another Offer form in the Offers page.

Table 33. Responses Captured by Siebel Web Marketing

Response Description
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Web visitors access the My Settings view by clicking the My Account link in the navigation bar of any 
Web Marketing page. Table 34 lists the links in the My Settings view that users and visitors can use 
to manage their personal profiles.

NOTE: Auction Privilege, Lister Payment, Notification Preferences, and Shipping Terms, are not used 
at this time.

Web Marketing Offers Page
The default home page for Web Marketing is the Offers page. The center applet of this view contains 
the specific Web offer intended for each Web site visitor. The Offers page provides links to other 
views, including additional offers, product information, Web surveys, and account and contact profile 
information.

The Offers page has several configurable applets, which this topic describes.

Table 34. Personal Profile Links in the My Settings View

Link Description

Address Book A list of available addresses for the visitor. Visitors can add, delete, 
and modify their address, and the changes update their information 
in the Siebel database.

Credit Cards A list of available credit cards for the visitor. This view is not 
required if you do not implement the Siebel eSales module or if you 
do not want to use credit card management.

Subscription Preferences A series of channel-specific and general communication preferences 
for each visitor. This view could be modified through Siebel Tools to 
include additional subscription preferences, for example by product 
or area of interest. These preferences could then be used to drive 
marketing activities for that visitor. This view appears when a visitor 
clicks on the Request Unsubscribe embedded URL in an email and a 
response is created when the visitor clicks Submit. The individual’s 
preferences are also updated in the Siebel database.

User Profile A series of user profile fields, which the visitor can modify. This view 
can be extended to display additional profile information.
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Salutation
The salutation text that appears depends on the personalization rules that are applied for the visitor 
who accesses the page. After logging in, registered email recipients or Web users get a greeting 
customized with their names. An anonymous Web visitor’s greeting says “Welcome!” You can change 
the salutation greeting text in the Personalization Administration views.

NOTE: When Web Marketing is deployed as part of the eCustomer application (a bundle of eSales, 
eService and Web Marketing), the visitor can display the Offers page (Web Marketing home page) 
and the eCustomer home page. Because the eCustomer home page has a salutation greeting, the 
salutation greeting is suppressed in the Offers page (Web Marketing home page).

The New User Link
You can set up the New User link that appears in the User Login applet so a Web site visitor can create 
a user ID and password for limited access to your Web Marketing Web site. When a visitor clicks New 
User on the Web Marketing home page, the registration views appears. The process is managed by 
a workflow business process that you can modify. For more information, see Siebel Business Process 
Framework: Task UI Guide and Siebel Business Process Framework: Workflow Guide.

NOTE: If a prospect registers, the prospect is converted to a contact. After becoming a contact, 
responses captured for the prospect are not associated with the new contact record. For more 
information, see Siebel Security Guide.

Web Offer
The center applet of the Offers page displays Web offer details. The applet contains the contents of 
the Web offer presented to the visitor. The Offer that appears is determined in the following ways:

■ The offer details are based on the Web-offer link that the visitor selects in an email.

■ The offer details are based on how Siebel Personalization sorts the offers in the Featured Offers 
applet. Details for the top offer in the Featured Offers applet appear in the center applet.

NOTE: If no featured offers exist, the Featured Offers area displays nothing.

Recommended Products
This applet contains a list of recommended products, customized for each visitor based on that 
visitor’s Web profile attributes. This list can be modified using the Personalization Administration 
views. Unidentified visitors get a default listing.

Featured Offers
This applet displays every Web offer for which the contact or prospect is eligible. When a visitor logs 
onto a Web site and clicks the Send Product Information or Request Call Back link, the response is 
captured for the default campaign and offer.

Web-offer types have the following characteristics:
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■ Web offers associated with the default campaign. When you specify a default campaign, 
the offers associated with that campaign appear in the Featured Offers list. The default campaign 
does not need to be loaded with campaign contacts and prospects. However, the campaign and 
associated Web offers must have active dates, and the Inbound Active flag must be checked.

■ Web offers associated with other active campaigns. These have been loaded with contacts 
and prospects. The offers must have active dates and the Inbound Active flag must be checked. 
Only those contacts and prospects targeted get these Web offers in the Featured Offers applet.

For more information about setting the default campaign or default offer, see Default Campaigns and 
Default Offers on page 219.

Information
This applet contains hyperlinks to the following applets in the Information page:

■ Downloads

■ Send Product Information

■ Request a Call

For more information about these applets, see Web Marketing Information Page on page 226.

Do you have another offer?
This applet contains fields that a visitor can use to enter the offer code and source code and then 
click Submit. An alternate Web offer then appears, and Siebel Web Marketing creates a response. 

Web Marketing Product Detail View
When a visitor responds to an offer (email or Web) by clicking an embedded product URL, a page 
with product details appears for that offer. This view displays details and incentive pricing for the 
selected offer. The price list associated with the offer determines the price shown in this view. The 
person who created the offer is responsible for associating the products and the correct price list with 
the offer. This combination determines the products that can be embedded in the offers and the price 
that appears. For more information about price list administration, see Siebel Pricing Administration 
Guide.

Additionally, this view contains the Related Items applet, showing products that may be of interest 
to the Web visitor. Items in the Related Items list are based on previous purchases or literature 
requests.

In addition to viewing details, the Web visitor using Siebel eCustomer may purchase the product from 
this view by clicking Add Item. After adding the product, the selected item appears in the Last Item 
Added applet.

NOTE: Checkout functionality exists only if the customer has purchased Siebel eCustomer. If you are 
not using eCustomer, the Add Item button is unavailable.
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Web Marketing Web Survey View
When the Web site visitor clicks an embedded URL for a Web survey in an email or Web offer, a survey 
wizard appears that navigates the visitor through a series of questions about the product. Survey 
results can be stored and then analyzed and used for future marketing activities. Web surveys are 
administered using Siebel SmartScripts. For more information, see Siebel SmartScript 
Administration Guide.

About Adding Unstructured Content
Oracle’s Siebel Web Marketing has the ability to display general external and unstructured content 
in the Web Marketing site using the Microsite Management module. For more information, see Siebel 
Applications Administration Guide.

Web Marketing Information Page
Web site visitors can use the Information page to download product information and request more 
information. The visitor can reach this page clicking the Information page tab. The Information page 
contains the following applets:

■ Downloads. Clicking a hyperlink opens the literature using the default viewer for that type of 
literature. The visitor can sort this list or search for any specific literature item by name, 
description, type, or date.

■ Request More Information. Used by visitors to request product information (Send Product 
Information) and request a telephone call (Request a Call) using response forms.

Web Marketing Send Product Information View
The Send Product Information view displays a form that Web site visitors can complete to request 
that product information be sent to them.

This view can be accessed from the Offers and Information pages or as an embedded URL link in an 
email offer or a Web offer. The Available Products area lists products for which more information is 
available. This is determined by Catalog visibility. For more information, see Siebel Product 
Administration Guide.

When the Send Product Information or Request Call Back views are accessed using an offer’s 
embedded URL, the list of products is restricted to the products associated with the offer. The visitor 
can browse the list, selecting products of interest, and then move the items to the Selected Products 
list by clicking Add.
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A visitor can request information about the one or more items in the Selected Products list by 
selecting the check boxes. To clear an item from the list, choose a Selected Product item, and then 
click Remove. After the Web site visitor chooses the products for which he or she wants more 
information, the visitor clicks Continue to move to the delivery form. In the delivery form, the Web 
site visitor can choose direct mail, email, fax, or phone as the delivery method, and then fill in the 
necessary information for the delivery method. When the visitor clicks Submit, the Confirmation view 
appears listing the products for which the visitor requested information and the delivery information. 
This information is stored as a response of the type Requested More Info.

Web Marketing Request a Call View
The Web site visitor can use the Request a Call view to request a callback about one or more 
products. This view can be accessed from the Offers or Information pages or as an embedded URL 
in an email offer or a Web offer. When accessed from an email or Web offer, the products available 
are limited to those products associated with the offer. When accessed from the Offers or Information 
pages, the products are limited by Catalog visibility.

Requests for a telephone call are initiated in the same way as requests for product information, using 
Available and Selected product lists. After the visitor chooses the products that he or she wants to 
discuss in a callback, the visitor clicks Continue to move to the Request Call form. There the visitor 
provides a phone number, the time of day to call, and adds comments. When the visitor clicks 
Submit, a Confirmation appears containing a list of products for which the visitor requested a 
callback and a list of call preferences. This information is stored as a response of the type Requested 
Call Back.
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owners to 142

campaign data
importing 196
mapping fields 196

campaign elements, reviewing 161
campaign execution options, setting up

about setting up 138
campaign contacts, automatically assigning 

owners to 142
Campaign Explorer

campaign elements, reviewing 161
folder, adding items to 161

campaign groups
about 136
groups, adding to a campaign 137

campaign quotas, setting up
campaign quota plan, assigning 

participants 146
new awards, creating 146
quota objective values, editing 144
quota objective, assigning predefined awards 

to 145
quota plan, adding quota objectives to 144
quota plan, creating 143

campaign skills, defined 147
campaign teams, working with

about 136
groups, adding to a campaign 137

campaign, setting up in Siebel Marketing
campaign, associating campaign elements 

with 130
execution options, setting up 138

team, assigning to a campaign 136
campaigns

 See also segment count, allocating to 
campaigns; waves; multistage 
recurring campaign

about 122
associating with loyalty programs 38
associating with loyalty promotions 39
contacts or prospects, adding to 164
documents, attaching to 126
expenses 36
list, adding to a campaign 75
new campaign with offer, defining 73
note, determining which program is using a 

campaign 73
opportunity, creating for 184
planning suggestions 127
predefined campaigns with associated offers, 

adding 72
stand-alone 14
stand-alone, executing 15
using in Siebel Marketing

about 121
Campaigns Opportunity, using to promote a 

prospect 207
campaigns, launching

See also automatic execution of programs
campaign launch status, monitoring 174
email campaign, suspending and 

relaunching 175
manually launching campaigns 

(procedure) 172
manually launching campaigns, 

requirements 172
marketing program, launching 171

campaigns, setting up
new campaign, creating 127
offer, associating with a campaign 131
related event, associating with a 

campaign 134
SmartScript, setting up 134

campaigns, setting up in Siebel Marketing
campaign, associating offers with 131
creating (procedure) 127

catalog, managing 45
charts

Average Opportunity Revenue Analysis 
(Response) chart, viewing 186

Call Status Analysis chart, viewing 179
Call Status by Employee chart, 

viewing 180
Campaign Achievement chart, steps before 

viewing 179
Campaign Achievements, viewing in Siebel 
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Campaigns, Campaign Achievement 
chart

Siebel Campaigns, viewing in 179
Campaign Analysis (Response) chart, 

viewing 184
campaign charts, about 178
Lead Quality Analysis by Campaign chart, 

viewing 180
Lead Quality by Analysis chart, 

viewing 181
Offer Analysis (Response) chart, 

viewing 185
Offer Type Analysis (Response) by Campaign 

chart, viewing 186
Offer Type Analysis (Response) chart, 

viewing 185
Opportunity Analysis (Response) chart, 

viewing 184
Opportunity Revenue Analysis by Employee 

chart, viewing 182
Opportunity Revenue Analysis chart, 

viewing 181
Order Revenue Analysis chart, viewing 182
response charts, about viewing in Siebel 

Campaigns 183
response charts, accessing 

(procedure) 184
Revenue Analysis (Response) chart, 

viewing 186
Trend Analysis by Employee chart, 

viewing 183
conditional content, creating 103
constraining list data 62
contact call offers 116
contact information, working with

contacts and prospects, viewing 164
imported or internal list, about associating 

with campaign 162
prospects or contacts, adding to a 

campaign 164
prospects or contacts, associating with a 

campaign 162
contact lists, viewing from 210
contacts

data matching and data cleansing 188
definition 187
removing from a list 212

contacts and prospects, about working 
with 161

Contacts List view, using to view contact 
information 210

creating
budget requests 21, 27
conditional content 103

marketing plans 21
Nth samples 61
N-tile samples 61
plan tactics 25
random samples 61
ranked samples 61
segment trees 56
segments 45

creating and submitting budget 
requests 27

creating plan tactics 25
criteria blocks

adding fields 46
cumulative counts 48
defined 42
filters 47
properties 47

criteria, adding to segments 46
cumulative counts, criteria blocks 48

D
D&B lists, about 161
D&B, integrating list management with

account data, viewing for D&B 
prospect 213

D&B prospect, promoting 213
data quality settings, verifying 189
deduplication, defined 42
deleting assignment skills 148
delivery profiles

about 109
creating 110
fax offer, associating with 110

Design view 77
designing marketing programs 65
direct campaigns, targeted at 121
direct mail offers, about and Direct Mail Offer 

view 117
distribution list, generating

generating a list 168
note, previewing not working 167
previewing (procedure) 168
previewing, about 167
sample list example 168

Do you have another offer? applet, 
about 225

documents
marketing plan, attaching to 36
programs and campaigns, attaching to 126

Downloads applet, about 226
drag-and-drop, about Program Flow 

Designer 65
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E
eligible audience

defined 42
working with constraints 62

email
campaign, testing 151
campaigns, stopping, resuming, or 

restarting 175
offers, sending 173
Siebel eMail Response, about configuring to 

capture email responses 152
email offers

See also Delivery Profiles; offers, creating and 
using

about and Email Offers view 87
attachments, adding to email offers 96
offer template, associating with 112
offer template, associating with an email 

offer 92
outbound email distribution 172
outbound email load balancing 172

embed nested segments 47
employees

Call Status Analysis by Employee chart, 
viewing 180

Opportunity Revenue Analysis chart, 
viewing 182

Trend Analysis by Employee chart, 
viewing 183

errors, Internal Communication protocol 
error message 168

events
about using with Siebel Marketing 149
expenses 36
offers, about how links appear in an 

offer 114
offers, associating with (procedure) 115
promoting, using campaigns 149
promoting, using programs 150

executing
marketing programs 15
programs 77
stand-alone campaigns 15

expenses
associating with invoices 38
for events, campaigns, programs 36

extension attributes 54
external lists, about 161
external lists, importing and managing

See also internal lists, creating and managing
about 187
campaign and response data, 

importing 196

campaign and response fields, 
mapping 196

database columns in the prospect table, 
mapping list columns to 194

existing List Import Format, applying to your 
list 199

fields, mapping to when importing a 
lists 198

import mode, selecting (procedure) 193
import request, tracking the status of 195
import status and error messages, 

understanding 200
importing an external list, creating a 

record 192
importing external lists, format and tasks 

performed 191
List Import Format, about editing the 

settings 199
List Import Format, about using 199
List Import mode, selecting 192
list import request, launching 195
list records, maintaining attributes for 197
log file, viewing for an import task 200
mapping fields when importing, about 198
server components and tasks, verifying status 

of 188

F
fax offers

See also Delivery Profiles
about and Fax Offer view 108
offer template, associating with fax 

offer 109
sending 173

Featured Offers applet, about 224
fields, aggregate, using in filters 47
filters

adding to criteria blocks 47
using aggregate fields 47

forecast expenses and revenues, about and 
field (table) 31

forecasting for campaigns
See also activity plans, creating and using; 

activities, creating and using; 
timelines

frames, implementing Web Marketing 
without frames 221

G
global audience, defined 42
global deployment, Web Marketing 215
globalization rules, offers, applying to 107
gross count, defined 43
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groups, defined 43

H
HTML editor to edit the offer template 93
HTML frames, implementing Web Marketing 

without frames 221

I
if-then-else 103
if-then-else personalization element 104
import request, tracking the status of 195
imported lists, campaign, about associating 

with 162
importing a list, mapping fields when 

importing 198
incoming data, validating the structure 

of 190
indirect campaigns, targeted at 121
Information applet, about 225
internal lists

about 161
campaign, about associating with 162

internal lists, creating and managing
about and list of tasks 201
contacts or prospects, adding to an internal 

list 204
creating internal lists, about 203
internal list, adding using prospect 

attributes 205
internal lists of contacts or prospects, 

creating 203
lists of prospects, about creating using 

attributes 204
lists of prospects, creating using attributes 

(procedure) 204
invoices, associating with expenses 38
is 13

L
Lead Quality Analysis by Campaign chart, 

viewing 180
Lead Quality by Analysis chart, 

viewing 181
List Contacts and Prospects view, using to 

promote a prospect 207
list format, defined 43
List Import Format

about using 199
editing the settings, about 199
existing List Import Format, applying to your 

list 199
import status and error messages, 

understanding 200

List Import mode, selecting 192
list import request, launching 195
list management

See also external lists, importing and 
managing; internal lists, creating and 
managing

about 187
list records

additional attributes, adding to list 198
additional attributes, creating 197
attributes, maintaining for list records 197

Lists view. using to view a contact or 
prospect list 210

lists, generating
generating a list 168
note, previewing not working 167
previewing (previewing) 168
previewing, about 167
sample list example 168

lists, viewing and maintaining
about and format 209
Contact or Prospects List view, using to view 

contact or prospect 
information 210

contacts, removing from a list 212
deactivating lists 211
deleting lists 211
Lists view, using to view a contact or prospect 

list 210
prospects, removing from a list 211

literature, offer, associating with 119
localization rules, applying to offers 107
log file, import task, viewing 200
loyalty programs

about 38
associating with campaigns 38

loyalty promotions
associating with campaigns 39

M
managing catalog 45
manually launching programs, about 171
mapping fields

about 198
when importing a list (procedure) 198

marketing planning and budgeting
budgets, developing and assigning for a 

marketing plan 31
goal for marketing plan, creating 23
marketing plan tactics, assigning a budget 

to 32
marketing plan tactics, associating with the 

marketing plan 25
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marketing plan, about creating 21
marketing plan, attaching a document 

to 36
marketing plan, creating (procedure) 22

marketing plans
associating with budget requests 29
associating with plan tactics 25
creating 21

marketing process flow 13
marketing programs

See also automatic execution of programs
campaign launch status, monitoring 174
designing 65
designing and creating 67
designing multistage programs, about and 

types of programs 66
designing multistage programs, about 

launching 67
designing programs, about 65
designing programs, creating 

(procedure) 68
email campaign, suspending and 

relaunching 175
executing 15
expenses 36
launching 171
manually launching campaigns 

(procedure) 172
manually launching campaigns, 

requirements 172
marketing programs, designing

See also Program Flow view
Marketing Segment Panel 46
media offers, about and Media Offers 

view 117
merge fields in email offers 101, 102
merge fields personalization category 100
metadata, reloading 45
mixing random splits 60
multilingual deployment, Web 

Marketing 215
multistage programs

about and types of programs 66
launching, about 67

N
named blocks personalization 

element 106
nested segment

defined 43
using a results set 51

nested segment node 62
net count, defined 43

new features in this release 11
New User Link applet, about 224
not included count, defined 43
Nth splits

creating 61
defined 59

N-tile splits
creating 61
defined 60

O
Offer Analysis (Response) chart, 

viewing 185
offer templates, creating and editing

See also offers, creating and using
about and offer types associated with 84
creating an offer template 85
email offer, associating with 92, 112
offer template associated with an offer, using 

the HTML editor 93
Offer Templates list, adding a template 

to 85
Personalization Categories, about using 99
template not associated with an offer, 

editing 86
Offer Type Analysis (Response) by Campaign 

chart, viewing 186
Offer Type Analysis (Response) chart, 

viewing 185
offers

applying localization rules 107
campaign, associating with 131
contact call 116
contact call, associating with response 

templates 116
email, about merge fields 102
email, using merge fields 101
merge fields 101, 102
offer code lookups, performing 154
previewing 99
specialized 115

Offers page, using and configurable 
applets 223

offers, creating and using
See also Delivery Profiles; email offers; offer 

templates, creating and editing
delivery profiles, about 109
delivery profiles, associating with a fax 

offer 110
delivery profiles, creating a delivery 

profile 110
direct mail offers, about and Direct Mail Offer 

view 117
Siebel Marketing User Guide Version 8.0234 



Index ■ P
fax offers, about and Fax Offer view 108
fax offers, associating an offer template 

with 109
globalization rules, applying to offers 107
literature, associating with an offer 119
media offers, about and Media Offers 

view 117
offer template, associating with an email 

offer 112
offer, creating 80, 88
offers, about 79
Web offers, adding attachments to 112
Web offers, Web surveys, events, and URLs. 

about how links appear in an 
offer 114

Web offers, Web surveys, events, and URLs. 
about Web Survey view 114

Web offers, Web surveys, events, and URLs. 
associating with offers 
(procedure) 115

opportunities, campaign, creating for 184
Opportunity Analysis (Response) chart, 

viewing 184
Opportunity Revenue Analysis by Employee 

chart, viewing 182
Opportunity Revenue Analysis chart, 

viewing 181
Order Revenue Analysis chart, 

viewing 182
overwrite existing record mode

about 193

P
personalization categories 99
Personalization Categories drop-down list, 

about and using 99
Personalization, using with Web 

Marketing 219
phone offers, working with

call guides, about and creating 118
call guides, creating a call guide 119

Pick Campaign dialog box, using to define 
new campaign with offer 73

plan tactics
associating with marketing plans 25
creating 25

planning and budgeting 17
Preview List, about preview not 

working 167
previewing offers 99
priority, defined 43
process flow, marketing 13
Product Detail view, about using 225

products, associating with treatments 84
program and campaign organizational tools, 

about 122
program execution schedule

deleting 177
editing 177

Program Execution workflow, about using to 
launch multistage programs 67

program flow
campaigns 70
events 70
lists 70
segment 70
stage 70

Program Flow Designer, about 65
Program Flow view

See also marketing programs, designing
about using 70
campaign, adding list to 75
new campaign with offer, defining 73
predefined campaigns with associated offers, 

adding 72
segments, adding to a program stage 72
stage, adding to the program 70

program templates
about 76
applying 77
by saving programs 76

programs
See also automatic execution of programs
about 14
campaign launch status, monitoring 174
documents, attaching to 126
email campaigns, suspending and 

relaunching 175
executing 77
loyalty 38, 39
manually launching campaigns 

(procedure) 172
manually launching campaigns, requirements 

for 172
marketing programs, launching 171

promotion map
about modifying and prospect information 

(table) 208
map entries, modifying 209

prospect lists
deleting prospects from list 211
Lists view, viewing from 210

Prospect records, about updating using 
Update Existing Duplicates 
Mode 193

prospects
campaign, adding to 164
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campaign, associating with 162
data matching and data cleansing 188
definition 187
list, removing from 211
viewing in Siebel Marketing 164

Prospects List view, using to view prospect 
information 210

Prospects More Info view, using to promote 
a prospect 207

prospects, promoting
Campaigns Opportunity, using to promote a 

prospect 207
List Contacts and Prospects view, using to 

promote a prospect 207
promotion map, modifying, about and 

prospect information (table) 208
prospect, promoting to a contact, about and 

application checks 206
prospect’s response to an opportunity, about 

promoting 208
Prospects More Info view, using to promote a 

prospect 207
purging results set 52

Q
quotas

See campaign quotas, setting up

R
random splits

creating 61
defined 59

ranked splits
creating 61
defined 59

Recommended Products applet, about 224
reject import record mode, about 192
related events, campaign, associating 

with 134
reloading server metadata 45
Request a Call view, about using and 

accessing 227
Request More Information applet, 

about 226
requested and assigned budget, about 31
requirements

result sets 51
response charts

accessing (procedure) 184
Average Opportunity Revenue Analysis 

(Response) chart, viewing 186
Campaign Analysis (Response) chart, 

viewing 184

Offer Analysis (Response) chart, 
viewing 185

Offer Type Analysis (Response) by Campaign 
chart, viewing 186

Offer Type Analysis (Response) chart, 
viewing 185

Opportunity Analysis (Response) chart, 
viewing 184

Revenue Analysis (Response) chart, 
viewing 186

Siebel Campaigns, about viewing in 183
response data

importing, about and List Import view 
described 196

response fields for mapping import 
data 196

Response Details form, fields (table) 156
response management, using

about 15, 151
attachments, adding 155
automatic response, about creating from 

opportunities and orders 160
offer code lookups, performing 154
opportunities, adding 155
orders, adding 154
products, adding 154
Response Details form, fields (table) 156
response information, adding 152
response, promoting to an 

opportunity 159
source code lookups, performing 154

response template, associating to contact 
call offers 116

responses
adding attachments to 155
adding opportunities to 155
adding orders to 154
adding products to 154

responses management, about 221
responsibilities, setting up for Web 

Marketing 218
result sets

purging 52
requirements 51
saving 51
segment tree 52
using as nested segment 51

Revenue Analysis (Response) chart, 
viewing 186

S
Salutation applet, about 224
saved result set, defined 43
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Schedule Calendar view
See automatic execution of programs

Segment Designer
about 41
purpose 45

segment tree branch properties 57
Segment Tree Designer 54
segment trees

about 41
adding segments to 56
adding to stages 75
advanced options 53, 63
allocating 75
allocating to stages 76
constraining list data 62
creating 56
defined 44
eligible audience 62
saving result sets 52
updating counts in 56

segmentation, frequently used terms 42
segments

about 13, 41
adding criteria to 46
adding to segment trees 56
advanced options 53
creating 45
defined 44
nested, defined 43
nested, embedding 47
splitting 59
updating counts 48

selection rules 48
Send Product Information view, about using 

and accessing 226
server components and tasks, verifying 

status of
about and list of components 188
data quality settings, verifying 189
incoming data, validating the structure 

of 190
server metadata, reloading 45
set distribution periods

See waves
Siebel Campaigns, Campaign Achievements, 

viewing 179
Siebel Dun & Bradstreet

account data, viewing for a D&B 
prospect 213

D&B prospect, promoting 213
Siebel eMail Response, about configuring to 

capture email responses 152
Siebel Personalization, using with Web 

Marketing 219

Siebel Web Engine, about 217
skills

skill items defined 147
skill items, associating with a skill 148

SmartScript, setting up 134
source code lookups, performing 154
source codes, about 14
split-by-value node 62
splits

mixing random 60
Nth, creating 61
Nth, defined 59
N-tile, creating 61
N-tiles, defined 60
random, creating 61
random, defined 59
ranked, creating 61
ranked, defined 59
selecting fields for 61
values, creating 62
values, defined 60

splitting and sampling, defined 44
splitting segments 59
stages

about 14
allocating segment tree cells to 76
follow-up 15

stand-alone campaigns
defined 14
executing 15

subject area, defined 44
submit budget requests 29
submitting budget requests 27
subwaves, determining the number 

created 172

T
target cells, defined 44
target level, defined 44
teams

campaign, assigning to 136
organizations inheritance, turning off 68

telemarketing offers, about defining 118
templates

See individual template entries, and offer 
templates, creating and editing

response management, using
See individual campaign items

testing campaigns and offers
See individual campaign items
about 150
business scenario 151
email and fax offers, sending 173
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testing campaigns and treatments
email campaign, testing 151

timelines
See also forecasting for campaigns
about 125

tools
See program and campaign organizational 

tools
treatments, creating and using

product, associating with a treatment 
offer 84

treatments, about 13
Trend Analysis by Employee chart, 

viewing 183

U
updating counts

in segment trees 56
in segments 48

URLs
offers, about how links appear in an 

offer 114
offers, associating with 113
offers, associating with (procedure) 115

user interface, customizing
about 220
full-text search, about 221
response management, about 221
Web Marketing without frames, 

implementing 221
Web templates, using 220

V
values sampling 62
values split 60
vendors, about 14

W
Wave Batch Size parameter, subwaves, 

determining the number 
created 172

waves
about 15
about using 73
multiple waves, setting up 74, 166

Web Anonymous User responsibility, 
about 219

web catalog, defined 44
Web Corporate User responsibility, 

about 219

Web Marketing, setting up and using
home page, accessing by visitors 216
Information page, about and applets 226
installing, applications to install before Web 

Marketing 217
Offers pages, using and configurable 

applets 223
Product Detail view, about using 225
Request a Call view, about using and 

accessing 227
responsibilities and users, setting up 

default 218
Send Product Information view, about using 

and accessing 226
Siebel Personalization, using with Web 

Marketing 219
unstructured content, additional 226
user access, tasks to control user 

access 218
user interface, customizing 220
Web site visitor, about 215
Web site, about 222
Web Survey view, about using 226

Web Offer applet, about 224
Web offers

attachments, adding to 112
offers, about associating with 

(procedures) 115
offers, about how links appear in an 

offer 114
Web Offers Downloads, using to add 

attachments to Web offers 112
Web Registered User responsibility, 

about 219
Web site

user access, tasks to control user 
access 218

visitor, about 215
Web Marketing home page, accessing by 

visitors 216
Web Marketing Web site, about 222

Web Survey view, Web Marketing Offers 
page, about using 226

Web surveys
offers, about links appear in an offer 114
offers, associating with (procedure) 115
Web survey link, about clicking on 114

Web templates, using to customize the user 
interface 220

what’s new 11
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